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BioTek Instruments, Inc. 

Notices 

BioTek® Instruments, Inc. 

Highland Park, P.O. Box 998 

Winooski, Vermont  05404-0998  USA  

All Rights Reserved 

© 2013, BioTek® Instruments, Incorporated. No part of this publication may be 
reproduced, transcribed, or transmitted in any form, or by any means electronic or 
mechanical, including photocopying and recording, for any purpose other than the 
purchaser’s use without written permission of BioTek Instruments, Inc. 

Trademarks 

BioTek® is a registered trademark, and ELx808™, 4-Zone™ and Gen5™ are trademarks 
of BioTek Instruments, Inc. Microsoft®, Windows®, and Excel® are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.  

All other trademarks are the property of their respective holders. 

Restrictions and Liabilities 

Information in this document is subject to change and does not represent a 
commitment by BioTek Instruments, Inc. Changes made to the information in this 
document will be incorporated in new editions of the publication. No responsibility is 
assumed by BioTek for the use or reliability of software or equipment that is not 
supplied by BioTek or its affiliated dealers. 
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Contact Information 

 See also Product Support and Service on page 7. 

 
BioTek® Instruments, Inc. 

Highland Park, P.O. Box 998 

Winooski, Vermont 05404-0998 USA 

Customer Service and Sales 

Internet:  www.biotek.com 

Phone:  888-451-5171 (toll free in the U.S.) 
 802-655-4740 (outside the U.S.) 

Fax:  802-655-7941 

E-Mail:  customercare@biotek.com 

Service/TAC 

Phone: 800-242-4685 (toll-free in the U.S.) 
 802-655-4740 (outside the U.S.) 

Fax: 802-654-0638 

E-Mail: tac@biotek.com 

European Coordination Center/Authorized European 
Representative  

BioTek® Instruments GmbH 
Kocherwaldstrasse 34 
D-74177 Bad Friedrichshall 
Germany 

Internet: www.biotek.de 

Phone: +49 (0) 7136 9680 

Fax: +49 (0) 7136 968 111 

E-Mail: info@biotek.de 
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Revision History 

Rev Date Changes 

A 1/96 First Release 

B 5/96 Revised reader specifications. Added Scanning method to software. 

C 1/97 Added Panel and Reuse of Standard Curve, and revised serial port pin-out 
description. 

D 2/98 Changed Chapter 4, Performance Verification to reflect changes to the Universal 
Test Plate. Added Liquid Tests 1 and 2. Changed Appendix C: Error Codes. 

E 8/98 Added printer information. Updated Appendix B: Computer Control. 

F 3/99 Changed European address. Corrected printer compatibility. Corrected the 
sequence of steps for processing a curve-fit method. 

G 7/99 Added comment about blanking, P-Down and P-Across being inactive in this 
version of software. Clarified the need for at least one sample to be defined on a 
plate. Added scanning computer control commands. 

H 5/00 Updated Chapter 4- Performance Verification to include a Liquid Test 3 to verify 
340 nm instruments. Corrected the voltage range for Range 2 in the 
Introduction. Corrected Incubation Temperature Control range to 6 deg above 
ambient. Changed Note on page 4-7 dealing with air readings during Self-Test. 
Clarified Liquid Test 1. Changed Table 4-1 to include additional maintenance 
items. Reworked Liquid Test 2.  

I 7/02 Updated contact information (pages iii, 1-8, 1-9, 2-8, 2-20, and 4-13). Added 
IQ/OQ/PQ procedures and updated liquid testing information (Chapter 4). 
Revised lamp replacement procedure (page 2-15). 

J 11/03 Preface: Updated contact information in Notices (page iii). Added Document 
Conventions (page vi). Updated Warnings section (pages vii and viii). Updated 
Electromagnetic Compatibility section (pages ix and x). Added the following 
safety symbols and text: “Consult instructions for use” (page xii) “In vitro 
diagnostic medical device” (page xii) “Separate collection for (disposal of) 
electrical and electronic equipment” (page xiii). Expanded the Intended Use 
Statement (page xiv). 
Chapter 1: Updated contact information in Technical Support. Removed About 
This Manual section (page 1-5). Added “Absorbance Test Plate” to the Optional 
Accessories list (page 1-8). Clarified lamp replacement procedure (Chapter 2, 
pages 2-14 to 2-16). Clarified description of cutoff formulas (Chapter 3, pages 3-
42 to 3-44). 
Chapter 4: Changed title to “Performance Verification and IQ, PQ, OQ Tests.” 
Added IQ/PQ/OQ test procedure information. Clarified procedures for liquid 
tests. 

J 11/03 Revised decontamination instructions and added cleaning procedure (Appendix 
A). Added KC4 startup information to Appendix B. Added new Appendix E with 
two examples of assay kit instructions and directions for programming an assay. 
General: Edited and formatted text. Modified appearance of display screens. 
Standardized the presentation of significant digits. Changed “Abs” to “OD” 
throughout. 
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Rev Date Changes 

K 4/05 Updated the cover with a current photo of the instrument. Updated contact 
information and warranty. Changed “Automated Microplate Reader” to 
“Absorbance Microplate Reader” throughout. Changed “Universal Test Plate” to 
“Absorbance Test Plate” throughout. Removed references to internal barcode 
scanner and “R” models. Removed references to General Formulas with respect 
to open assays. Updated specifications to match product spec rev D. Added text 
from rev J1 insert (Fuse Installation/Replacement). Updated the installation 
instructions in Chapter 2 to better reflect actual practice. Updated the 
IQ/OQ/PQ/PM steps in Chapter 4 to better reflect actual practice. Created 
Appendix F to provide instructions for adjusting the line input voltage range and 
replacing fuses for instruments with an older-style power input module than the 
one described in Chapter 2. 

L 4/06 Updated the manual primarily to support the introduction of Gen5™ software. In 
general, changed ‘Bio-Tek’ to ‘BioTek,’ and added Gen5 instructions wherever 
KCjunior™ and KC4™ instructions were present.  
Cover: Updated BioTek logo to new graphic. 
Preface: Added Contact Information section, updated Hazards, Precautions, and 
safety standards. Removed Registration Card and Warranty (these items ship 
separately).  
Chapter 1: Added external power supply to Hardware Features, Package 
Contents, and Specifications. Also added ‘Reading Speeds’ section to specs. 
Replaced Technical Support section with one-page Product Support & Service 
section. 
Chapter 2: Added instructions for connecting the external power supply in 
Connect Power section. Moved instructions in Check/Adjust the Power Input 
Voltage Setting section to Appendix F.  
Chapter 4: Changed chapter title from ‘Performance Verification, Periodic 
Maintenance, and IQ, PQ, OQ Tests’ to ‘Instrument Verification’. Moved 
maintenance instructions to new Chapter 5, Preventive Maintenance (see below). 
For Liquid Tests 1, 2, and 3, added recommendation to shake the plate for four 
minutes (or wait for 20 minutes) after pipetting the diluted test solution, before 
reading the plate.  
Chapter 5 (new chapter): In Recommended Maintenance table, removed 3-
month interval for cleaning the lamp contacts and changed ‘Replace the Lamp’ to 
‘Replace the Lamp and Clean the Contacts.’ Added cleaning instructions from 
Appendix A, Decontamination.   
Appendix B: Added new section: ‘Controlling the Reader with Gen5’. 

M 3/08 General: Applied the BioTek template to the manual. Changed “Bio-Tek” to 
“BIOTEK” in startup screens to reflect this change in the reader’s basecode 
software.  
Preface: Added Microsoft®, Windows®, Windows XP, Windows 2000, Windows 
Vista™, and Excel® to the “Trademarks” section. In the “Contacting BioTek 
Instruments” section, updated the TAC fax number and added “Authorized 
European Representative” to the “European Coordination Center” heading. 
Chapter 1: Added part number disclaimer to “Package Contents” and “Optional 
Accessories” and updated the TAC fax number in the “Product Support and 
Service” section. 
Chapter 2: Added a packaging disclaimer to the section “Unpack and Inspect the 
Instrument.” 
Chapter 3: Enhanced section on the keypad with graphics that illustrate 
components of the ELx808™keypad/ display. Updated “Panel Assays” section. In 
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Rev Date Changes 
the “Printing Reports and Assay Lists” section, added a note containing an 
explanation of the OUT of range indication on reports.  
Chapter 4: Clarified the description of the System Test Report to state that the 
incubation test is done ‘separately’ and that the overall system test results given 
at the bottom of the test report refer only to the Optics portion of the test. 
Capitalized the “l” in “μl” and “ml.” 
Chapter 5: Merged this chapter with Appendix A, Decontamination.   
Reformatted and renamed Appendix C, Error Codes, as “Chapter 6, Error Codes”. 
Added a “Fatal Errors” section, and added information on Error Codes 2311 to 
2386.      
Renamed Appendix B, Computer Control, as Appendix A. 
Renamed Appendix D, Reports, as Appendix B, Sample Reports. In the 
“Overview,” added a note containing an explanation of the OUT of range 
indication on reports. 
Renamed Appendix E, Programming a New Assay as Appendix C. 
Renamed Appendix F, Adjusting the Power Input Voltage Setting as Appendix D. 

N 6/11 Throughout: Removed references to outdated software KC4 and KCjunior. 
Preface: Updated Trademark. Updated Warnings and Precautions. Updated 
Intended Use statement. 
Chapter 2: Removed Parallel and Serial Port Pinout charts. Added Install 
Software/Connect to Computer. 
Chapter 3: Added “Getting Started with Gen5”. Gave Baud Rate information for 
Gen5. Removed references to outdated software Extensions.  
Chapter 4: Removed Installation Qualification. Updated Autocal Analysis. 
Updated sample Absorbance Test Plate Results. Updated Stock Solution 
Formulation for Liquid Tests 1 and 2. Removed outdated instructions for creating 
former Solution A: 10x Concentrate PBS from Liquid Test 3. Simplified test 
procedure as a result.  
Chapter 5: Updates lamp replacement instructions (added text from former 
revision M1 insert). 
Chapter 6: Added error code 1201.  
Appendices: Removed former Appendix A: Computer Control. 

O 9/12 General: Updated Gen5 instructions to reflect terminology in Gen5 v2.x. 
Preface: Updated the Intended Use Statement and the heading for the In 
Vitro Diagnostics directive to refer to the instrument’s IVD label (if one 
exists). Added ‘Service’ and ‘Accessories’ hazard warnings. Added ‘Spare 
Parts’ precaution.  
Chapter 1, Introduction: Updated part number for the power supply. 
Chapter 2, Installation: Added note that improper packaging that results in 
damage to the instrument may lead to additional charges. 
Chapter 4, Qualification: Added a note to the Absorbance Test Plate section 
stating that the test tests the accuracy and repeatability of the reader to 2.500 
OD. It does not indicate a PASS or FAIL above 2.500 OD. 

P 4/13 Preface: Added EN 61010-2-081 and EN 61010-2-010 to Directive 2006/95/EC 
Low Voltage (Safety) and EN 61010-2-101 to Directive 98/79/EC In Vitro 
Diagnostics. 
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Document Conventions 

See also Safety Symbols on page xix. 

 

This icon calls attention to important safety notes. 

Warning! 
A Warning indicates the potential for bodily harm and 
tells you how to avoid the problem. 

Caution 
A Caution indicates potential damage to the instrument 
and tells you how to avoid the problem. 

Note: Bold text is primarily used for emphasis. 

L 
This icon calls attention to important information. 

 
 

Intended Use Statement 

• The ELx808 is an absorbance microplate reader. The performance characteristics of the 
data reduction software have not been established with any laboratory diagnostic 
assay. The user must evaluate this instrument and (if used) PC-based software in 
conjunction with their specific assay(s). This evaluation must include the confirmation 
that performance characteristics for the specific assay(s) are met. 

• If the instrument has an “IVD” label it may be used for clinical and non-clinical 
purposes, including research and development. If there is no such label the instrument 
may only be used for research and development or other non-clinical purposes. 

 

Quality Control 

It is considered good laboratory practice to run laboratory samples according to instruc-
tions and specific recommendations included in the assay package insert for the test to be 
conducted. Failure to conduct Quality Control checks could result in erroneous test data. 
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Warranty & Product Registration 

Take a moment to review the warranty information that shipped with your product. 
Please also register your product with BioTek to ensure that you receive important 
information and updates about the product(s) you have purchased. You can register online 
through the Customer Resource Center (CRC) at www.biotek.com or by calling 888-451-
5171 or 802-655-4740. 
 

Repackaging and Shipping 

L If you need to ship the instrument to BioTek for service or repair, 
contact BioTek for a Return Materials Authorization (RMA) 
number, and be sure to use the original packing materials. Other 
forms of commercially available packaging are not recommended 
and can void the warranty. If the original packing materials have 
been damaged or lost, contact BioTek for replacement packing. 

 

 

Warnings 

   

Operate the instrument on a level, stable surface away from excessive humidity. 

Bright light or strong incandescent light can reduce the linear performance range 
of the instrument. 

Measurement values may be affected by extraneous particles (such as dust) in the 
microplate wells. A clean work area is necessary to ensure accurate readings. 

When operated in a safe environment according to the instructions in this 
document, there are no known hazards associated with the instrument. However, 
the operator should be aware of certain situations that could result in serious 
injury; these may vary depending on the instrument model. See Hazards and 
Precautions. 
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Hazards 

The following hazard warnings are provided to help avoid injury: 

 

Warning! Internal Voltage. Always turn off the power switch and unplug the 
power cord or power supply before cleaning the outer surface of the instrument or 
removing its top case.  

   

Warning! Power Rating. The instrument’s power supply or power cord must be 
connected to a power receptacle that provides voltage and current within the 
specified rating for the system. Use of an incompatible power receptacle may 
produce electrical shock and fire hazards. 

 Warning! Electrical Grounding. Never use a plug adapter to connect primary 
power to the external power supply. Use of an adapter disconnects the utility 
ground, creating a severe shock hazard. Always connect the power cord directly to 
an appropriate receptacle with a functional ground. 

 Warning! Service. Only qualified technical personnel should perform service 
procedures on internal components. 

 Warning! Accessories. Only accessories that meet the manufacturer’s 
specifications shall be used with the instrument. 

 Warning! Liquids. Avoid spilling liquids on the reader; fluid seepage into 
internal components creates a potential for shock hazard or instrument damage. 
Wipe up all spills immediately. Do not operate the instrument if internal 
components have been exposed to fluid. 

 Warning! Unspecified Use. Failure to operate this equipment according to the 
guidelines and safeguards specified in this manual could result in a hazardous 
condition. 

 Warning! Software Quality Control. The operator must follow the 
manufacturer’s assay package insert when modifying software parameters and 
establishing reading methods. Failure to conduct quality control checks could 
result in erroneous test data. 

 Warning! Reader Data Reduction Protocol. When the reader is operated in 
standalone mode the onboard assay software will flag properly defined controls 
when they are out of range. The software will present the data with the 
appropriate error flags for the operator to determine control and assay validity. 
When operated via computer control, no limits are applied to the raw 
measurement data. All information exported via computer control must be 
thoroughly analyzed by the operator. 

 

Warning! Hot Surface. The lamp is hot when the instrument is turned on. Turn 
off the reader and allow the lamp to cool for at least 15 minutes before attempting 
to replace it.  



Precautions  |  xv 
 

ELx808 Operator’s Manual 

 

Warning! Potential Biohazards. Some assays or specimens may pose a 
biohazard. Adequate safety precautions should be taken as outlined in the assay’s 
package insert. Always wear safety glasses and appropriate protective equipment, 
such as chemically resistant rubber gloves and apron. 

 

Precautions 

The following precautions are provided to help avoid damage to the instrument: 

   

Caution: Service. The instrument should be serviced by BioTek-authorized 
personnel. Only qualified technical personnel should perform service procedures 
on internal components. 

Caution: Spare Parts. Only approved spare parts should be used for 
maintenance. The use of unapproved spare parts and accessories may result in a 
loss of warranty and potentially impair instrument performance or cause damage 
to the instrument. 

Caution: Environmental Conditions. Do not expose the system to temperature 
extremes. For proper operation, ambient temperatures should remain within the 
range listed in the Specifications section. Performance may be adversely affected 
if temperatures fluctuate above or below this range. Storage temperature limits are 
broader. 

 Caution: Sodium Hypochlorite. Do not expose any part of the instrument to the 
recommended diluted sodium hypochlorite solution (bleach) for more than 20 
minutes. Prolonged contact may damage the instrument surfaces. Be certain to 
rinse and thoroughly wipe all surfaces.  

 Caution: Power Supply. Use only the power supply shipped with the 
instrument. Operate the power supply within the range of line voltages listed on it. 

 Caution: Warranty. Failure to follow preventive maintenance protocols may 
void the warranty. 

 Caution: Disposal. This instrument contains printed circuit boards and wiring 
with lead solder. Dispose of the instrument according to Directive 2002/96/EC, 
“on waste electrical and electronic equipment (WEEE)” or local ordinances. 

 Caution: Electromagnetic Environment. Per IEC 61326-2-6 it is the user’s 
responsibility to ensure that a compatible electromagnetic environment for this 
instrument is provided and maintained in order that the device will perform as 
intended. 

 Caution: Electromagnetic Compatibility. Do not use this device in close 
proximity to sources of strong electromagnetic radiation (e.g., unshielded 
intentional RF sources), because these may interfere with the proper operation. 
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CE Mark 

 
Based on the testing described below and information 
contained herein, this instrument bears the CE mark. 

 

 See the Declaration of Conformity for more information. 

Directive 2004/108/EC: Electromagnetic Compatibility 

Emissions—Class A 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1: Class A for Radiated Emissions 
and Line Conducted Emissions. Verification of compliance was conducted to the 
limits and methods of EN 55011 – CISPR 11, Class A. In a domestic environment it 
may cause radio interference, in which case you may need to mitigate the 
interference. 

Immunity 

The system has been type-tested by an independent, accredited testing laboratory 
and found to meet the requirements of EN 61326-1 and EN 61326-2-6 for Immunity. 
Verification of compliance was conducted to the limits and methods of the 
following: 

EN 61000-4-2 Electrostatic Discharge 
EN 61000-4-3 Radiated EM Fields 
EN 61000-4-4 Electrical Fast Transient/Burst 
EN 61000-4-5 Surge Immunity 
EN 61000-4-6 Conducted Disturbances from RFI 
EN 61000-4-11 Voltage Dips, Short Interruptions and Variations 

Directive 2006/95/EC Low Voltage (Safety) 

The system has been type-tested by an independent testing laboratory and was found 
to meet the requirements of this Directive. Verification of compliance was conducted to 
the limits and methods of the following: 

EN 61010-1, “Safety requirement for electrical equipment for measurement, control and 
laboratory use. Part 1, General requirements.” 

EN 61010-2-081, “Particular requirements for automatic and semi-automatic laboratory 
equipment for analysis and other purposes.” 

EN 61010-2-010, “Particular requirements for laboratory equipment for the heating of 
materials.” 
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Directive 2002/96/EC: Waste Electrical and Electronic Equipment 

Disposal Notice: This instrument contains printed circuit boards and wiring with 
lead solder. Dispose of the instrument according to Directive 2002/96/EC, “on 
waste electrical and electronic equipment (WEEE)” or local ordinances. 

Directive 98/79/EC: In Vitro Diagnostics (if labeled for this use) 

• Product registration with competent authorities 

• Traceability to the U.S. National Institute of Standards and Technology (NIST) 

• EN 61010-2-101, “Particular requirements for in vitro diagnostic (IVD) medical 
equipment.” 

 

Electromagnetic Interference and Susceptibility 

USA FCC CLASS A 

RADIO AND TELEVISION INTERFERENCE 

NOTE: This equipment has been tested and found to comply with the limits for a Class 
A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. Like all similar equipment, this equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause 
interference, in which case the user will be required to correct the interference at their 
own expense. 

In order to maintain compliance with FCC regulations, shielded cables must be used 
with this equipment. Operation with non-approved equipment or unshielded cables is 
likely to result in interference to radio and television reception. 

Canadian Department of Communications Class A  

This digital apparatus does not exceed Class A limits for radio emissions from digital 
apparatus set out in the Radio Interference Regulations of the Canadian Department of 
Communications. 

Le present appareil numerique n'émet pas du bruits radioelectriques depassant les 
limites applicables aux appareils numerique de la Class A prescrites dans le Reglement 
sur le brouillage radioelectrique edicte par le ministere des Communications du 
Canada. 
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User Safety 

This device has been type-tested by an independent laboratory and found to meet the 
requirements of the following: 

• Underwriters Laboratories UL 61010-1, “Safety requirements for electrical 
equipment for measurement, control and laboratory use; Part 1: General 
requirements.” 

• Canadian Standards Association CAN/CSA C22.2 No. 61010-1, “Safety 
requirements for electrical equipment for measurement, control and laboratory 
use; Part 1: General requirements.” 

• EN 61010 Standards, see CE Mark starting on page xvi. 
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Safety Symbols 

Some of these symbols may appear on the instrument or accessories: 

 

 
Alternating current 

Courant alternatif 

Wechselstrom 

Corriente alterna 

Corrente alternata 

 
Both direct and alternating current 

Courant continu et courant alternatif 

Gleich - und Wechselstrom  

Corriente continua y corriente alterna 

Corrente continua e corrente alternata 

 
Direct current 

Courant continu 

Gleichstrom 

Corriente continua 

Corrente continua 

Earth ground terminal 

Borne de terre 

Erde (Betriebserde) 

Borne de tierra 

Terra (di funzionamento) 

 

On (Supply) 

Marche (alimentation) 

Ein (Verbindung mit dem Netz) 

Conectado 

Chiuso 

Protective conductor terminal 

Borne de terre de protection 

Schutzleiteranschluss 

Borne de tierra de protección 

Terra di protezione 

 

Off (Supply) 

Arrêt (alimentation) 

Aus (Trennung vom Netz) 

Desconectado 

Aperto (sconnessione dalla 
rete di alimentazione) 

Caution (refer to accompanying documents) 

Attention (voir documents 
d’accompanement) 

Achtung siehe Begleitpapiere 

Atención (vease los documentos incluidos) 

Attenzione, consultare la doc annessa 

 

Warning, risk of electric shock 

Attention, risque de choc 
électrique 

Gefährliche elektrische schlag 

Precaución, riesgo de sacudida 
eléctrica 

Attenzione, rischio di scossa 
elettrica 

 
 

 

Warning, risk of crushing or pinching 

Attention, risque d’écrasement et 
pincement 

Warnen, Gefahr des Zerquetschens und 
Klemmen 

Precaución, riesgo del machacamiento y 
sejeción 

Attenzione, rischio di schiacciare ed 
intrappolarsi 

 

Warning, hot surface 

Attention, surface chaude 

Warnen, heiße Oberfläche 

Precaución, superficie caliente 

Attenzione, superficie calda 

 

Warning, potential biohazards 

Attention, risques biologiques potentiels 

Warnung! Moegliche biologische Giftstoffe 

Atención, riesgos biológicos 

Attenzione, rischio biologico 
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In vitro diagnostic medical 
device 

Dispositif médical de 
diagnostic in vitro  

Medizinisches In-Vitro-
Diagnostikum 

Dispositivo médico de 
diagnóstico in vitro 

Dispositivo medico diagnostico 
in vitro 

 

Separate collection for electrical and 
electronic equipment  

Les équipements électriques et 
électroniques font l’objet d’une collecte 
sélective 

Getrennte Sammlung von Elektro- und 
Elektronikgeräten 

Recogida selectiva de aparatos eléctricos y 
electrónicos  

Raccolta separata delle apparecchiature 
elettriche ed elettroniche 

 

Consult instructions for use 

Consulter la notice d’emploi 

Gebrauchsanweisung beachten 

Consultar las instrucciones de 
uso 

Consultare le istruzioni per uso 

 

 

Laser radiation: Do not stare into beam 

Rayonnement laser: Ne pas regarder 
dans le faisceau 

Laserstrahlung: Nicht in den strahl 
blicken 

Radiación de láser: No mire fijamente al 
rayo  

Radiazione di laser: Non stare nel fascio 
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Introduction 

This chapter introduces the ELx808 Absorbance Microplate Reader 
and describes its hardware and software features, and technical 
specifications. Instructions for contacting BioTek are provided on 
page 7. 
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ELx808 Absorbance Microplate Reader 

BioTek’s ELx808 is an eight-channel reader-assay system. The reader can serve as a 
standalone system, or can be controlled via BioTek’s Gen5 software. 

Designed to automatically perform endpoint and kinetic analysis, the reader can measure 
the optical density of solutions in 96-well microplates between 380 nm and 900 nm. The 
UV option measures down to 340 nm. 

The reader features superior optical specifications, with an extended dynamic range of up 
to 4.000 absorbance units. 

The instrument’s onboard processor, 2-line x 24-character LCD screen, and membrane 
keys allow easy definition and management of assay protocols, templates, formulas, and 
data. Results can be output in a printed report format, or exported for use in a variety of 
ELISA-based data manipulation applications. 

Reader Variations 

• ELx808: Absorbance Microplate Reader (standard model). 

• ELx808IU: Reader with incubation and UV capability. The ELx808IU has a four-
zone incubation chamber that controls temperatures up to 50°C, and is capable of 
reading plates between 340 nm and 900 nm wavelengths. 

 

Hardware Features 

• Eight optics channels, with an additional reference channel 

• A wavelength range of 380-900 nm (ELx808), 340-900 nm (ELx808IU) 

• A user-accessible, 6-position filter wheel 

• A 2-line x 24-character LCD display  

• A membrane keypad with alphanumeric keys 

• Adjustable plate shake frequency and times  

• Reads 96-well microplates with 0.355" (9.017 mm) well centers 

• Internal, four-voltage range power input module that can be adjusted for 100, 120, 
230, or 240 V~ @ 50-60 Hz  (readers manufactured before December 2005)   

• 24-volt external power supply compatible with 100-240 V~ ± 10% @ 50-60 Hz  
(readers manufactured after December 2005) 

• One serial COM port (25-pin male) and one parallel port (25-pin female) 

• 4-Zone incubation chamber option (ELx808IU)   

BioTek Instruments, Inc. 
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Software Features 

• Easy-to-use, menu-driven interface 

• Endpoint, Kinetic, and Linear Well scanning calculations 

• Curve fitting, with 4-parameter, cubic, quadratic, linear, 2-P, cubic-spline and 
point-to-point methods 

• Transformation and formula calculations for more complex mathematical 
operations, including validation and cutoff formulas 

• 55 assays are available onboard; up to 75 custom assays can be preprogrammed 
and exported to the reader using BioTek’s Define Protocol software. 

• Automatically stores results for the last 10 plates. 

Package Contents 

 Package contents and part numbers are subject to change. Please 
contact BioTek Customer Care with questions. 

• ELx808 Absorbance Microplate Reader 

• Power cord (PN varies according to country of use) 

• Power supply for readers manufactured after December 2005 (PN 01281)  

• Filter wheel with four standard filters: 405 nm, 450 nm, 490 nm, 630 nm and two 
blank filters. The ELx808IU also includes a 340 nm filter. 

• Operator’s Manual (PN 7341000)  

• Serial cable (PN 75053)  

• Dust cover (PN 7342066) 

Optional Accessories 

 Accessory availability and part numbers are subject to change. Contact 
BioTek Customer Care with questions, or visit www.biotek.com and 
use the Accessories search tool. 

• Additional filters (please inquire for availability): 

 340 to 630 nm, PN 3100XXX (XXX is wavelength in nanometers) 

 640 to 900 nm, PN 3404XXX (XXX is wavelength in nanometers) 

ELx808 Operator’s Manual  
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• Replacement lamp assembly (PN 3400508) 

• Filter wheel plug (PN 3122037) 

• Absorbance Test Plate (PN 9000547 or PN 7260522) 

• ELx808 IQ/OQ/PQ Package (PN 7340543) 

• Gen5 Software (visit biotek.com or contact your local dealer for details) 

• Absorbance Liquid Test Solutions: 

 BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL) 

 BioTek wetting agent (PN 7773002) 

• Adapter to connect the reader to a USB-only printer (PN 75135) 

Specifications 

Microplates  

• Standard 96-well, flat- or round-bottom plates 

Electrical 

• Power source and voltage range: 

 Readers manufactured after December 2005: 24-volt external power 
supply compatible with 100-240 V~ ± 10% @ 50-60 Hz 

 Readers manufactured before December 2005: Internal, adjustable 
power input module with four voltage ranges accommodated by the voltage 
selection switch: 

    Range 1 100 V~       90 to 110 V~, 50 to 60 Hz 
    Range 2 120 V~       108 to 132 V~, 50 to 60 Hz 
    Range 3 230 V~       207 to 253 V~, 50 to 60 Hz 
    Range 4 240 V~       216 to 264 V~, 50 to 60 Hz 

• Power consumption: 100 VA   

Physical 

• Dimensions: 16.0" D x 15.5" W x 8.75" H (40.6 cm x 39.37 cm x 22.2 cm) 

• Weight: 35 lb. maximum (15.87 kg maximum)   

BioTek Instruments, Inc. 
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Environmental 

• Operating temperature: 18° to 40°C  (64° to 104°F) 

• Humidity: 10% to 85% noncondensing 

Hardware 

• Light source: Tungsten halogen-filled bulb   

• Display: 2-line x 24-character LCD 

 
 Reading Speeds 

• Single wavelength: 8 seconds rapid mode; 12 seconds normal/regular mode 

• Dual wavelength: 13 seconds rapid mode; 20 seconds normal/regular mode 

• Single wavelength higher than 400 nm: 6-second minimum kinetic interval, 
rapid mode 

  

Standard Model: ELx808 

 The following specifications apply only to standard 96-well, flat- or 
round-bottom microplates. 

• Wavelength Range: 380 to 900 nm 

• Filters: 10 nm half-bandwidth interference filters. User-accessible filter wheel.  
Up to 6 filters may be installed on the instrument at one time. Filters supplied:  
405 nm, 450 nm, 490 nm, 630 nm, and two blank filters. 

• Absorbance Measurement Range: 0.000 to 4.000 OD 

Optical specifications for single-wavelength endpoint measurements with a 12-
second read (normal/regular read mode):  

Accuracy:  ± 1.0% ± 0.010 OD from 0.000 to 2.500 OD @ 405 nm 

Linearity:  ± 1.0% from 0.000 to 2.500 OD at 405 nm 
 ± 2.0% from 2.500 OD to 3.500 OD @ 405 nm 

Repeatability:  ± 0.5% ± 0.005 OD from 0.000 to 2.500 OD @ 405 nm 
 ± 1.5% ± 0.005 OD from 2.500 to 3.500 OD @ 405 nm 
 ± 2.5% ± 0.005 OD from 3.500 to 4.000 OD @ 405 nm 

ELx808 Operator’s Manual  
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Optical Specifications for single-wavelength kinetic measurements with read 
intervals of less than 12 seconds:  

Accuracy: ± 2.0% ± 0.010 OD from 0.000 to 2.500 OD @ 405 nm 

Linearity: ± 2.0% from 0.000 to 2.500 OD @ 405 nm 

Repeatability: ± 1.0% ± 0.010 OD from 0.000 to 2.500 OD @ 405 nm 

 The plate can be read at 6-second intervals (rapid mode) with 
wavelengths higher than 400 nm. 

 

Incubator/Ultraviolet Model: ELx808IU 

 The following specifications apply only to standard 96-well,  
flat- or round-bottom microplates. 

• Wavelength Range: 340 to 900 nm 

• Filters: 10 nm half-bandwidth interference filters. User-accessible filter wheel.  
Up to 6 filters may be installed on the instrument at one time. Filters supplied:  
340, 405, 450, 490, 630 nm. 

• Absorbance Measurement Range: 0.000 to 4.000 OD for 400 to 900 nm range, 
0.000 to 3.000 OD for 340 to 400 nm range 

Optical specifications for the 400 to 900 nm range (12-second read in normal/ 
regular read mode): 

Accuracy, Linearity, Repeatability: Same as Standard Model. 

Optical specifications for the 340 to 400 nm range (12-second read in normal/ 
regular mode): 

Accuracy: ± 1.0% ± 0.010 OD from 0.000 to 2.000 OD @ 340 nm 

Linearity: ± 1.0% from 0.000 to 2.000 OD @ 340 nm 

Repeatability: ± 1.0% ± 0.005 OD from 0.000 to 2.000 OD @ 340 nm 

• Incubation: The following specifications apply to a 96-well sealed plate with  
200 μL of liquid in all wells: 

 Temperature Control: Temperature controlled to 50°C 

 Temperature Variation: ± 0.50°C @ 37°C with the plate sealed 

 

BioTek Instruments, Inc. 
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Product Support and Service 

If your instrument or software fails to function properly, if you have questions about how 
to use or maintain your products, or if you need to send an instrument to BioTek for 
service or repair, please contact our Technical Assistance Center (“TAC”). 

Contacting the Technical Assistance Center  

TAC is open from 8:30 AM to 5:30 PM (EST), Monday through Friday, excluding 
standard U.S. holidays. You can send a fax or an e-mail any time. 

Phone: 800-242-4685 (in the U.S.) or 802-655-4740 (outside the U.S.) 

Fax: 802-654-0638 

E-Mail: tac@biotek.com 

Web: www.biotek.com 
 

Please be prepared to provide the following information: 

• Your name and company information  

• A daytime phone or fax number, and/or an e-mail address  

• The product name, model, and serial number  

• The onboard software part number and version (available via the keypad 
by selecting UTIL > TESTS > CHKSUM) 

• Gen5 software version information (Help > About Gen5). 

Returning Instruments for Service/Repair 

If you need to return an instrument to BioTek for service or repair, please contact the 
TAC for a Return Materials Authorization (RMA) number and the shipping address. 
Repackage the instrument according to the instructions at the end of Chapter 2: 
Installation.  
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Chapter 2 

Installation 

This chapter includes instructions for unpacking and setting up the 
ELx808, and instructions for connecting printers and/or serial 
devices. 

Product Registration ......................................................... 10 
1: Unpack and Inspect the Instrument ................................ 10 
2: Select the Operating Environment .................................. 11 
3: Install the Filter Wheel .................................................. 12 
4: Check/Adjust the Power Input Voltage Setting ................. 14 
5: Connect Power ............................................................ 14 
6: (Optional) Connect Printer ............................................. 15 

Printers ...................................................................... 16 
7: Turn on Reader and Run System Test ............................. 16 
8: Check/Adjust the Reader’s Filter Table ............................ 17 
9: Configure Reader Settings ............................................. 18 

SETUP Options ............................................................ 18 
OUTPUT Options .......................................................... 19 
REPORT Type .............................................................. 19 
READ Options ............................................................. 20 
Read Speed ................................................................ 21 

10: Install Software/Connect to Computer (Optional) ............ 21 
Attach the Cable ......................................................... 21 
Install Gen5 Software on the Host Computer ................... 21 
Establish Communication .............................................. 22 
Changing the Baud Rate on the ELx808 .......................... 22 

11: Verify Performance ..................................................... 23 
Before Repackaging the Instrument .................................... 24 
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Product Registration 

Please register your product(s) with BioTek to ensure that you receive important 
information and updates about the product(s) you have purchased. Register online 
through BioTek’s Customer Resource Center (CRC) at www.biotek.com or by contacting 
BioTek Customer Care.  

1: Unpack and Inspect the Instrument 

L Important! Save all packaging materials! If you need to 
ship the reader to BioTek for repair or replacement, you must 
use the original packaging materials. Using other forms of 
commercially available packaging materials is not 
recommended and can void the warranty. Improper 
packaging that results in damage to the instrument may lead to 
additional charges. 

If the original packaging materials have been damaged or lost, 
contact BioTek and ask for PN 7343000. See Product Support 
& Service in Chapter 1 for contact information. 

See Before Repackaging the Instrument at the end of this 
chapter for complete shipping instructions. 

 

 The instrument’s packaging is subject to change. If the instructions in this 
section do not apply to the packaging materials you are using, please contact 
BioTek’s Technical Assistance Center for guidance. 

 
The ELx808 and its accessories are securely packaged inside custom-designed shipping 
materials. This packaging should protect the instrument from damage during shipping. 
Inspect the shipping box, packaging, instrument, and accessories for signs of damage. 

If the shipping box has been damaged: Inspect the instrument for visible dents and 
scratches as you unpack it. 

If the reader is damaged: Notify the carrier and your BioTek sales representative. 
Keep the shipping cartons and the packing materials for the carrier’s inspection. BioTek 
will arrange for repair or replacement of your reader immediately.  

1. (Refer to Figure 1 on the next page.) Carefully open the top of the box, and 
remove any accessories. These include a power cord and power supply, a filter 
wheel in a padded envelope, and an operator’s manual. 

2. Remove the end caps from the reader. 

BioTek Instruments, Inc. 
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3. Lift the reader out of the box, and place it on a level surface. Remove the reader 
from the plastic bag. 

4. Remove the filter wheel from the shipping envelope 

5. Place all packing material back into the shipping box for reuse if the instrument 
needs to be shipped again. 

 

Figure 1: Unpacking the ELx808 

2: Select the Operating Environment  

For best operation, install the reader on a level surface in an area where ambient 
temperatures between 18°C (64°F) and 40°C (104°F) can be maintained.  

The reader is sensitive to extreme environmental conditions. Conditions to avoid are: 

• Excessive humidity: Condensation directly on the sensitive electronic 
circuits can cause the instrument to fail internal self-checks. The humidity must 
be in the range of 10% to 85%, noncondensing. 

• Excessive ambient light: Bright sunlight or strong incandescent light can 
reduce the linear performance range and affect the instrument’s readings.  

ELx808 Operator’s Manual  



12  | Chapter 2: Installation 

• Dust: Optical density readings may be affected by extraneous particles (such 
as dust) in the microplate wells. A clean work area is necessary to ensure 
accurate readings. 

3: Install the Filter Wheel 

The filters that ship with the ELx808 are installed in the six-position filter wheel. For 
example, the standard models have 405, 450, 490, 630 nm filters; the UV model’s filter set is 
405, 450, 490, 630 and 340 nm. 

The filter wheel, which is packaged in a shipping envelope, must be installed before the 
reader is used. If you plan to install additional filters, or change the filter locations, use the 
following instructions to gain access to the filter wheel (refer to  

 

Figure 2 on page 13): 

1. If the reader is on, turn it off and disconnect the power cord or power supply. 

2. Remove the seven screws around the perimeter of the shroud with a 
screwdriver.  

 Tip: Bring the reader to the edge of the work surface to access the screws 
without having to turn the reader upside down. 

3. Carefully lift up the shroud from the front. (Note that the shroud is hinged along 
its back edge.) Hold the plate access door steady, or tape it closed as the shroud 
is being lifted to prevent the door from moving. 

4. Ensure that all locations on the filter wheel contain either a filter or a blank. Each 
location on the filter wheel must be occupied for the reader to operate properly. 
Take a moment to record the filter values in each location  
(e.g., 405 nm in position 1). 

L Important!  Keep track of all filter locations. The physical 
location of the filters must match the filter locations mapped in 
the reader’s software filter table. The filter wheel must have no 
empty locations; all locations must be filled with either a filter 
or a blank plug. Install all filters with the arrow denoting the 
light direction pointing downward. 

5. The filter wheel mount is located in the left-rear corner inside the reader. The 
filter wheel is held in place by a magnet on the filter wheel motor hub. To install 
the filter wheel: 

• Line up the registration notch on the hub and the corresponding peg on the 
filter wheel. 

• Apply firm pressure to attach the filter wheel to the hub. The peg must be 
engaged in the notch for proper installation. 
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• Ensure that the filter wheel is positioned flat against the hub and that it 
rotates freely. 

• Lower the top shroud back into position and remove tape if used to steady 
the plate access door. 

• Reinstall the seven screws removed from the perimeter of the shroud. 

L Important! Be sure to replace the seven perimeter screws; 
they increase the reader’s ability to withstand electrostatic 
discharges and electromagnetic interference. In addition, the 
screws MUST be installed to hold the shroud in place if you 
plan to ship the instrument back to BioTek for service or repair. 

6. To remove the filter wheel, grasp the center hub of the filter wheel and pull it 
toward the lamp. The wheel should easily disconnect from the hub. Lift the 
wheel from the instrument. 

7. To properly store interference filters for the ELx808 during extended periods of 
non-use, package the filters in a light-tight envelope or container, away from 
high humidity and direct sunlight. This will ensure the longest life for the filters. 
When handling the filters, keep the surfaces clean from fingerprints and debris 
by simply wiping with a lens tissue or other lint-free cloth. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2: Installing the Filter Wheel 
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4: Check/Adjust the Power Input Voltage Setting 

For ELx808 readers manufactured before December 2005 only: The reader is 
powered by an internal, adjustable four-voltage range power input module, instead of by 
an external power supply. For instructions for checking or adjusting the power input 
voltage setting, and for reconfiguring or replacing the fuses, refer to Appendix C, 
Adjusting the Power Input Voltage Setting. 

 

5: Connect Power 

ELx808 with the external power supply: 

1. Connect the power cord to the external power supply. 

2. Locate the power inlet on the right side of the reader. 

3. Plug the rounded end of the power supply’s line cord into the power inlet. 

4. Plug the other end of the power cord into an appropriate power receptacle. 
 

ELx808 with the internal power input module: 

1. Locate the power inlet on the right side of the reader. 

2. Plug the rounded end of the power cord into the power inlet.  

3. Plug the other end of the cord into an appropriate power receptacle. 

 

 
Warning! Power Rating. The ELx808 or power supply 
must be connected to a power receptacle that provides voltage 
and current within the specified rating for the system. Use of 
an incompatible power receptacle may produce electrical 
shock and fire hazards. 

 
Warning! Electrical Grounding. Never use a plug adapter 
to connect primary power to the ELx808 power supply. Use of 
an adapter disconnects the utility ground, creating a severe 
shock hazard. Always connect the power supply cord directly 
to an appropriate receptacle with a functional ground. 

 

 

 

BioTek Instruments, Inc. 



6: (Optional) Connect Printer  |  15 

6: (Optional) Connect Printer 

If the ELx808 will operate in standalone mode (that is, without BioTek’s Gen5 software 
running on a host PC), connect a printer directly to the reader using the supplied cable.  

L Important! To avoid system instability, make sure the printer 
and reader are turned OFF before connecting them. 

1. If the reader and/or printer are on, turn them off. Place the printer in a location 
adjacent to the reader. 

2. Attach one end of the parallel cable to the printer’s parallel port. 

3. Attach the other end of the cable to the reader’s parallel port, located on the 
instrument’s rear panel.  

4. Make sure the securing screws on both ends of the cable are tightened. 

5. Turn on the printer. 

 

 

Figure 3: Serial and parallel ports 
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Printers 

The ELx808’s parallel port (LPT1) allows connection to compatible printers. The reader 
supports printers using either HP's PCL3 language, such as the HP DeskJet series, or 
Epson's LQ language. For a list of compatible printers call BioTek's Technical 
Assistance Center or visit our website (refer to Chapter 1 for contact information). 
 

7: Turn on Reader and Run System Test 

If all of the required steps preceding this one have been performed successfully, locate the 
reader’s power switch (on the right side) and turn on the reader. The ELx808 will 
automatically perform a System Test. The System Test conducts a series of tests at each 
wavelength defined in the filter table to confirm adequate light levels, low electronic noise, 
adequate photodiode sensitivity, overall system cleanliness, and (if equipped) proper 
function of the incubator. The testing verifies that the reader will give in-specification 
performance for each set wavelength over the specified OD range.  

If a printer is connected to the reader, the test results  automatically print. This test can also 
be run through Gen5 running on a host PC; consult the Gen5 Help system for instructions. 

• If the test passes, the reader will beep once and the display will show the 
software’s main menu, which will resemble one of the following: 

Standard ELx808: 

R E A D Y    0 1 : 3 0 P M  1 0 / 0 9 / 1 0 

R E A D   D E F I N E  R E P O R T  U T I L 

 
ELx808IU: 

R E A D Y    0 1 : 3 0 P M    3 7 . 0 º C 

R E A D   D E F I N E  R E P O R T  U T I L 

• If the test fails, the reader will beep repeatedly and the display will show an 
error code. If this happens, write down the error code and then press the STOP 
key on the keypad to stop the beeping. Look up the error code in Chapter 6, 
Error Codes to determine its cause.  

If the problem is something you can fix (for example, if the error code is 0201 
or 0301, indicating that the filter wheel is missing), turn off the reader, fix the 
problem, and then turn the reader back on. If the cause is not something you 
can fix, contact BioTek’s Technical Assistance Center. See Chapter 1, 
Introduction for contact information. 
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8: Check/Adjust the Reader’s Filter Table 

After installing the filter wheel (or new filters), ensure that the ELx808’s filter table 
accurately maps the physical location of the filters in the filter wheel.  

1. Turn on the reader if it is not already on.  

2. At the Main Menu screen, select UTIL. 

R E A D Y    0 1 : 3 0 P M  1 0 / 0 9 / 1 0

R E A D   D E F I N E  R E P O R T  U T I L

 
The SELECT UTILITY OPTION menu appears: 

S E L E C T  U T I L I T Y  O P T I O N :    

T E S T S  S E T U P  O U T P U T  R E A D  

 
3. From the Select Utility Option menu, select SETUP. The EDIT SETUP 

INFORMATION screen appears: 

E D I T  S E T U P  I N F O R M A T I O N :  

 D A T E   T I M E  F I L T E R  * M O R E

 
4. Select FILTER. The wavelength currently defined for Filter #1 appears: 

E N T E R                    

F I L T E R # 1  W A V E L E N G T H : 4 0 5  

 
If you need to change the filter wavelength number, use the numeric keypad to 
enter a number at the cursor location. To save the entry and move to the next 
filter on the filter table, press the Enter key. When the last filter has been 
entered, the software exits the filter routine, and displays the following screen: 

E D I T   S E T U P  I N F O R M A T I O N :  

 D A T E    T I M E  F I L T E R  * M O R E

 
5. Press the Main Menu key to return to the Main Menu. 

 

ELx808 Operator’s Manual  



18  | Chapter 2: Installation 

9: Configure Reader Settings 

The ELx808 may be configured a number of ways, depending on user preference. 
Configuration options are accessed via the Select Utility Option menu, and include: 

• SETUP: Set the date and time. 

• OUTPUT: Select whether reports will be output to a Printer, the Computer, or 
both, choose the Column or Matrix report format, and determine if Curves will 
be printed. 

• READ: Indicate whether prompts shall be displayed at run-time for Plate IDs, 
Sample IDs, and Sample Counts. 

• TESTS: Access functions to test reader optics and instrument calibration. 
Check the version of basecode software installed. See Chapter 4, 
Instrument Qualification for more information. 
 

To select the SETUP, OUTPUT, and READ user-configurable options: 

• At the Main Menu screen, select UTIL to access the Select Utility Option menu. 

S E L E C T  U T I L I T Y  O P T I O N :    

T E S T S   S E T U P  O U T P U T  R E A D  

SETUP Options 

1. At the Select Utility Option screen, select SETUP. 

E D I T  S E T U P  I N F O R M A T I O N :  

 D A T E   T I M E  F I L T E R  * M O R E

 
2. At the Edit Setup Information screen, select DATE.  

D A T E :   1 0 / 0 9 / 0 7       M D Y

M M D D Y Y       D D M M Y Y       

 
3. Enter the new date, using the numeric keys. The cursor is positioned under the 

first editable field, and advances automatically. To change the date format, select 
MMDDYY or DDMMYY. The display updates to reflect the new format. 

4. Press Enter to return to the Edit Setup Information screen. 

T I M E :    0 3 : 1 1 P M      1 2 H R

1 2 H O U R      2 4 H O U R   A M / P M
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5. To edit the Time, select TIME. At the Time Entry Screen, use the numeric keys to 

enter the correct time.  

6. Select a 12- or 24-hour format by pressing the soft key beneath these options. The 
display automatically updates with the new time AM/PM format. 

7. Press the Previous Screen key to return to the Select Utility Option menu. 

OUTPUT Options 

1. At the Select Utility Option screen, select OUTPUT to set report output 
preferences. 

R E P O R T  O U T P U T ?  B O T H      

P R I N T    C O M P U T E R   B O T H   

 
2. Any previously defined selection appears on the top line of the display. Select 

the desired option (PRINT, COMPUTER, BOTH) to change the output device. 

3. Press Enter to advance to the Select Printer menu screen. If COMPUTER is 
selected, all results will be transferred directly to the computer screen via the 
RS232 serial port. 

S E L E C T  P R I N T E R      E P S O N

E P S O N     H P                  

 

REPORT Type 

 These selections only apply when the reader is run in standalone mode 
(without Gen5). See Appendix A for examples of Reports. 

1. At the Select Printer screen, press Enter to advance to the REPORT TYPE menu 
screen. 

R E P O R T  T Y P E :  M A T R I X      

C O L U M N       M A T R I X     B O T H

 
2. The current selection appears on the top line of the display. Select the desired 

option (COLUMN, MATRIX, BOTH) to change the Report Type.  
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3. Press Enter to advance to the SAMPLES ON COL RPT screen. 

S A M P L E S  O N  C O L  R P T ?   N O  

 Y E S      N O                   

 
4. Select YES to print samples on the column report, or NO to omit them. 

5. Press Enter to advance to the PRINT CURVE-FIT screen. 

P R I N T  C U R V E - F I T ?      N O  

 Y E S     N O                 

 
6. The current selection is displayed on the top line of the screen. To change the 

report option, select YES or NO. The display updates to reflect the selection. 
(Select YES if there are quantitative assays defined on board and you wish to 
print the curve.) 

7. Press Enter to return to the Select Utility Option screen. 

READ Options 

1. At the Select Utility Option screen, press the soft key beneath READ to set up 
Reader Prompt preferences. Select YES to prompt the operator to enter 
identifications and sample counts before a microplate is read. The prompts are 
shown below. 

2. Press Enter after each selection to advance the display. 

P R O M P T  F O R  P L A T E  I D ?   N O  

 Y E S     N O                 

 
3. PROMPT FOR PLATE ID allows the user to enter an alphanumeric name of up 

to 10 characters. Select YES to present this prompt at run-time. 

P R O M P T  F O R  S A M P L E  I D ?   N O

 Y E S     N O                 

 
4. PROMPT FOR SAMPLE ID allows the user to identify samples with a  

4-character alphanumeric name. The starting ID is entered and automatically 
incremented by the software. Select YES to present this prompt at run-time. 

P R O M P T  S A M P L E  C O U N T ?    N O

 Y E S     N O                 
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5. PROMPT SAMPLE COUNT allows the user to enter the total number of samples 

on the plate at runtime; only those sample results will be printed. Select YES to 
present this prompt at run-time. 

Read Speed 

R E A D  I N  R A P I D  M O D E ?     N O

 Y E S     N O                 

 

RAPID MODE reads a 96-well plate at 6-second intervals with wavelengths higher 
than 400 nm. Selecting NO means a plate with single-wavelength kinetic 
measurements will be read in intervals less than 12 seconds (“Regular” or “Normal” 
Mode). Specifications for these modes are outlined in Chapter 1. 

 

10: Install Software/Connect to Computer 
(Optional) 

The ELx808 has serial (RS232) port located on back of the reader (see Figure 3 on page 15). 
This port allows the reader to communicate with a computer using the BioTek Gen5 
software. It also allows for upgrades to the ELx808 basecode (on-board) software. 

Attach the Cable 

• Turn off the computer and the reader.  

• Connect the supplied serial cable to both machines. 

Install Gen5 Software on the Host Computer 

L 
If applicable, install Gen5 on the host computer. There is a 
certain sequence of events that must be followed to ensure 
that the software is properly installed and configured. Please 
follow the instructions provided in Gen5 Getting Started 
Guide to install the software. 
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Establish Communication  

1. Start Gen5 and log in if prompted. The default System Administrator password is 
admin.  

2. Go to the Gen5 main screen: 

• Gen5 version 2.x users: From the Task Manager, select Setup > Go to System 
Menu. 

• Gen5 version 1.x users: From the Welcome screen, select System Menu. 

3. Select System > Instrument Configuration and click Add. 

4. Set the Reader Type to ELx808. 

5. Set the Com Port to the computer’s COM port to which the reader is connected. 

6. Click Test Comm. Gen5 attempts to communicate with the reader. If the 
communication attempt is successful, return to the Gen5 main screen. 

If the communication attempt is not successful, try the following: 

• Is the reader connected to the power supply and turned on? 

• Is the communication cable firmly attached to both the reader and the 
computer? 

• Did you select the correct Reader Type in Gen5? 

• Try a different COM port. 

• Make sure the reader display is at its Main Menu. 

If you remain unable to get Gen5 and the reader to communicate with each other, 
contact BioTek’s Technical Assistance Center.  

Changing the Baud Rate on the ELx808 

 Gen5 requires the baud rate to be set to 9600. 

If you need to change the baud rate from the default of 9600 to either 1200 or 2400: 

1. Turn on the instrument if it is not already on. 

R E A D Y    0 1 : 3 0 P M  1 0 / 0 9 / 0 7

R E A D   D E F I N E  R E P O R T  U T I L

2. At the Main Menu screen, select UTIL. 

S E L E C T  U T I L I T Y  O P T I O N :   

T E S T S  S E T U P  O U T P U T   R E A D  
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3. At the Select Utility Option screen, select SETUP. 

E D I T  S E T U P  I N F O R M A T I O N :  

 D A T E   T I M E  F I L T E R  * M O R E

4. At the Edit Setup Information screen, select *MORE to advance to the EDIT 
SETUP / RS232 option screen. 

E D I T  S E T U P  I N F O R M A T I O N :  

R S 2 3 2    C A L P L A T E     * M O R E

5. Select RS232 to access the Select Baud Rate menu. The top line of the 
display shows the baud rate currently set. 

S E L E C T  B A U D  R A T E :  9 6 0 0   

 1 2 0 0   2 4 0 0   9 6 0 0  V I E W   

6. To change the Baud rate, press the soft key beneath the desired baud rate. 
The display (top line) automatically updates to reflect the new choice. 

7. To view the reader’s settings for parity, stop bits, and data bits, select 
VIEW. 

 

11: Verify Performance 

Before using the ELx808 for the first time, verify that the reader is operating properly by 
running a System Test and the Absorbance Plate Test. These tests and additional 
verification procedures are described in Chapter 4, Instrument Qualification. 
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BioTek Instruments, Inc. 

Before Repackaging the Instrument 

L Important! Use the instrument’s original shipping container 
and packaging material. This shipping system was designed to 
be used no more than five times. If the container is damaged 
and/or has been used more than five times, contact BioTek for 
a new set of shipping materials, and ask for PN 7343000.  

The instrument’s packaging design is subject to change. If the 
instructions in this section do not appear to apply to the 
packaging materials you are using, please contact BioTek’s 
Technical Assistance Center for guidance. 

 
Warning! If the reader has been exposed to potentially 
hazardous material, decontaminate it to minimize the risk to 
all who come in contact with the reader during shipping, 
handling, and servicing. Decontamination prior to shipping is 
required by U.S. Department of Transportation regulations 

 

1. Decontaminate the reader prior before shipping. Refer to Decontamination in 
Chapter 5, Preventive Maintenance, for instructions. 

2. Once the reader is clean, pack it in its original shipping box, using the original 
packing materials (see Figure 1 on page 11).  

3. Contact BioTek’s Technical Assistance Center for a Return Materials 
Authorization (RMA) number and shipping instructions. 

 

 

 



Chapter 3 

Operation 

This chapter includes instructions for operating the ELx808 Reader 
and its software.  
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Beginning the Plate Read .............................................. 72 
Printing Reports and Assay Lists ......................................... 73 

Result ........................................................................ 74 
Editing Standard Outliers .............................................. 74 
Printing Results ........................................................... 75 
Map ........................................................................... 75 
Assay ........................................................................ 76 
List ........................................................................... 76 

Recommendations for Optimum Performance ....................... 76 
 
 
 
 

 

L Some readers have custom programmed assays installed. 
Not all features of the software discussed in this chapter are 
available on custom instruments. Please contact BioTek’s 
Technical Assistance Center (TAC) if you have any questions 
about the assays on your reader 

All users should read Recommendations for Optimum 
Performance on page 76. 
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Getting Started with Gen5 

These instructions describe how to create and run an Experiment in Gen5. For more 
information, or if the instructions below do not match what you see in Gen5, refer to the 
Gen5 Getting Started Guide and help system. 

Gen5 version 2.x users: 

1. Start Gen5.  

2. If the Task Manager appears, select Read Now > New and skip to step 4. 
Otherwise, select File > New Task from the main view. 

3. Select Read Now > New. Gen5 will open the procedure dialog. Go to step 4.  

Gen5 version 1.x users: 

1. Start Gen5. If the Welcome screen appears, select Read a Plate and skip to 
step 4. Otherwise, select File > New Experiment from the main view. 

2. Click Default Protocol and click OK. Gen5 will open the Experiment 
workspace, which includes the Protocol menu tree and Plate screen. 

3. Select Plate > Read or click the Read Plate icon. The Procedure dialog will 
open. Go to step 4. 

For any version: 

4. Select a Plate Type.  

5. Click Read to open the Read Step dialog. 

6. Select a Read Type. 

7. Select or enter the wavelength(s) at which the plate will be read. 

8. Define other reading parameters as desired. Click Help for assistance. 

9. When complete, click OK to return to the Procedure dialog. 

10. Click OK to save and close the Procedure dialog.  

• Gen5 version 1.x only: The Plate Reading dialog will open. Enter any 
desired information, place the plate on the carrier, then click READ to 
begin the plate read. If the Save As dialog opens, enter a File name, 
choose a file location (Save in:) and click Save. 

11. Click OK when the Load Plate dialog appears. The plate will be read. 

• To view the raw data results, use the Data drop-down arrow in the 
Plate screen to select one wavelength. The results will be displayed for 
the selected wavelength. Repeat, for other wavelengths. 

• To analyze, manipulate, or print results, Protocol parameters should be 
defined. Refer to the Gen5 Help system for instructions. 
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Introduction  

The front panel on the ELx808 Reader features a 25-pad keypad and a 2-line x 24-character 
LCD display as the user interface (see Figure 4 below). The reader’s bidirectional serial 
port allows computer control of the instrument and provides the means for downloading 
additional assay protocols to the instrument. 

 

 

Figure 4: ELx808 Front Panel with LCD and Keypad 
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The Keypad 

 Use the four “soft keys,” located directly below the display, to select 
options presented on the display. For example, from the Main Menu, 
press the leftmost soft key to select READ, the rightmost to select UTIL. 

 Exit the current screen and return to the Main Menu. After defining a 
reader program, press the Main Menu key, then press YES to save the 
program. 

 To scroll through the different options within a program, press the 
Options key or the Shift + Options key combination. Press the 
Enter key to select the current option. 

 Pressing Enter generally saves the current screen settings and 
advances to the next screen in a series. 

 To move to a previous menu, press the Previous Screen key. 

 Press Clear to clear/reset the current value on the reader’s LCD 
display. 

 Press the ◄ (reverse) arrow to move the cursor to the left in the LCD 
display. 

 Press the ► (forward) arrow to move the cursor to the right in the LCD 
display. 
 

 

To start running a reader program, press the Read key.  

 

 
To stop running (abort) a reader program, press the Stop key. 

Main 
Menu 

Options 

ENTER 

Previous 
Screen 

CLEAR 

◄  

►  

READ 

STOP 
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The Startup Screen 

To turn on the ELx808, press the on/off switch on the right side of the reader’s 
base. The ELx808 will perform a system self-test, displaying the screens shown 
below until initialization is complete. During this time, all keys are inactive.  

If the self-test fails, the reader will “beep” and display an error code. Press Stop to 
stop the beep. Refer to Chapter 6, Error Codes, to interpret these codes. Contact 
BioTek Instrument’s Technical Assistance Center (see page 7), for further 
assistance with troubleshooting. 
 

P O W E R U P  S E Q U E N C E  V X . X X    

I N I T I A L I Z I N G . . .          

 

B I O T E K    E L X 8 0 8              

S E L F - T E S T . . . . .           

 

The Main Menu Screen  

Following successful power-up of the ELx808, the Main Menu screen is displayed. 
This screen will vary slightly if the instrument has the Incubation/UV option:  

Main Menu screen – ELx808   

R E A D Y    0 1 : 3 0 P M  1 0 / 0 9 / 0 7 

R E A D   D E F I N E  R E P O R T  U T I L 

Main Menu screen – ELx808IU (model with incubation/UV capability) 

R E A D Y    0 1 : 3 0 P M    3 7 . 0 º C 

R E A D   D E F I N E  R E P O R T  U T I L 

 
 Note: The temperature indicated on the display of incubated models is 

the actual averaged temperature of the incubator’s four zones. The 
applied setpoint of the last assay is used. To adjust the temperature, a 
new setpoint value must be assigned to the assay before running. 
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The keyboard’s four “soft keys,” located below the on-screen menu options 
(READ, DEFINE, REPORT and UTIL), are activated, and may be selected. Press 
the soft key that corresponds to a displayed menu option to select that option: 

• READ option:  Initiate a plate read (or, press the key labeled READ on the 
keyboard for plate reading prompts). You will be prompted to select from a 
list of available assays. 

• DEFINE option:  Create a reading and data reduction protocol. You will be 
prompted to select/edit an assay and then define its various parameters. 

• REPORT option:  Print results reports and protocol descriptions. For results 
reports, you will be prompted to select a previously run assay with valid 
data. 

• UTIL option:  Access various onboard utilities, used for configuring and 
testing the reader. 

Quick Read 

On some readers, Assay 01 has been designed to allow for quick and simple 
assay programming. It appears as _Quick Read on the display. Most of the 
options available in Assays 2 through 55, and described in this section, are 
unavailable for programming within Quick Read. You can access the Quick Read 
assay when READ is selected from the main menu. 

The Quick Read assay DEFINE settings are shown below, and cannot be edited, 
except where noted: 

METHOD 

• Single Wavelength 405 nm (editable) 

MAP 

• 96-well plate geometry 

• Blank on Air 

• Automap 

• Map starting location A1 

• Samples only (no blanks, standard, or controls) 

• Sample count prompted at runtime (can be turned off in UTIL > READ 
options) 
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Defining Assays 

 Note: Appendix B, Instructions for Programming a New Assay, 
provides two examples of assay kit instructions and step-by-step 
directions for programming each assay. The appendix includes two 
sample assays: one with a ratio transformation calculation and a 
POS/NEG cutoff determination, and another with a standard curve. 

 

The Main Menu option, DEFINE, allows you to customize previously defined assays 
stored in the reader’s memory. 

• From the Main Menu, press the soft key beneath the DEFINE menu option to 
advance to the SELECT ASSAY NUMBER screen. 

Selecting an Assay 

At the SELECT ASSAY NUMBER screen:  

1. Use the NUMERIC keys to enter the number of predefined Assay Definition 
files stored in the reader’s memory, or use the OPTION key to advance one 
assay at a time. The cursor is positioned at the first editable field, and 
advances automatically. The numeric range depends on the number of 
assays (1-55 or more if custom programmed) programmed in the reader’s 
memory.  

2. The assay’s name and number are displayed on the screen.  

S E L E C T  A S S A Y  N U M B E R :     6 5 

N A M E : H B S - A G 1             

3. Press Enter to select the assay and advance to the Name screen. You may 
change the default assay name to a more descriptive one (see Assay Name 
on the next page). 

4. Press Enter to advance to the Edit Assay Name screen. 

Assay Name 

At the Assay Name screen, edit the name assigned to the Assay. The assay name 
can be up to 16 characters. 
 

E D I T  > H B S - A G 1               

 -       /      :     S P A C E 

 

BioTek Instruments, Inc. 



Defining Assays  |  33 

• Press the ALPHA and NUMERIC keys to update the assay name. The cursor 
is positioned at the first editable field. 

• Press the OPTION key to sequentially advance the character positioned 
above the cursor. The characters will cycle through the alphabet (A-Z), with 
a space character following Z.  

• Press Clear to clear the assay name from the display.  

• Use the Left and Right Arrows to move the cursor to the previous or next 
editable field. The cursor will wrap around the edit field. 

• Press Soft Keys 1, 2, 3, and 4 when using alphanumeric characters on the 
display above the soft key in the assay name. 

In addition: 

• Press the Main Menu key to return to the Main Menu screen. 

• Press Previous Screen to save the contents of the display and return to 
the previous screen. 

• Press Enter to save the contents of the display and advance to the next 
screen. 

 

Defining the Method, Map, Formula, and Curve 

The DEFINE Option screen allows you to edit the Method, Map, Formula or Curve 
Fit. 
 

D E F I N E                     

M E T H O D   M A P  F O R M U L A  C U R V E 

Press the soft key beneath the displayed option to access the following functions: 

• SOFT KEY 1: METHOD is selected, and the user is prompted to select the 
read method parameters. 

• SOFT KEY 2: MAP is selected and the user is prompted for plate mapping 
information. 

• SOFT KEY 3: FORMULA is selected and the user is prompted to enter a 
formula. 

• SOFT KEY 4: CURVE FIT is selected and the user is prompted for curve-fit 
options. 

• In addition, the MAIN MENU, PREVIOUS SCREEN and ENTER keys are 
active, allowing you to move back and advance through the menu 
structure. 
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METHOD 

The definition of a method includes selecting: 

• Endpoint, Kinetic or Scanning Read Modes 

• Delay First Read 

• Incubation Parameters 

• Filter Wavelengths Applied 

• Shake Parameters 

• Kinetic Analysis 

 Note: Some screens shown below and on the following pages may not 
appear on some reader models. 

Read Type 

This option allows you to enter which read type: Endpoint, Kinetic, or Scan. 
The following keys are active during this screen: 
 

R E A D  T Y P E : K I N E T I C             

E N D P O I N T    K I N E T I C  S C A N   

• Press SOFT KEY 1 to select Endpoint read mode. Press SOFT KEY 2 to 
select Kinetic read mode. 

• Press Enter to save the displayed value and advance to the next screen. 

Delay in First Read  

Selecting the Delay in First Read option allows you to enter a time delay before 
the first read. 
  

D E L A Y   F I R S T  R E A D           

T I M E :    X X : X X             

• Enter the time in minutes and seconds, using the numeric keys. 

• Press Enter to advance to the INCUBATION TEMPERATURE screen. 
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Incubation Temperature 

The incubation temperature screen allows you to set the assay incubation 
temperature. 
 

I N C U B A T I O N  T E M P :  3 7 C       

A M B I E N T      T E M P E R A T U R E  

• Press SOFT KEY 1 or 2 to select ambient incubation.  

• Press SOFT KEY 3 or 4 to select an adjustable temperature. 

• Use the LEFT and RIGHT ARROW keys to move the cursor between 
the two digits on the input temperature. 

• Use NUMERIC keys to enter the incubation temperature, up to 50°C. 

• Press Enter to save and advance to the next screen. 

 

Single or Dual Wavelength 

The WAVELENGTH selection screen allows you to select SINGLE or DUAL 
wavelength for the assay.  
 

W A V E L E N G T H :  D U A L           

S I N G L E   D U A L              

• Press SOFT KEY 1 to select SINGLE wavelength. The reader will 
measure the optical density of each well with a single filter. 

• Press SOFT KEY 2 to select DUAL wavelength. Each well will be read 
twice, each time with a different filter. Note: The microplate is not 
removed from the reading chamber between the two measurements. 
The final reported optical density is the difference between the two 
readings. Dual wavelength readings can significantly reduce optical 
interference caused by scratched or fingerprinted microplates since the 
scratches or fingerprints reduce the amount of light on both 
wavelengths. 

• Press Enter to save the selection and advance to the next screen.  
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MEAS Selection 

The MEAS selection screen allows you to select the filter(s) for the assay. The 
currently selected filter appears on the top line of the display, and the available 
options appear on the bottom. 
 

M E A S : 4 5 0  R E F : 6 3 0           

4 0 5      4 5 0    4 9 0     6 3 0  

• Press SOFT KEYS 1, 2, 3, and 4 to select the filter option displayed 
above the soft key. The display updates to reflect the selection. 

• Press the right arrow key to select the Reference Filter. 

• Press ENTER to move to the next screen. 

Number of Kinetic Reads/Kinetic Duration Selection 

This menu allows you to either select the total number of kinetic reads or the 
length of time the assay will run (kinetic duration). Any previously defined 
value is shown on the top line of the display and the options on the second. 
 

K I N E T I C :  T O T A L  R E A D S       

T O T A L  R E A D S   D U R A T I O N    

• Press SOFT KEY 1 to select the total reads option. 

• Press SOFT KEY 3 to select the duration option. 

• Press Enter to save the selection and advance to the next screen. 
 

Kinetic Interval  

Use this screen to enter the interval of time between each kinetic read. 
 

K I N E T I C                    

I N T E R V A L :   0 1 : 2 3 : 5 6      

• Use the NUMERIC keys to enter the time duration. Valid ranges are: 0-1 
hours, 0-59 minutes and 0-59 seconds. The number of Reads = 
Duration/Interval must be less than or equal to 40 and more than or 
equal to 2. 
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• Use the LEFT and RIGHT ARROW keys to move to the next or previous 
numeric entry fields. 

• Press Enter to save the value and advance to the next screen. 

Kinetic Number of Reads 

T O T A L  N U M B E R               

O F  K I N E T I C  R E A D S :      0 6 

• Use the NUMERIC keys to enter the number of reads required. The 
range is 2 to 40 reads. 

• Press Enter to save the entry and advance to the next screen. 

Kinetic Duration 

Use this screen to enter the duration of the kinetic reaction. 
 

K I N E T I C                    

D U R A T I O N :  1 1 : 2 3 : 4 5       

 

• Use the NUMERIC keys to enter the time duration in hours, minutes, 
and seconds. The maximum duration time is 80 hours.  

• Use the LEFT and RIGHT ARROW keys to move between entry fields. 

• Press Enter to save the entry and advance to the next screen. 

Shake Mode Selection 

S H A K E :  B E F O R E  E V E R Y  R E A D 

F I R S T  E V E R Y   N O N E        

 
• Press SOFT KEY 1 to select shaking for the first read only or endpoint 

read.  

• Press SOFT KEY 2 to select shaking for every read.  

• Press SOFT KEY 3 to select no shaking. 

• Press ENTER to save the selection and advance to the next screen. 

• Press SCREEN key to save the selection and return to a previous screen. 
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Shake Time 

S H A K E   T I M E :  0 0 : 1 2 : 3 4       

C O N T I N U O U S               

 
• Use the NUMERIC keys to enter the shake interval. Valid ranges are:  

0-1 hours, 0-59 minutes and 0-59 seconds. 

• Use the LEFT and RIGHT ARROW keys to move the cursor between 
hours, minutes, and seconds. 

• Press Enter to save the entry and advance to the next screen. 

 Note: "Continuous" appears on the display when a kinetic assay with a 
previously specified shake has been selected. 

Shake Speed 

The shake movement is a repeated 0.021-inch movement from the shake 
position and back. 
 

S H A K E   S P E E D :    M E D I U M      

L O W   M E D I U M  H I G H   V A R I   

 
• Press SOFT KEY 1 to select low-speed shaking.  

• Press SOFT KEY 2 to select medium-speed shaking.  

• Press SOFT KEY 3 to select high-speed shaking. 

• Press SOFT KEY 4 to select variable-speed shaking (1 second of each 
speed repeated). 

• Press Enter to save the entry and advance to the next screen. 

Kinetic Data Analysis Selection 

K I N E T I C  A N A L Y S I S :  R - S Q R   

 R A T E  R - S Q R  O N S E T        

 
• Press SOFT KEY 1 to select the kinetic rate calculation. This method 

will apply a linear fit to calculate the maximum slope based on the 
number of kinetic points specified. 
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• Press SOFT KEY 2 to select the R-squared rate calculation. This method 
will calculate the R-squared value at the maximum slope, based on the 
linear curve fit and the number of kinetic points specified. 

• Press SOFT KEY 3 to select the time calculation, which will calculate 
the time for each well to reach the onset optical density. 

• Press ENTER to save the selection and advance. 

Number of Kinetic Points Selection 

Use this screen to select the number of sequential kinetic points to calculate the 
steepest Rate, or the R squared at the steepest Rate. 
 

K I N E T I C  P O I N T S :  3          

A L L  P O I N T S               

 
• Use the NUMERIC keys to input the number of points. The range is 2 to 

MAX where max is the total number of reads. 

• Press SOFT KEY 1 or 2 to select ALL POINTS.  

• Press Enter to save the entry and advance to the next screen. 

Onset OD Selection 

Use this screen to enter the onset OD time. 
 

E N T E R                       

O N S E T  O D :  1 . 2 3 4          

 
• Use NUMERIC keys to enter the onset OD. 3.000 OD is the maximum 

value.  

• Use the LEFT and RIGHT ARROW keys to move the cursor within the 
entered OD field.  

• Press the Enter key to save the entry and advance. 

Linear Scanning  

If Scanning is chosen as the Read Type, use the following screen to enter the 
total number of points to be read in a line across the center of each well. 
 

E N T E R   N U M B E R  O F            

S C A N   P O I N T S :           1 5 
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The maximum number of points selectable is 31 (odd numbers only). The 31 
scan positions are fixed in the software. You must determine the optimal 
number of scans per well. If, for example, 7 scans across the well is chosen, the 
reader will read the centermost seven points in the well. The more scan points 
chosen, the closer to the well sides reads will be taken. 

 Note: If too many scans are chosen, the reader may be reading 
the sides of the well. 

The reader will read the chosen number of points across the well and report 
the calculated area under the curve. 

MAP 

The MAP Definition screen allows you to edit or specify the following options in 
the assay: 

• Automatic or Manual Map Generation 

• Mapping Direction 

• Replication Direction 

• Blank Map Selection 

• Blanking Constant  

• Number of Blanks 

• Location of Blanks 

• Number of Standards 

• Number of Standard Replicates 

• Averaging of Standards 

• Concentration and Location of Standards 

• Number of Controls 

• Control Type Definition 

• Number of Control Replicates 

• Control Location 

• Number of Samples 

• Number of Sample Replicates 

• Averaging of Samples 

• Sample Location 
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 Note: Some of the following screens may not appear, depending on the 
reader model. The valid range of the number of standards is 0-12. The 
valid range of valid replicate counts for standards is 1-8. The valid range of 
the number of controls is 0-8. The range of valid replicate counts for 
controls and samples is 1-12. 

 

D E F I N E :                    

M E T H O D   M A P  F O R M U L A  C U R V E 

• At the DEFINE Options screen, press SOFT KEY 2 to begin the plate MAP 
process. 

Map Generation 

“Map Generation” represents the method by which blanks, controls, standards, 
and/or samples are assigned to specific locations on the plate. The currently 
selected value appears on the top line of the display, and the available options 
appear on the bottom. 
 

M A P  G E N E R A T I O N :  M A N U A L     

A U T O   M A N U A L             

Automatic Plate Map Generation: Select AUTO to instruct the software to 
automatically generate a plate map after the blanks, controls, standards, 
and/or samples have been defined. 

Manual Plate Map Generation: Select MANUAL to indicate that the well 
assignments will be performed manually (by the user) at Define and/or Read 
time. 

• Press SOFT KEY 1 for automatic sample plate map generation. The 
display will update to reflect the selection. 

• Press SOFT KEY 2 for MANUAL plate map generation. The display 
updates to reflect the selection. 

• Press ENTER to save the selection and move to the next screen. 

 Note: Press SHIFT-CLEAR to clear any previously defined 
manual map. 
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Mapping Direction 

Use this option to select how the wells are mapped on the plate. Any 
previously defined Mapping Direction appears on the top line of the display; 
the available options appear on the second line. 
 

M A P P I N G  D I R E C T I O N : D O W N     

 D O W N  A C R O S S             

• Press SOFT KEY 1 to map DOWN the column. 

• Press SOFT KEY 2 to map ACROSS the row. 

• Press ENTER to save the selection and move to the next screen. 

 

Replication Direction  

This option allows you to specify how replicates are mapped on the plate. The 
currently selected Replication Direction appears on the top line of the display, 
and the available options appear on the bottom.  
 

R E P   D I R E C T I O N :     A C R O S S 

 D O W N  A C R O S S             

• Press SOFT KEY 1 to map the replicates DOWN the column, following 
the direction of the map listing. 

• Press SOFT KEY 2 to map the replicates ACROSS (in a paired format). 
As an example, two replicates can be placed in A1 and A2 wells. The 
third replicate would follow in B1. The next standard control, or 
sample, would follow in B2. 

• Press ENTER to save the selection and advance. 

 
Examples of mapping and replication directions are shown on the 
next page. 
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EXAMPLES OF MAPPING & REPLICATION DIRECTIONS 
 
Map Direction DOWN, Rep Direction DOWN: 

 1 2 3 4 5 6 7  8 9 10 11 12 

A STD1 STD5 SMP          

B STD1 STD5 SMP          

C STD2 PC SMP          

D STD2 PC           

E STD3 NC           

F STD3 NC           

G STD4 SMP           

H STD4 SMP           

 
Map Direction ACROSS, Rep Direction ACROSS: 

 1 2 3 4 5 6 7  8 9 10 11 12 

A STD1 STD1 STD2 STD2 STD3 STD3 STD4 STD4 STD5 STD5 PC PC 

B NC NC SMP SMP SMP SMP SMP SMP     

C             

D             

E             

F             

G             

H             

 
Map Direction DOWN, Rep Direction ACROSS: 

 1 2 3 4 5 6 7  8 9 10 11 12 

A STD1 STD1           

B STD2 STD2           

C STD3 STD3           

D STD4 STD4           

E STD5 STD5           

F PC PC           

G NC NC           

H SMP SMP           

 
Map Direction ACROSS, Rep Direction DOWN: 

 1 2 3 4 5 6 7  8 9 10 11 12 

A STD1 STD2 STD3 STD4 STD5 PC NC SMP SMP    

B STD1 STD2 STD3 STD4 STD5 PC NC SMP SMP    

C             

D             

E             

F             

G             

H             
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Start Mapping at Well Location 

The Start Mapping at Well Location screen is only shown if automatic mapping 
is selected. This option allows you to enter the location of the well that will be 
the starting point for automatic mapping.  
 

S T A R T   M A P P I N G                 

A T   W E L L  L O C A T I O N :     A 0 1 

• Use the LEFT and RIGHT ARROW keys to move the cursor to the 
previous or next editable field. The cursor will wrap around the edit 
field. 

• Use the NUMERIC and ALPHA keys to enter a letter or number at the 
cursor location. For all prompts of a well location, only the ALPHA keys 
are active for the first character and NUMERIC for the second and third 
characters.  

• Press ENTER to save the well location and advance to the next screen. 

 

Selecting a Blank Map 

This option allows you to select which blanking method to apply to the assay. 
The currently selected Blank Map value appears on the top line of the display, 
and the available options appear on the bottom.  

The blanking options, AIR, FULL and CONSTANT, ROW and COLUMN, and 
P-ACROSS and P-DOWN are displayed on three screens. 
 

B L A N K   M A P :      F U L L           

 A I R       F U L L   C O N S T  * M O R E 

 
B L A N K   M A P :      F U L L           

 R O W    C O L U M N        * M O R E 

 
B L A N K   M A P :      F U L L           

  P - A C R O S S   P - D O W N  * M O R E 
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• Press SOFT KEYS 1, 2, or 3 to select the BLANK MAP type above the 
soft key. The display updates to reflect the selection. 

• Press SOFT KEY 4 to access MORE options: ROW or COLUMN, and 
P-ACROSS or P-DOWN. 

• Press ENTER to save the well location and advance to the next screen. 

Blank Map Definitions 

• AIR performs an initial reading on “air” just prior to the plate read, and 
uses that value as the blank value. This value is subtracted from each 
well on the plate. 

• FULL enables a single blank well or an average of blank wells to be 
subtracted from the whole plate. 

• CONST (Constant) allows entry of a user-specified absorbance value. 
This value will be subtracted from each well on the plate. Use a blank 
value from the first plate, or a blanking plate to save space on 
subsequent assay plates. 

• ROW enables a single blank well or an average of blank wells to be 
selected for each row. The blank (or average) will be subtracted from 
each well in the row. Use manual mapping to position blanks, controls, 
standards, and samples. 

• COLUMN enables a single blank well or an average of blank wells to be 
selected for each column. The blank (or average) will be subtracted 
from each well in the column. Use manual mapping to position blanks, 
controls, standards, and samples. 

• P-DOWN enables a blank in every even numbered column to be 
subtracted from the well to the left of it in every odd column. Manual 
mapping is recommended to set up the appropriate map by placing the 
standards, controls, and samples in only the odd columns. 

• P-ACROSS enables a blank in the B, D, F and H rows to be subtracted 
from the well above in the A, C, E and G rows. Manual mapping is 
recommended to set up the appropriate map by placing the standards, 
controls, and samples in only the A, C, E, and G rows.  
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Constant Blank Value Entry 

This entry screen only appears when a Constant Blank map is selected. Enter 
the value to be subtracted from each well on the plate. 
 

E N T E R                          

B L A N K I N G  C O N S T A N T :  0 . 0 0 0 

• Use the NUMERIC keys to enter the value. The range is 0.000 to 3.000. 
The cursor is positioned at the first editable field and advances 
automatically. 

• Press the CLEAR key to clear the value on the display.  

• Press the ENTER key to save the value and advance. 

Number of Blanks 

The Number of Blanks field allows you to enter the number of blank wells in 
the assay. This entry screen is only displayed when Full, Column, or Row 
blank map is selected.  
 

E N T E R  N U M B E R  O F          

B L A N K S :                0 2 

• Use the NUMERIC keys to enter the number of blanks. The range is 0 to 
48. 

• Press the CLEAR key to clear the Number of Blanks value from the 
display. 

• Press the ENTER key to save the value and move to the next screen. 

Selecting a Blank Location 

The Blank Location screen allows you to define where the blank well is located 
on the microplate. This screen only appears if manual map generation has been 
selected. Any previously defined value is displayed.  
 

E N T E R   T H E  L O C A T I O N  O F      

B L A N K # 1 :                A 1 2 

• Use the NUMERIC and ALPHA keys to enter a Blank Location, based 
upon the plate geometry.  
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• Use the ARROW keys to move the cursor to the next or previous 
editable field. The cursor is positioned beneath the first editable field. 

• Press the ENTER key to save the value, and move to the next screen. 

Number of Standards 

Use this option to enter the number of standards that will be used in the assay. 
Any previously defined value will be displayed on the screen. If the number of 
standards is altered, the number of replicates for the standard automatically 
defaults to 1.  
 

E N T E R   N U M B E R  O F               

S T A N D A R D S :               0 2 

 
• Use the NUMERIC keys to enter the Number of Standards. The valid 

range depends on the selected curve fit method. The maximum number 
of standards is 12. The minimum is 4 for 4-P fit, cubic, cubic spline, and 
2-P; 3 for quadratic; and 2 for linear and point-to-point. 

• Press CLEAR to clear the value on the display. 

• Press ENTER to save the value, and move to the next screen. 

Number of Standard Replicates 

E N T E R   N U M B E R  O F               

S T A N D A R D  R E P L I C A T E S :     0 2 

• Use the NUMERIC keys to enter the Number of Replicates per 
Standard. The range is 1 to 8 replicates. The software will verify that the 
number of replicates, multiplied by the number of standards, does not 
exceed the number of wells on the plate. 

• Press CLEAR to clear the value on the display. 

• Press ENTER to save the value and move to the next screen. 

Average Standards 

The Average Standards option allows you to select whether or not to average 
the Replicates of a Standard. This average is used to calculate the standard 
curve instead of using the individual replicate of each standard. Note: If the 
replicate selection is 1, this option is not available. 
 

ELx808 Operator’s Manual  



48  | Chapter 3: Operation 

A V E R A G E  S T A N D A R D S ?  Y E S     

  Y E S        N O                    

• Press SOFT KEY 1 to select YES (average the replicates). The top line 
of the display updates to reflect the selection. 

• Press SOFT KEY 2 to select NO (do not average the replicates). The 
top line of the display updates to reflect the selection. 

• Press the ENTER key to save the selection, and advance to the next 
screen. 

Standard Concentration 

The Standard Concentration field allows you to enter the predicted or expected 
concentration value for each standard group. Any previously defined value is 
displayed.  

If Manual Map Generation is selected, the replicate locations must also be 
defined. 
 

C O N C N   O F       L O C A T I O N    

S T D 1 : 1 . 5 0      R E P #  1 : A 0  1 

• Use the NUMERIC and ALPHA keys and the DECIMAL POINT key to 
enter Standard Concentration values. The range is 0.00001 to 999999. 
The entry cannot exceed six characters including the decimal point. 
Valid well locations for the defined geometry are listed below. 

• Use the RIGHT ARROW and LEFT ARROW keys to move to the next 
or previous editable field. 

• Press the CLEAR key to clear the Standard Concentration value from 
the display. 

• Press the ENTER key to save the value on the display and move to the 
next screen. 
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Reuse of Standard Curves 

The ELx808 has the ability to reuse a standard curve that has already been 
established.  

Limitations of the Reuse of Standard Curves 

• The reuse of standard curves can only be done in assay positions 31 
through 55. Each of these positions can only store one standard curve. 

• Standard curves cannot be reused on panels (see page 67 for Panel 
Assays). 

• Standard curves will be stored in memory with the Assay Name, Standard 
Concentrations, Replicate Counts, and Optical Densities for each standard 
replicate. 

• Stored standard curves can only be reused for the assay that the curve was 
originally generated on (i.e., the curve for assay #53 cannot be applied to 
samples on a plate to be run in assay #51). 

• To reuse a standard curve, an assay must first be programmed (in positions 
31 through 55) and run. During the defining process, you will be prompted 
to enter the number of standards, the number of standard replicates, and 
the standard concentrations. The following screen has been added after 
these prompts: 

R E U S E  S T A N D A R D  C U R V E ? Y E S

 Y E S    N O                    

 
• After the assay has been run, the results have been calculated, and the 

reports have been generated, the reader will prompt if this standard curve 
should be stored in memory. The following display will appear: 

S A V E  S T A N D A R D  C U R V E ?   Y E S

 Y E S    N O                    

 
• Select YES to store the curve for use at a later time. The next time a plate is 

to be read using this assay, the instrument will prompt if there are 
standards on the plate. Select NO to discard the curve. 
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S T A N D A R D S  O N  P L A T E ?     N O  

Y E S   N O                       

 
• If YES is chosen, a new standard curve will be generated. The plate map is 

not changed. (If “Prompt for Sample ID” is enabled in the UTIL section, 
you will be prompted to enter the number of samples. See page 18 for more 
information on the UTIL options.) 

• If NO is chosen, the stored standard curve will be used. If Auto mapping 
had been used to originally map the standards, blanks, controls, and 
samples defined for this assay, the map will be automatically regenerated 
without the standards, beginning in well xxx (where xxx was chosen as the 
Starting well in the map, usually well A01). If Manual mapping was used to 
map the plate, the map is NOT regenerated - the reader will NOT produce 
results for the well positions that originally were standards. Auto mapping 
is recommended, if the standards curves will be routinely reused. 

Number of Controls 

E N T E R    N U M B E R  O F               

C O N T R O L S :                0 2 

• Use the NUMERIC keys to enter the Number of Controls. The range 
depends on the number of locations on the plate that are undefined. 
The maximum number of controls is 8. 

• Press CLEAR to clear the value on the display. 

• Press ENTER to save the value and advance to the next screen. 

 

Control Type 

C O N T R O L # 1 :          P C       

    P C       N C    H P C     * M O R E 

 
C O N T R O L # 1 :          P C       

 L P C      C T L 1    C T L 2  * M O R E 

 
C O N T R O L # 1 :          P C    

 C T L 3    C T L 4        * M O R E 
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• Press the soft keys under the displayed Control Type to select the 
option (Positive Control, Negative Control, High Positive Control, Low 
Positive Control, CTL1, CTL2, CTL3, CTL4). 

• Press CLEAR to clear the Control Type from the display. 

• Press ENTER to save the displayed Control Type and advance to the 
next screen. 

Number of Control Replicates 

E N T E R  N U M B E R  O F               

R E P L I C A T E S  O F  P C :         0 2 

• Use the NUMERIC keys to enter a value for Number of Control 
Replicates. The range is 1 to 12 replicates. The software performs a 
check to ensure the number of replicates does not exceed the number of 
undefined wells remaining on the plate. 

• Press CLEAR to clear the displayed Number of Replicates value. 

• Press ENTER to save the displayed value and advance to the next 
screen. 

Location of Controls 

The displayed location field can only be edited if manual map generation was 
selected.  
 

C O N T R O L # 1       L O C A T I O N   

T Y P E : P C          R E P # 1 : A 0 1 

• Press the CLEAR key to clear the value on the display. 

• Use the NUMERIC and ALPHA keys to enter values for well locations 
on the plate. 

Valid Well Locations 

For all prompts of a well location, only the ALPHA keys are active for the first 
character and NUMERIC for the second and third characters. 

• Press the MAIN MENU and PREVIOUS SCREEN keys to move back 
and advance through the menu structure. 
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Number of Samples 

E N T E R   N U M B E R  O F               

S A M P L E S :                 2 4 

• Use the NUMERIC keys to enter the number of samples in the assay. 
The range is 0 to the number of undefined well locations remaining on 
the plate. If there are no controls, blanks, or standards defined on a 96-
well plate, the maximum number of samples is 96, and the minimum 
number of samples is 1. 

• Press the Clear key to clear values on the display. 

• Press Enter to save the displayed value and advance to the next screen. 

 Note: If the number of samples is altered, the number of replicates for 
the sample reverts to a value of 1. 

Number of Sample Replicates 

E N T E R   N U M B E R  O F               

S A M P L E   R E P L I C A T E S :     0 2 

• Use the NUMERIC keys to enter the Number of Sample Replicates. The 
range is 1 to 12 replicates. The software ensures that the number of 
replicates multiplied by the number of samples, multiplied again by the 
number of dilutions, does not exceed the number of undefined wells 
remaining on the plate. 

• Press the Clear key to clear the value on the display. 

• Press the Enter key to save the displayed value and advance to the next 
screen. 

Sample Location 

If Manual Map Generation is selected, this screen allows you to select the 
well location of the sample on the plate. Any previously defined Sample 
Location appears on the display. 
 

S A M P L E  # 1       L O C A T I O N    

                 R E P #  1 : A 0 1 

• Use the NUMERIC, ALPHA, and DECIMAL POINT keys to enter the 
sample identifier and its location on the plate. 
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• Press the CLEAR key to clear the displayed value. 

• Press ENTER to save the value and advance to the next screen. 

FORMULA 

The ELx808 supports three types of formulas (Cutoff, Transformation, and Validation), 
as well as the ability to define variables for use within formulas. Up to three types of 
Validation formulas may be defined (Blank, Control, and Assay Validation). 

Formulas are processed in the following order, with the number of permitted formulas 
of each type: 

• Blank Validation 0-1 

• Control Validation 0-4 

• Assay Validation 0-4 

• Transformations 0-1 

• Cutoff Formulas 0-1 

• Curve Fit Analysis (if a curve fit method is defined) 

Within any given formula type, the order of processing is the order in which the 
formulas are entered. 

Validation Formula Examples 

• Blank Validation: An assay protocol states that every blank well on a 
plate should have an OD of less than 0.050. The formula is entered on the 
reader as a Blank Validation Formula: BLK < 0.050. 

• Negative Control Validation: An assay protocol states that every 
Negative Control well must have an OD of less than or equal to 0.100. The 
formula is entered as a Control Validation Formula: NC < =  0.100. 

• Positive Control Validation: An assay protocol states that every Positive 
Control well must have an OD higher than 1.000, but less than 2.500. Two 
Control Validation Formulas can be entered: PC > 1.000 AND PC < 2.500.  

Or, one formula can be used if the formula is 24 characters or less: PC > 
1.000 AND PC < 2.500. 

• Assay Validation:  An assay protocol states that in order for an assay to 
be valid, the mean of the Negative Control well ODs must be less than 
0.100. The Assay Validation formula that should be entered: NC;x < 0.100  
(the map identifier NC;x indicates the mean of the NCs). 

From the assay DEFINE Menu, press the arrow corresponding to FORMULA. 
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Formula Type 

The ELx808 supports three types of formulas, as well as the ability to program 
variables for use within Transformation formulas. 

• CUTOFF formulas are used to classify results. During data reduction, 
results are evaluated against the cutoff formulas, and each well is 
assigned a user-specified label or “call” (POS, NEG, or EQUIV). 

• TRANSformation formulas are applied to the raw data in preparation 
for further data reduction and/or curve-fit calculation. 

• VALidation formulas can be used to determine whether or not blanks 
and/or controls are valid. In addition, Assay Validation formulas can 
be used to determine whether or not the entire assay should be 
considered valid. 

• The TRANS-VAR option allows you to define a variable to be used in 
transformation formulas. 

 Note: GENERAL formulas are not used in the ELx808 open 
assays. 

 

S E L E C T  F O R M U L A  T Y P E :       

C U T O F F  T R A N S   V A L   * M O R E

 

S E L E C T  F O R M U L A  T Y P E :       

G E N E R A L  T R A N  S - V A  R   * M O R E

• Press SOFT KEY 1 to select CUTOFF Formula. 

• Press SOFT KEY 2 to select TRANSFORMATION Formula. 

• Press SOFT KEY 3 to select ASSAY VALIDATION Formula. 

• Press *MORE to access additional formula types. 

• Press SOFT KEY 3 to select TRANS-VAR. 

• Press ENTER to save the selected formula type and advance to the next 
screen. 
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Validation Type Selection 

If you selected VAL, this option allows you to choose which Validation 
Formula type (Control, Assay, or Blank Validation formulas) to enter for the 
assay. 
 

S E L E C T   V A L I D A T I O N  T Y P E :   

C O N T R O L      A S S A Y   B L A N K 

• Press SOFT KEY 1 to select Control Validation Formula. 

• Press SOFT KEY 3 to select Assay Validation Formula. 

• Press SOFT KEY 4 to select Blank Validation Formula. 

• Press ENTER to save the validation type and advance. 

Formula Entry 

 Note: In formulas, “OD” is used to represent the optical density 
value. 

 

F O R M U L A # 1 :                   

 M A T H  O T H E R   M A P   F U N C T N

• After a moment, the FORMULA #1: prompt disappears, and the 
formula can be entered. 

• Each formula can contain a maximum of 24 characters. Spaces are 
unnecessary. 

• Use the LEFT and RIGHT ARROW keys to move the cursor to the 
previous or next editable field.  

• Press SOFT KEY 1 to place the next item on the MATH list at the cursor 
position. The following table shows the order of items on the MATH list: 

 
+ Addition sign 

- Subtraction sign 

* Multiplication sign 

/ Division sign 

% Percent 

ELx808 Operator’s Manual  



56  | Chapter 3: Operation 

= Equal 

> Greater than 

>= Greater than or equal to 

< Less than 

<= Less than or Equal to 

 

 Note: The reader software checks the formulas for errors during data 
reduction. A syntax error in a formula will result in a “Token Error” on 
results reports. 

• Press SOFT KEY 2 to place the next item on the OTHER list at the 
cursor position. See the table that follows for the order of items on the 
OTHER list: 

( Left parenthesis 

) Right parenthesis 

AND Logical AND 

OR Logical OR 

• Press SOFT KEY 3 to place the next defined item on the plate map list 
(i.e., STD, NC, PC, BLK) at the cursor position.  

• Press SOFT KEY 4 to place the next option on the FUNCTION list at 
the cursor position. The available functions are: 

 

LOG10 Log Base 10 

ALOG1
0 

Anti Log Base 10 

AB Absolute Value  

PWR Power 

ALOG Anti Log 

LOG Log  

SQRT Square Root 
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EXAMPLES: 

LOG10: Log Base 10    ALOG: Anti Log  
Log10 2 = 0.301029995  ALOG (0.69314718) = 2 

ALOG10: Anti Log Base 10   LOG: Log 
ALOG10 (0.30102995) = 2  LOG 2 = 0.69314718 

AB: Absolute Value    SQRT: Square Root 
AB (-1) = 1    SQRT 2 = 1.4142 

PWR: Power 
(10 PWR 2) = 100 
 

• Well locations, well types, or numbers in parentheses precede functions. 

• Press the Clear key to clear the item displayed at the cursor position. 

• Press the Shift and Clear keys to clear the entire entry. 

• Press Enter to save the displayed value and advance to the next screen, 
or use the Previous Screen key to move backward through the menu 
structure. 

Number of Required Controls/Blanks 

If a control or blank validation formula is entered, this screen allows you to 
enter the number of valid controls / blanks for the assay. Any previously 
defined values will appear on the display. 
 

P C :  N U M B E R  O F  V A L I D           

R E P L I C A T E S  R E Q U I R E D ?     0 2 

• Use the Numeric keys to enter the Number of Required Controls. The 
range is 1 through the number of defined replicates of a control or 
blank. 

• Press the Clear key to clear the displayed value. 

• Press the Enter key to save the displayed value and advance to the next 
screen, or use the Previous Screen key to move backward through the 
menu structure. 
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Cutoff Formulas 

A cutoff formula calculates a cutoff value that is used for classifying samples.  

During data reduction, results are evaluated against the cutoff value (with an 
optional greyzone), and each well is assigned a call POS (positive), NEG 
(negative), or EQUIV (equivocal). 

• One cutoff formula may be defined per assay. 

• If Transformation Formulas are defined, cutoffs are based on the 
transformed results. Refer to “FORMULA” on page 53 for the order in 
which formulas are processed.  

• A cutoff formula can consist of a simple numeric value (1.500), a well 
identifier (PC or PC;x to represent the mean), or a formula combining 
the two (NC;x+0.050). 

• A “greyzone” around the cutoff value can be defined, to indicate 
equivocal or indeterminate results. 

• Do not use the < or > mathematical symbols in a cutoff formula. 

• Tip:  Choose to print a Column Report to see the greyzone and cutoff 
values as well as the equations used to assign calls to samples. 

After selecting an assay (page 32), define the Cutoff formula as shown below: 

D E F I N E :                      

M E T H O D   M A P  F O R M U L A  C U R V E 

                                       

S E L E C T   F O R M U L A  T Y P E :         

C U T O F F   T R A N S   V A L   * M O R E 

            

F O R M U L A # 1 :                    

 M A T H   O T H E R   M A P   F U N C T N 

After the FORMULA #1: prompt disappears, enter the formula as described in 
“Formula Entry” on page 55. Refer to the examples on page 60. 
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Greyzone Entry 

The greyzone is a definable area around the cutoff value. Samples falling 
within an area defined by the greyzone (ex. ± 5.0% of the cutoff value) could be 
considered equivocal (EQUIV). 
 

E N T E R   G R E Y Z O N E :         0 5 % 

                                   

• Use the NUMERIC keys to enter the greyzone percentage. 

• The valid entry range is from 00 to 99%. An entry of 00% indicates no 
greyzone, although a sample equal to the cutoff value will still receive 
the EQUIV call. 

• See POS / NEG Calls below for information on how calls are assigned. 

• Press the Clear key to clear the displayed value. 

• Press the Enter key to save the displayed value and advance. 

Positive/Negative Calls for Cutoff 

After the greyzone is defined, calls for the sample wells (POSitive, NEGative, 
EQUIVocal) must be defined. 
 

S A M P L E > C U T O F F + 0 5 % :      P O S 

 P O S     N E G                   

• Select POS or NEG to select the call that will be assigned to samples 
greater than the cutoff value plus the greyzone. 

• If, for example, POS is selected as shown in the above screen, calls will 
be assigned according to the following equations (SMP represents the 
sample wells): 

EQUIV: SMP <= (CUTOFF+(CUTOFF*GREYZONE)) AND 
   SMP >= (CUTOFF-(CUTOFF*GREYZONE)) 

POS: SMP >  (CUTOFF+(CUTOFF*GREYZONE)) 

NEG: SMP <  (CUTOFF-(CUTOFF*GREYZONE)) 

ELx808 Operator’s Manual  



60  | Chapter 3: Operation 

Examples 

1: The cutoff between negative and positive calls should be calculated as the 
average of the negative controls plus the OD value of 0.500. Samples greater than 
the cutoff should be labeled as positive. No greyzone is required. 

• For this example, NC;x (the mean of the NC wells) equals 1.000 OD 

• The cutoff formula is NC;x+0.5 

• The greyzone is 00% 

• POS is selected for SAMP>CUTOFF+00% 

• Calls are assigned to sample wells as follows: 

 EQUIV if the sample equals 1.500 

 POS if the sample is greater than 1.500 

 NEG if the sample is less than 1.500 

2: For a quantitative assay, samples with OD values greater than the STD2 mean 
plus a 10% greyzone should be labeled as positive; samples with OD values less 
than the STD2 mean minus the 10% greyzone should be labeled as negative. All 
other samples should be considered equivocal. 

• For this example, STD2;x (the mean of the STD2 wells) equals 2.000 OD 

• The cutoff formula is simply STD2;x 

• The greyzone is 10% 

• POS is selected for SAMP>CUTOFF+10% 

• Calls are assigned to sample wells as follows: 

 EQUIV if the sample is greater than or equal to 1.800 and  
less than or equal to 2.200 

 POS if the sample is greater than 2.200 

 NEG if the sample is less than 1.800 
 

 

BioTek Instruments, Inc. 



Defining Assays  |  61 

Transformation Formulas 

Transformation formulas change the absorbance data of all wells defined in the 
Map to another format, in preparation for further data reduction.  

Transformation Formula Definition 

• From the assay Define Menu, press the arrow corresponding to 
Formula. 

 

D E F I N E :                      

M E T H O D  M A P  F O R M U L A   C U R V E

                
• This will bring you to a screen asking to Select Formula Type. At this 

screen, select TRANS and then enter the formula using the Math, 
Other, Map and Function keys. 

     

S E L E C T  F O R M U L A  T Y P E :       

C U T O F F  T R A N S   V A L    * M O R E

      
 
Example:  Divide all ODs on the plate by 2 and multiply by 100. 
 
  Enter the formula:  (OD/2)*100 

 
This formula will be applied to the ODs of all samples, standards, 
controls, and blanks that are present on the plate map.  
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Transformation Scope Variable 

For more complex transformations, a Transformation Scope Variable 
(TVar) can be defined for use with a transformation formula. This variable 
defines the scope of the transformation: whether to apply the transformation to 
just the samples (SMP) or to all wells defined on the plate (OD). 

From the assay Define Menu, press the arrow corresponding to Formula. 
 

D E F I N E :                      

M E T H O D   M A P  F O R M U L A  C U R V E 

                   
This will bring you to a screen prompting you to Select Formula Type. Press 
*MORE at this screen. 

 

S E L E C T   F O R M U L A  T Y P E :        

C U T O F F   T R A N S  V A L    * M O R E 

                   
The options displayed now include TRANS-VAR. Press VAR at this screen. 

 

S E L E C T   F O R M U L A  T Y P E :        

G E N E R A L  T R A N S - V A R   * M O R E 

     
The following screen will appear, asking you to choose the scope of this 
transformation. 
 

S C O P E   V A R I A B L E :        O D 

  S M P       O D                    

If SMP is chosen, the transformation formula will be applied only to the 
samples defined in the plate map. If OD is chosen, the formula definition 
screen will appear. Use the formula keys (Math, Other, Map and Function) to 
define the transformation variable (TVar). Once the variable has been 
defined, it can be used in a transformation formula. The TVar will be available 
as a MAP option when writing the transformation formula. 
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Example: An assay plate map has 2 blanks, 1 control well in duplicate (CTL1), 
1 negative control well in triplicate (NC), and 5 standards in duplicate 
(STD1-STD5) with varying concentrations.  

The assay data reduction states:  

• Subtract the mean of CTL1 from the mean of the NC. Subtract the 
difference from all ODs on the plate.  

• Divide the result of the above by the means of the NC less the means of 
CTL1, and then multiply by 100. 

On paper, the formula reads:  

(OD-(NC;x-CTL1;x))/(NC;x-CTL1;x)*100 

• On the reader, define the formula (NC;x-CTL1;x) as the Transformation 
Variable, since the transformation will apply to all standards, controls 
and samples on the plate. 

• At the SCOPE VARIABLE screen, choose OD and press Enter. Now 
enter the formula (NC;x-CTL1;x) by using the MATH, OTHER, MAP 
and FUNCTION keys. Press the ENTER key. 

• The formula definition screen is displayed. Choose TRANS. 

• Enter the following formula: (OD-(TVar))/(TVar)*100 using the 
MATH, OTHER, MAP, and FUNCTION keys. (TVar is included in Map 
options on the formula entry screen.) The transformation formula has 
been added to the assay definition. 

Another Transformation Example: 

In the case of competitive reactions, converting absorbance data to percent 
B/B0 can be: (OD/Std1)*100. This divides all the wells by STD1 (presumably 
the 0 standard), and multiplies the results by 100. 

• At the SCOPE VARIABLE screen, choose OD and press Enter. 

• Select STD1 from MAP and Press Enter. 

• Choose TRANS. 

• Enter (OD/TVAR) * 100 
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CURVE 

The CURVE entry screens allow editing and entry of: 

• Curve-Fit Type 

• Editing of Outliers 

• Axis Identification 

• Extrapolation of Unknowns 

These screens are displayed on the ELx808 in the order in which they appear in the 
assay. If a closed variable (i.e., an element of the assay definition that you cannot 
access or modify) is being used in the assay, the entry screen is omitted. 

Curve Fit  

The Curve-Fit screen allows you to select the curve-fit method that will be 
applied to the assay. Any previously defined curve-fit type appears on the top 
line of the display, and available options on the second line.  

The Curve-Fit screen has three sub-menu screens. Each sub-menu screen 
provides different curve-fit options for selection. These options include C-
Spline, Linear, Quadratic, Cubic, 4-P, 2-P (Logit/Log), PT to PT (point to 
point), and None.  

• Linear curve fit: A simple best-fit straight line is plotted using the 
values of the standards. 

• Quadratic or “Quad” curve fit: A curve fit which uses the Quadratic 
equation “ax2 + bx + c = y” to plot the standard's values. Utilizing this 
curve, any data point for a standard that deviates from the ideal value 
will not affect the entire curve. 

• Cubic curve fit: A curve fit that uses the equation “ax3 + bx2 + cx + d = 
y” to plot the standard's values. This type of curve fit is affected even 
less than the quadratic fit when any particular standard has a poor 
value. 

• 2-P (LOGIT/LOG): A curve fitted to the standard values, which is 
characterized by a skewed sigmoidal (S-shaped) plot that eventually 
becomes asymptotic to the upper and lower standard values. The 
logistic equation is algebraically transformed to a simpler form in which 
experimentally determined values are used for the responses at 
concentrations of zero and infinity. 

• Cubic Spline (C-Spline) curve fit: A piecewise polynomial 
approximation consisting of joining a set of data points by a series of 
straight lines, which is then smoothed by using a cubic fit. 

BioTek Instruments, Inc. 



Defining Assays  |  65 

• 4-Parameter Logistic or “4-P”:  A curve fitted to the standard 
values, which is characterized by a skewed sigmoidal (S-shaped) plot 
that eventually becomes asymptotic to the upper and lower standard 
values. The 4 parameters are: Left asymptote, Right asymptote, Slope 
and Value at the Inflection point. This fit is most recommended for 
immunoassay data, and is more exact than Logit/Log. 

• Point to Point or “PT to PT”: A plot that connects each standard 
point with a line, with no averaging of the values to “smooth” the curve 
at each standard. 
 

C U R V E - F I T  T Y P E :  C - S P L I N E

 N O N E  L I N E A R  Q U A D    * M O R E

 

C U R V E - F I T  T Y P E :  C - S P L I N E

 C U B I C   4 - P    2 - P    * M O R E

 

C U R V E - F I T  T Y P E :  C - S P L I N E

  C - S P L I N E    P T - P T  * M O R E

• Press SOFT KEYS 1, 2, 3, or 4 to select the curve-fit type that is 
displayed above the soft key. Select the soft key below the menu option 
MORE to display additional options. The top line of the display updates 
to reflect this selection. 

• Press ENTER to save the selection and advance to the next screen, or 
use the MAIN MENU and PREVIOUS SCREEN keys to move 
backward through the menu structure. 

Edit Standard Outliers 

This screen allows you to select which method (None or Manual) will be used 
to edit Standard Outlier values. After the standard curve has been calculated, 
one or more standards can be excluded from the recalculation of the curve. 
Any previously defined edit method is displayed.  
 

E D I T   S T D  O U T L I E R S : M A N U A L 

 N O N E   M A N U A L                  

• Press SOFT KEY 1 or 2 to select the edit option displayed above the 
soft key. The display updates to reflect your selection. 

• Select NONE to suppress the Edit Standard Outliers capability for this 
assay. 
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• Choose MANUAL to enable the capability.  

 If AVERAGE STANDARDS is set to NO, the individual standard 
replicates are available for editing. If set to YES, the standard groups 
are available for editing. 

 After the assay is run and reports are generated, press REPORT 
from the Main Menu. Press RESULT, select the assay, and then 
press ENTER. The EDIT STD OUTLIERS? YES/NO prompt will 
appear. See Editing Standard Outliers on page 74 for further 
instructions. 

• Use the ENTER key to save the selection and advance to the next 
screen, or use the MAIN MENU and PREVIOUS SCREEN keys to move 
backward through the menu structure. 

Axis Selection 

This screen allows you to select the X and Y Axis Type. Any previously defined 
axis type will be displayed. This option screen appears only if Manual Map 
Generation has been selected. 
 

X / Y   A X I S  T Y P E :  L I N            

L I N     L I N / L O G  L O G  L O G / L I N 

• Press SOFT KEY 1, 2, 3, or 4 to select the method by which the X and 
Y-axes will be scaled. The top line of the display updates to reflect the 
selection. 

• This option is not available for the 2-P and 4-P curve-fit types. The X/Y 
scaling for these curves is always LIN/LIN. 

• Press ENTER to save the selection and advance to the next screen. 

Extrapolation of Unknowns 

This screen allows you to choose whether to extrapolate the curve to evaluate 
samples outside of the absorbance range defined by the standards. Any 
previously defined decision appears on the screen. 
 

E X T R A P O L A T E  U N K N O W N S ? Y E S 

 Y E S        N O                    

• Press SOFT KEY 1 to select YES (extrapolate the unknowns). The top 
line of the display updates to reflect this selection. 

• On the printed reports, extrapolated concentrations (RSLT values) are 
surrounded by < > (e.g., <44.425>). 
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• Press SOFT KEY 2 to select NO. The top line of the display updates to 
reflect this selection. 

 Note: If extrapolation is chosen for the Point-to-Point curve fit, unknown 
concentrations will be extrapolated linearly from the nearest segment of 
the curve. If the plot includes both increasing and decreasing segments, 
the curve printout will be labeled “Ambiguous.” The resulting values, 
which actually are extrapolated, may not be indicated as such. All 
calculated results for an “Ambiguous” curve should be considered 
unreliable. 

Panel Assays 

A Panel assay is a collection of up to 8 assays to be run on one plate. 

• A common reason to use a Panel assay is when one or more samples are 
tested for more than one antigen. An example is an ENA panel, which 
could screen dsDNA, Sm, SSA, SSB, Scl-70, and/or Jo-1 on one microplate. 

• Only one Panel assay can be defined on the reader at any time. 

• The assays specified within the Panel must be predefined in any of the 
assay positions 1-55. 

• The assays specified within the Panel must all use the Endpoint read 
method. 

• The assays specified within the Panel must all read at the same 
wavelength(s). 

• Any curve-fit type, formulas, or standard concentrations previously 
defined for each assay will be used when the assay is selected for a Panel.  

• Panel assays cannot reuse standard curves. 

• Only an Auto map is recognized by a Panel assay. Custom locations 
entered using a Manual map will be overwritten by the Panel assay. 

• If the Panel runs in a 1*12(ACROSS) configuration, both the Map Direction 
and Replication Direction must be set to ACROSS during assay definition. 
ACROSS would also then be selected as the direction during Panel 
definition. 

• The type and number of controls, blanks, standards, and replicates in the 
assays chosen for the Panel will be “copied” into the Panel definition. Map 
or assay parameters must first be changed in the predefined assay before 
they can change in the Panel. 

To create a panel assay, start at the Main Menu, select DEFINE, then choose assay 
number 99. Enter the panel assay name. 

N A M E :      P A N E L              
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 -       /      :     S P A C E 

• The default name is “PANEL”. 

• Use the alpha and numeric keys to update the assay name, if desired. 

• Press Enter to continue. The Number of Assays entry screen will appear. 

 

N U M B E R   O F  A S S A Y S :           2 

                        

 
• Specify the number of assays to include in the panel (1 to 8). 

• Press Enter to continue. The Mapping Direction selection screen will 
appear. 

 

M A P P I N G  D I R E C T I O N : D O W N     

D O W N   A C R O S S             

• This option ensures that all assays will be mapped in the same direction.  

• Select DOWN or ACROSS.  

After selecting the mapping direction of the assays, choose which assays to 
include in the panel. 

 

S E L E C T   A S S A Y  N U M B E R :      2 2 

N A M E :  H B S - A G 1            

• Press the Options key to cycle through the assay numbers and names, or 
use the numeric keys to enter an assay number. Press Enter to make a 
selection. 

• After an assay is selected, its starting location must be defined. 

S T A R T   M A P P I N G                 

A T   W E L L  L O C A T I O N :     A 0 1 

 
• Use the alpha and numeric keys to choose the well location to begin the 

assay.  

• Repeat this process for each assay within the panel. Remain aware of the 
total number of controls, standards, and blanks that were originally 
mapped in each individual assay while mapping for the Panel assay. 
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• For example, to include Assays 1, 8, and 22 in the Panel assay (DOWN 
mapping is selected for the Panel): 

 Assay 1 has a total of 12 wells defined for controls, blanks, and 
standards. In the Panel, the mapping for Assay 1 begins in well A01. The 
user wants to run 6 samples in Assay 1. Assay 1 now fills wells A01 
through B03. 

 The mapping for Assay 8 can begin in well B04, or any well other than 
A01 to B03. The reader will “beep” if you try to map into a well that is 
already assigned for use with the Panel.  

 The mapping for Assay 22 may begin at the next available well location 
after Assay 8 mapping is complete.  

 The Panel Assay results are sorted by Sample (unless a custom assay has 
been programmed by BioTek).  

 Note: The Interpretation of Results reports for each assay in 
the Panel will print first, and then the Sample results will print. 
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Reading a Microplate  

Press the READ option, found at the Main Menu, to read a microplate. 

• From the MAIN MENU screen, press the soft key beneath the READ menu 
option to access the SELECT ASSAY NUMBER screen. 

• Alternately, press the red READ key on the lower right of the keyboard. 

Select Assay 

At the Select Assay Number screens: 

• Use the NUMERIC keys to enter the number of any predefined Assay 
Definition Files stored in the reader’s memory, or the OPTION key to 
advance one assay at a time. The cursor is positioned at the first editable 
field and advances automatically. The numeric range depends on the 
number of assays (1-55) programmed in the reader’s memory. 

The assay’s name and number are displayed on the screen.  
 

S E L E C T  A S S A Y  N U M B E R :   2 5 

N A M E : H B S - A G              

• Press Enter to advance to the Run-Time prompts. 

• MAIN MENU: Returns the display to the Main Menu screen. 

Run-Time Prompts 

After the assay is selected, one or more informational prompts may be presented, 
depending on preferences selected in UTIL > READ, whether or not the assay 
specifies manual mapping, or if a custom assay database is installed on the reader. 

• Prompts enabled via UTIL > READ can include ENTER NUMBER OF 
SAMPLES, PLATE ID, and ENTER SAMPLE ID. 

• If the assay specifies manual mapping, prompts for information will 
include the locations for the sample wells. 

• If running a custom assay, typical prompts might include: 

Number of samples 
Standard concentrations 
Assay ID 
Fill pattern 
Blank method 
First well location 
Replicate count for each well type 
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Wavelength mode 
Report preferences 

Enter Number of Samples 

Use this screen to enter from 00 to the maximum number of samples permitted by 
the previously created well map. If there are no controls, standards, or blanks 
defined, the minimum number of samples is 1. 

This value controls the number of samples reported if Matrix or Column reports 
are requested. 
 

E N T E R   N U M B E R  O F           

S A M P L E S :               9 1 

Enter Plate ID 

You can enter a 10-character (maximum) identifier to assign to the plate. Since this 
Plate ID will be stored in the reader’s memory, each plate ID should be unique. 

 Note:  Use caution when creating multiple Plate IDs. The reader does 
not warn you that you are about to exceed the maximum of 10 plate 
IDs stored in memory. If an eleventh Plate ID is added, it will 
overwrite the first Plate ID stored in memory. 

 Note:  If the internal bar code scanner option is installed, the reader 
will automatically scan the plate/bar code label and use this as the 
Plate ID. 

 

P L A T E   I D :                 

  -          /    :        S P A C E 

• Use the KEYPAD to enter numbers, and the LEFT / RIGHT arrow keys to 
move the cursor. Clear clears the display. 

Enter Sample ID 

You can start entering a starting sample identification number from 0001 to 9999. 
The software will automatically increment each subsequent sample identification 
number by 1. Sample IDs will be assigned according to the previously defined 
mapping order. 
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E N T E R                      

S A M P L E   I D :  0 0 0 1          

• Use the KEYPAD to enter numbers and the LEFT / RIGHT arrow keys to 
move the cursor. Clear clears the display. 

Prompts for Well Location 

Well locations can be changed at run time if a Manual Map has been specified, and 
you have requested a sample count at run time via the Utilities menu. 
 

S A M P L E #  1      L O C A T I O N    

                  R E P #  1 : A 0 1 

• Use the KEYBOARD to enter the well location, using the SHIFT-LETTER 
sequence to key in letters, and press Enter to specify the desired location. 

Beginning the Plate Read 

When the following screen appears on the display, the reader is ready to read a 
plate: 
 

P L A C E   P L A T E  I N  C A R R I E R    

A N D   P R E S S  < R E A D >  K E Y     

• Place the plate in the carrier and press the READ key to initiate the plate 
read. After the plate has been read, all requested reports will be generated. 

• To halt in read in progress, press the STOP key. 

 Note: If using the incubation option, the reader will wait for the 
incubator to reach temperature before reading the plate. 
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Printing Reports and Assay Lists 

L Important! The 'OUT' indication on reports means the OD 
for an individual well, or the average OD for a group of 
wells, falls outside the minimum/maximum OD range 
defined for the assay. For the Quick Read assay on the 
ELx808, this range is -3.0 OD to +3.0 OD. For assays defined 
onboard by a user (Assay02-Assay55), it is -4.0 OD to +4.0 
OD. 

 

Reports are automatically generated after a plate has been read (see OUTPUT Options 
on page 19 and REPORT Type on page 19 in Chapter 2 for information on selecting 
reports). To manually regenerate results reports, use the REPORT option from the 
Main Menu. You can also print Map, Assay, and Assay List reports. 

 See Appendix A for sample reports. 

 

R E A D Y    9 : 4 5 P M   0 5 / 0 9 / 0 7 

R E A D   D E F I N E  R E P O R T  U T I L 

 

P R I N T   R E P O R T :              

R E S U L T   M A P  A S S A Y  L I S T    

 

• The eight most recent sets of plate data are stored in memory (see next page). 
Select REPORT > RESULT to print an exact copy of results from the plate 
reading.  

 The form in which the results are presented is determined by the report 
settings (Matrix, Column, Curve Fit) specified under UTIL > OUTPUT.  

• Select MAP to print a matrix showing the locations of the Blanks, Standards, 
Controls, and Samples for a selected assay. 

• Select ASSAY to print a plate map and a listing of all of the assay’s settings, 
such as wavelengths, numbers of well types, formulas, and curve-fit 
parameters. 

• Select LIST to print a list of all assays (name and number) currently 
programmed in the ELx808. 
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 Note: The reader stores measurement values for the last 8 plates in 
memory. 

Result 
 

R E P O R T : H B S - A G              

I D :   0 0 1           0 7 /  1 7 / 0 7 

• Use the OPTION key to select the appropriate Plate ID and Report. Note 
that the Assay ID will change if the selected Plate ID was read with a 
different assay. Once you have found the correct Plate ID, press Enter. 

Editing Standard Outliers 

If a standard curve was generated and if EDIT STANDARD OUTLIERS was set to 
MANUAL in the assay definition, the option to edit outliers is presented. 
 

E D I T   S T D  O U T L I E R S :         

 Y E S    N O                 

• Select NO to include all standards in the curve-fit calculations. 

• Select YES to indicate that one or more standard replicates or groups 
should be temporarily excluded from curve fit-calculations. 

 If AVERAGE STANDARDS was set to NO in the assay definition, one or 
more standard replicates can be chosen for exclusion. 
 

E D I T   S T D  1   R E P 1 ?  Y E S        

 Y E S    N O                 

• Select YES to exclude the replicate from curve-fit calculations. 

• Select NO to retain the replicate. 

• Press ENTER to advance to the next replicate. 

 If AVERAGE STANDARDS was set to YES in the assay definition, one 
or more standard groups can be chosen for exclusion. 
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E D I T   S T D  1 ;  X ?  Y E S           

 Y E S    N O                 

• Select YES to exclude the group from curve-fit calculations. 

• Select NO to retain the group. 

• Press ENTER to advance to the next group. 

 Note: Each curve-fit type requires a minimum number of standards for 
curve generation:  4 for 2-P, 4-P, cubic, and cubic-spline, 3 for 
quadratic, and 2 for linear and point-to-point. Exercise caution when 
editing outliers. If the assay is left with insufficient standards, the 
curve fit will fail. 

Printing Results 

After the assay is selected and standard outliers are edited (if necessary), the 
results report can be printed. 
 

P R I N T   R E S U L T S ?             

 Y E S    N O                 

• Ensure that the printer is connected, turned on, and filled with paper. 

• Press YES to print reports, or NO to return to the Main Menu. 

Map 

• Select REPORT at the Main Menu, and then select MAP. 
 

S E L E C T   A S S A Y  N U M B E R : 0 1    

N A M E :  H B S - A G             

 

• Press Options to cycle through the list of available assays, or enter the 
number of the desired assay. 

• Press Enter to print the report. 
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Assay 

• Select REPORT at the Main Menu, and then select ASSAY. 
 

S E L E C T   A S S A Y  N U M B E R : 0 1    

N A M E :  H B S - A G             

 

• Press Options to cycle through the list of available assays, or enter the 
number of the desired assay. 

• Press Enter to print the report. 

List 

• Select REPORT at the Main Menu, and then select LIST. The entire list of 
assays stored in the ELx808’s memory will be sent to the printer. 
 

Recommendations for Optimum Performance 

• Microplates should be perfectly clean and free of dust or bottom scratches. Use 
new microplates from sealed packages.  

• Do not allow dust to settle on the surface of the solution; use microplate covers 
when not reading the plate. Filter solutions to remove particulates that could cause 
erroneous readings. 

• Although the ELx808 supports standard flat, U-bottom, and V bottom 96-well 
microplates, the reader achieves optimum performance with optically clear, flat-
bottomed wells. 

• Non-uniformity in the optical density of the well bottoms can cause loss of 
accuracy, especially with U- and V-bottom polyvinyl microplates. Check for this 
by reading an empty microplate. Dual wavelength readings can eliminate this 
problem, or bring the variation in density readings within acceptable limits for 
most measurements. 

• Inaccuracy in pipetting has a large effect on measurements, especially if smaller 
volumes of liquid are used. For best results, use at least 100 µL per well. 

• The inclination of the meniscus can cause loss of accuracy in some solutions, 
especially with small volumes. Agitate the microplate before reading to help bring 
this problem within acceptable limits. Use Tween 20, if possible (or some other 
wetting agent) to normalize the meniscus. Some solutions develop menisci over a 
period of several minutes. This effect varies with the brand of microplate and the 
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solution composition. As the center of the meniscus drops and shortens the light 
path, the density readings change. The meniscus shape will stabilize over time. 

• Although the effect of ambient light is mathematically quantified and subtracted 
from each absorbance reading, the illumination of the instrument by strong 
ambient light should be avoided. If interference from ambient light is suspected, 
read a microplate of high-density solutions under the suspect conditions, and 
again with all ambient light blocked (in a dark room for example), then compare 
results. The blocked results will appear as an increase in optical density readings if 
light is influencing the readings. Because of the mathematical correction, this 
difference under normal conditions should be slight or nonexistent. 

• A 10-minute warm-up of the instrument is suggested, prior to reading, to achieve 
the best repeatability from microplate-to-microplate measurements. 
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Instrument Qualification 

This chapter discusses the tasks and procedures necessary for 
qualifying instrument performance initially and on an ongoing basis.  
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Overview 

This chapter contains BioTek Instruments’ recommended Installation Qualification (IQ), 
Operational Qualification (OQ), and Performance Qualification (PQ) procedures for all 
models of the ELx808 Absorbance Microplate Reader. 

Every ELx808 reader is fully tested at BioTek prior to shipment and should operate 
properly upon initial setup. If you suspect that a problem occurred during shipment, if 
you have received the equipment after returning it to the factory for service, and/or if 
regulatory requirements dictate that you qualify the equipment on a routine basis, you 
should perform the procedures outlined in this chapter. 

 An ELx808 Product Qualification Package (PN 7340543) is available for 
purchase. It contains procedures for performing IQ/OQ/PQ and 
Preventive Maintenance, with spreadsheets for analyzing results and 
checklists and logbooks. Contact your BioTek dealer for more information. 

Recommended Qualification Schedule 

The schedule below defines the factory-recommended intervals for qualifying an ELx808 
reader used two to five days a week. The actual frequency, however, may be adjusted 
depending on your usage of the instrument. This schedule assumes the reader is properly 
maintained as outlined in the Preventive Maintenance chapter. 

 The risk factors associated with your tests may require that the 
Operational and Performance Qualification procedures be performed  
more or less frequently than shown here. 

Tests 

Installation 
Qualification 

Operational 
Qualification 

Performance  
Qualification 

Initially 
Initially/ 
Annually 

Monthly Quarterly 

System Self-Test, p. 89     

Checksum Test, p. 89     

Absorbance Plate Test, p. 89     

Empty Carrier Test, p. 91      

Liquid Tests, p. 92 

Liquid Test 1*, or 
Liquid Test 2* 

Liquid Test 3**, (optional,  
for 340 nm) 
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* If you have an Absorbance Test Plate, run Liquid Test 1. If you do not have a Test Plate,  
run Liquid Test 2. 

**  Liquid Test 3 is optional; it is provided for sites requiring verification at wavelengths  
lower than those attainable with the Absorbance Test Plate. 

 

Test Descriptions 

System Test 

The System Test runs automatically whenever the instrument is turned on. It can also 
be performed manually using Gen5 software, or the keypad (UTIL > TESTS > 
SYSTEM). If the power-up System Test fails, the reader will “beep” repeatedly and 
display an error code; see Chapter 6.  

When run manually, a System Test report is printed (or displayed in Gen5). The report 
(sample shown on the next page) includes results for the System Optics Test and 
Autocal Analysis. We recommend saving System Test reports to document periodic 
testing and assist with troubleshooting. 

• The System Test conducts a series of tests at each wavelength defined in the 
filter table to confirm adequate light levels, low electronic noise, adequate 
photodiode sensitivity, overall system cleanliness, and (if equipped) proper 
function of the incubator. The testing is designed to verify that the ELx808 will 
give in-specification performance for each set wavelength over the specified 
OD range.  

• Autocal is run only at the factory (or by an authorized service engineer) to 
calibrate the carrier axis of the instrument. The results of this test are included 
in the System Test Report. In the field, the alignment of the Absorbance Plate 
Test is used to verify that the carrier positioning is correct. 

Terms used on the System Test Report 
Air Blank A full light reading through a filter with no plate in the light path. 

Dark Current A reading taken with the light blocked to measure background 
light levels in the reading chamber. Also used as a measure of 
background electronic noise within the measurement circuit. 

Gain An automatic electronic adjustment to the measurement circuit. 
The gain adjustment compensates for changing light levels or 
filter variations. For example, if the lamp output decreases 
slightly, the gain will increase to make up the difference. 

Axis Refers to a motor for the filter wheel or plate carrier. 
Offset A numerical limit, usually a range. For example, if the gain fails 

an offset test, it may be too high or too low.  
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                           Gen5 System Test Report 
 

Reader:                       ELx808  (Serial Number: 118943) 
Basecode:                     P/N 7340201  (v3.15) 
Date and Time:                7/28/2012 3:06:11 PM 
User:                         Administrator 
Company:                      BioTek 
Comments:                     System Test run during the IQ 

 
Test Results 

 
Operator ID:______________________________________________________________ 

 
Notes:____________________________________________________________________ 

 
 

03:11PM    7/28/12     SYSTEM SELF TEST   
 

Filter: 405  Gain: 15.06 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        24272  36673  54326  49036  37302  41392  37956  46880  42789 
Dark:        1627   1790   1738   1983   1922   1969   2155   1978   2041 
Delta:      22645  34883  52588  47053  35380  39423  35801  44902  40748 

 
Filter: 450  Gain:  5.12 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        26520  40514  54985  51166  41113  45699  43595  50055  47401 
Dark:         587    644    626    708    688    705    767    707    729 
Delta:      25933  39870  54359  50458  40425  44994  42828  49348  46672 

 
Filter: 490  Gain: 16.00 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        29585  40785  53183  50389  42324  46927  45225  51112  48181 
Dark:        1806   1981   1927   2187   2121   2172   2369   2182   2247 
Delta:      27779  38804  51256  48202  40203  44755  42856  48930  45934 

 
Filter: 620  Gain:  8.26 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        28973  40210  53315  49573  42596  47522  46312  50677  49083 
Dark:         922   1012    983   1116   1084   1111   1211   1114   1150 
Delta:      28051  39198  52332  48457  41512  46411  45101  49563  47933 

 
Filter: 630  Gain:  5.57 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        28127  42576  54097  52142  44139  48634  47638  52007  50305 
Dark:         630    691    672    762    739    758    826    760    784 
Delta:      27497  41885  53425  51380  43400  47876  46812  51247  49521 

 
Filter: 340  Gain: 64.00 
Channel:      Ref      1      2      3      4      5      6      7      8 
Air:        18961  28041  46573  41370  27548  30291  25144  36515  31946 
Dark:        7163   7855   7642   8677   8411   8630   9413   8655   8927 
Delta:      11798  20186  38931  32693  19137  21661  15731  27860  23019 

Channel:      Ref      1      2      3      4      5      6      7      8 
Noise Max:   3952   4351   4225   4817   4668   4790   5237   4807   4963 
Noise Min:   3951   4346   4220   4814   4664   4785   5233   4802   4957 
Delta:          1      5      5      3      4      5      4      5      6 
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03:11PM    7/28/12     INCUBATOR SELF TEST 
 
Temperature Setpoint: 37.0     Current Average: 36.9      A/D Test: PASS   
 
Zone 1: 37.0   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   
Zone 2: 37.0   Min: 37.0   Max: 37.1     Range: PASS    Thermistor: PASS   
Zone 3: 37.0   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   
Zone 4: 36.9   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   
 
 
 
 
AUTOCAL ANALYSIS   
 
 
Upper Left Corner:  x=5344  y=0       
Lower Left Corner:  x=6156  y=0       
Lower Right Corner: x=14850  y=0       
Upper Right Corner: x=14032  y=0       
Delta 1 : 5344-6156=-812   
Delta 2 : 14032-14850=-818   
 
 
SYSTEM TEST PASS         
0000 
  
 
 
 

 
 
Reviewed/Approved By: ________________________________  Date: ________________ 
 
 
For Technical Support 
 
In the U.S.:                      In Europe: 
  BioTek Instruments, Inc.          BioTek Instruments GmbH 
  Tel: 800 242 4685                 Tel: 49 (0) 7136-9680 
  Fax: 802 655 3399                 Fax: 49 (0) 7136-968-111 
 
All Others: 
  Tel: 802 655 4040 
  Fax: 802 655 3399 
 
email: TAC@biotek.com 
Product support center: www.biotek.com/service 

 

The INCUBATOR SELF TEST shows the 
PASS or FAIL condition of the four heating 
zones in the incubator (if equipped). See 
Incubator Self-Test on the next page. 

AUTOCAL ANALYSIS provides coordinates of 
the last Autocal performed on the instrument. 
AUTOCAL verification is not included in the 
SYSTEM TEST result given below. 

The SYSTEM TEST result will be either PASS or 
FAIL. The SYSTEM TEST result refers only to the 
System Optics Test results. 

Figure 5: Sample System Test Report (it varies slightly depending on how it was run)   

 If a System Test shows one or more channels that have air readings 
falling below 30,000 for filter wavelengths of 405 nm or higher, Liquid 
Test 1 should be performed. This test is applicable to the eight reading 
channels only, not the reference channel. 
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Incubator Self Test 

The Incubator Self Test of the ELx808 reader is designed to check for hardware 
failures (such as open or shorted thermistors, A/D noise) and to verify that each of 
the four zones in the incubation system are within ± 2° of the setpoint. 

• Temperature Setpoint: The desired temperature programmed by the 
user, either through the reader’s keypad or Gen5.  

• Current Average: Average temperature of the four zones of the incubator 
at the time the system test is run. This number is displayed on the ELx808 
front panel and sent to Gen5 if the reader is being computer controlled. 

• A/D Test: Checks for allowable noise levels. 

 
 03:11PM    7/28/12     INCUBATOR SELF TEST 

 
Temperature Setpoint: 37.0     Current Average: 36.9      A/D Test: PASS   
 
Zone 1: 37.0   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   
Zone 2: 37.0   Min: 37.0   Max: 37.1     Range: PASS    Thermistor: PASS   
Zone 3: 37.0   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   
Zone 4: 36.9   Min: 36.9   Max: 37.0     Range: PASS    Thermistor: PASS   

 
 
 
 
 

Zone #: Reports the average temperature of the zone at the time the test is 
run. Each zone is evaluated independently. 

Min: The minimum temperature recorded during the time that the system test 
is run.      

Max: Maximum temperature recorded during the time that the system test is 
run. There is no range checking between Min and Max temperatures.  

Range: This test checks that each zone is within ± 2° of the setpoint. 

Thermistor: This test indicates whether the thermistors are functioning or 
have failed. 

Checksum Test 

The Checksum Test compares the basecode software to internally recorded checksum 
values to ensure that the programming has not been corrupted. The test runs 
automatically when the instrument is turned on, and it can be run manually using the 
keypad (UTIL > TESTS > CHKSUM). If the test fails, the reader will “beep” 
repeatedly and display an error code; see Chapter 6. 

When run manually, the software displays the part numbers and versions of software 
currently loaded on the reader. For example: 

Software P/N   Software Version 
7340201           Version 3.21 
Code Checksum:          (5E35) 
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The second screen shows: 

Configuration P/N  Configuration Version 
7340203          Version 3.00  

Absorbance Plate Test 

This test uses BioTek’s Absorbance Test Plate to confirm the Mechanical Alignment, 
Accuracy and Linearity, Repeatability, and Channel-to-Channel uniformity of the 
ELx808. The Absorbance Plate Test compares the reader’s optical density 
measurements and mechanical alignment to NIST-traceable values. To run the test, 
you will need a BioTek Absorbance Test Plate with its accompanying data sheet.  

 The BioTek PN 7260522 Test Plate has a glass filter in location C6, which 
is used to check the wavelength accuracy of a monochromator. Although 
the ELx808 does not have a monochromator, you must enter values for 
the peak wavelength when defining the 7-filter test plate in Gen5 
software. Refer to the software help system for more information. 

A sample Absorbance Plate Test report is shown on the next page. 

 

 

 

 

ELx808 Operator’s Manual  



86  | Chapter 4: Instrument Qualification 

 

Figure 6: Sample Absorbance Plate Test Report 

 The report varies slightly depending on how it was run (via the keypad or 
Gen5). 
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 Important! The Absorbance Plate Test tests the accuracy and 
repeatability specifications from 0.000 to 2.500 OD only. In the example 
above, the Analysis report displays the OD values read in well positions D4 
and E9 but does not indicate PASS or FAIL, because the values are higher 
than 2.500 OD and therefore are not within the test range. 

If any of the test parameters report as FAIL, confirm that the standard values on the 
test plate data sheet match the values on the printout. If there are any mismatches, 
correct them and re-run the test. See also the troubleshooting tips below. If the test 
continues to fail, contact BioTek TAC. Please have a copy of the test and the reader’s 
serial number ready. 

• Mechanical Alignment: The Test Plate has several groups of precisely 
machined holes to confirm the mechanical alignment of different 
microplate readers. The amount of light that shines through these holes is 
an indication of how well the reader is aligned. A reading of more than 
0.015 OD for any of the designated alignment holes indicates that the light 
is being “clipped” and the reader may be out of alignment. If the test fails: 

 Examine the microplate carrier to ensure that it is clear of debris. 

 Make sure the Test Plate is properly seated in the microplate carrier. 

 Check the Test Plate’s alignment holes to ensure they are clear of 
debris. 

• Accuracy/Linearity: The Test Plate contains neutral-density glass filters 
of known OD values at several wavelengths. Actual measurements are 
compared against the expected values provided in the Test Plate’s data 
sheet. Since there are several filters with differing OD values, the accuracy 
across a range of ODs can be established. Once it is proven that the reader 
is accurate at these OD values, the reader is also considered to be linear. If 
the test fails: 

 Check the filters on the test plate to ensure they are clean. If 
necessary, clean them with lens paper. Do not remove the filters from 
the test plate, and do not use alcohol or other cleaning agents. 

 Ensure that the filter calibration values entered are the same as those 
on the Test Plate data sheet. 

 Ensure that the Test Plate is within its calibration certification period. 

• Repeatability: This test ensures the reader meets its repeatability 
specification by reading each neutral-density filter on the Test Plate twice 
with the filter in the same location. Note that there may not be a Pass/Fail 
indication for filter values that are beyond the specified accuracy (and thus 
repeatability) range of the instrument. If the test fails: 

 Examine the glass filters on the test plate to see if there are any loose 
particles that may have shifted between readings and caused changes. 
If needed, clean the filters with lens paper. 
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 Do not remove the filters from the test plate, and do not 
use alcohol or other cleaning agents to clean them. 

 Check the microplate carrier to ensure that it is clear of debris. 

• Channel-to-Channel Variation: This test ensures that selected channels 
read the same value for a filter as their paired channel when the plate is 
“turned around” 180° in the plate carrier. It is a way to verify that each 
channel’s Delta values are adjusted relative to the signal strength of the 
reference channel. 

Empty Carrier Test 

The Empty Carrier Test confirms the ELx808’s read capabilities at the 100% light level, 
and can help to identify deteriorating interference wavelength filters and other optical 
problems. 

Liquid Tests 

Conducting Liquid Tests confirms the ELx808’s ability to perform to specification with 
liquid samples. Liquid testing differs from testing with the Absorbance Test Plate in 
that liquid in the wells has a meniscus, while the Test Plate’s neutral density filters do 
not. The optics characteristics may differ in these two cases, alerting you to different 
types of problems. The Absorbance Test Plate will indicate the absolute amount of light 
absorbed, which will effectively test the linearity of the electronics. The liquid tests will 
help detect optical defects such as dirt on the lenses or other contamination that can 
contribute to errant readings. 

• Liquid Test 1 tests the alignment, accuracy, repeatability, and channel-to-
channel variability of the reader, making evident any problems with the 
optics of the system. If you have the Absorbance Test Plate, you will only 
need to run Liquid Test 1 for routine testing. 

• If you do not have the Absorbance Test Plate, test the linearity, 
repeatability, and alignment of the reader by preparing a series of solutions 
of varying absorbances as described in Liquid Test 2. 

• Liquid Test 3 is an optional test at 340 nm, offered for sites that must have 
proof of linearity at wavelengths lower than those attainable with the 
Absorbance Test Plate. This test is considered optional because the reader 
has good “front end” linearity throughout its wavelength range. 

 

BioTek Instruments, Inc. 



Perform the Tests  |  89 

Perform the Tests 

System Test 

 If the System Test fails, see Chapter 6 for troubleshooting tips and 
error code descriptions. 

Using Gen5, select the following in the appropriate software: 

• Open the system menu and select Diagnostics > Run System Test 

Using the instrument keypad: 

1. Attach a printer to the instrument.  

2. From the Main Menu, select UTIL > TESTS > SYSTEM. 

Checksum Test 

There is no Checksum Test in Gen5. To obtain reader software information: 

• Open the system menu and select Reader Control > ELx808. To obtain 
Gen5 software information, select Help > About Gen5.  

Using the instrument keypad: 

• From the main menu, select UTIL > TESTS > CHKSUM.  

 The initial checksum test display will show the onboard (base code) 
software part number, version number, and checksum.  

 After a few moments, a second screen will show the assay configuration 
software part number and version number. 

Absorbance Plate Test 

Define the Test Plate Parameters 

Using Gen5 (click Help for additional instructions): 

• Open the system menu and select Diagnostics > Test Plates > 
Add/Modify Plates, and click Add.  

Using the keypad: 

1. From the main menu select UTIL > SETUP > *MORE > CALPLATE. The 
Calibration Filter screen will appear. 

2. Select a filter wavelength and press Enter. The Wavelength / Calibration 
Value screen will appear.    
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3. Enter the values listed on the Test Plate data sheet. After each entry, press 
Enter to advance to the next well location.  

4. Repeat for the remaining filters. 

5. When all values have been entered, press the Main Menu key. 

Run the Plate Test 

 Before running the test, ensure that the reader is not running in Rapid 
Mode. To check this, select UTIL > READ and then cycle through the 
prompts until READ IN RAPID MODE? is displayed. Choose NO for 
an accurate result. 

Using Gen5 (click Help for additional instructions): 

• Open the system menu and select Diagnostics > Test Plates > Run.   

Using the keypad: 

1. Select Start at the Main Menu and select UTIL > TESTS > CALPLATE. The 
Calibration Filter screen will appear. 

2. Select the appropriate wavelength and press Enter. 

3. When prompted, insert the Test Plate into the plate carrier, and press the 
READ key to begin the test. The Test Plate Analysis Report (sample on page 
86) will be sent to a printer when the test is complete. 

 

L Gen5 version 1.07 and earlier users: Gen5’s Reader 
Diagnostics Utility (PN 5320201) must be installed before the 
Absorbance Plate Test can be performed using Gen5. 

L Important! The Absorbance Plate Test and CALPLATE 
utility in the reader are used only to verify the reader’s 
performance. The Test Plate and utility do not correct or 
calibrate the instrument. 

L The Absorbance Plate Test tests the accuracy and repeatability 
of the reader to 2.500 OD. It does not indicate a PASS or FAIL 
above 2.500 OD.  
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Empty Carrier Test 

Perform these steps (do not place a microplate on the carrier): 

1. For each filter in the filter wheel, run a simple endpoint protocol and then 
print the results. (Do not apply blanking or transformations.) 

2. Examine the OD values on the printouts. Every OD should read 0.000  
± 0.004 OD. 

 These limits are required by BioTek and cannot be changed. 

3. Sign and date the printouts, and store them with your test documentation. 

 
If the Empty Carrier test fails at more than one wavelength: 

• Check the microplate carrier to ensure that it is clear of debris. 

• Verify that the lamp is properly aligned, and then run the test again. If the 
lamp has been in use for approximately 600 hours, it may need to be 
replaced, and the contacts in the lamp socket may need to be cleaned. Refer 
to Replace the Lamp and Clean the Contacts in Chapter 5. 

• Follow the steps in Inspect and Clean the Wavelength Filters in 
Chapter 5 to remove the filter wheel and clean the filters. 

 
If the Empty Carrier test fails at just one wavelength: 

• Remove the filter wheel and examine the filter that exhibited the problem; 
it may need to be replaced (contact BioTek). Check for spotting or a halo 
effect. 

ELx808 Operator’s Manual  



92  | Chapter 4: Instrument Qualification 

Liquid Tests 

Prepare Test Solutions 

BioTek offers a dye solution (PN 7120779, 25 mL; or 7120782, 125 mL) that may be 
used in the stock solution formulation for Liquid Tests 1 and 2, or, if you prefer, 
you may use the dye solution described below. The purpose of the formulation is 
to create a solution that absorbs light at ~2.000 OD full strength when dispensed at 
200 µL/well in a flat-bottom microplate. 

Alternatively, any solution that gives a stable color will suffice. (This includes 
substrates incubated with an enzyme preparation and then stopped with an acidic 
or basic solution.)  Some enzyme/substrate combinations that may be used as 
alternates to the described dye are shown below: 

Typical Enzyme-Substrate Combinations and Stopping Solutions 

Enzyme Substrate Stopping Solution 

Alkaline Phosphate
   

o-nitrophenyl phosphate 3N sodium hydroxide 

beta-Galactosidase
   

o-nitrophenyl -beta-D 
galactopyranoside 

1M sodium carbonate 

Peroxidase 
  

2,2'-Azino di-ethylbenzothiazoline-
sulfonic acid (ABTS) 

citrate-phosphate buffer, 
pH 2.8 

Peroxidase 
  

o-phenylenediamine 0.03N sulfuric acid 

 

Stock Solution Formulation 

The stock solution for Liquid Tests 1 and 2 may be formulated using the materials 
listed below (Solution A), or by diluting a dye solution available from BioTek 
(Solution B). 

 Either solution should result in an absorbance of about 2.000 when 
using 200 µL in a flat-bottom microwell at 405 nm. The OD value will be 
proportional to the volume in the well and the amount of FD&C No. 5 
dye or QC Check Solution used. You can use a larger or smaller well 
volume, or add more dye or water to adjust the solution. Note that too 
small a well volume may result in increased pipetting-related errors. 

Solution A  

Required Materials: 

• BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; or 7120782, 125 mL) 

• Deionized water 
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• 5-mL Class A volumetric pipette 

• 100-mL volumetric flask 

Prepare Stock Solution: 

1. Pipette a 5-mL aliquot of BioTek QC Check Solution No. 1 into a  
100-mL volumetric flask.  

2. Add 95 mL of DI water; cap and shake well.  

Solution B 

Required Materials: 

• Deionized (DI) water 

• FD&C Yellow No. 5 dye powder (typically 90% pure) 

• Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting 
agent, PN 7773002 (a 10% Tween solution) 

• Precision balance with a capacity of 100 g minimum and readability of  
0.001 g 

• Weigh boat 

• 1-liter volumetric flask 

 
Prepare Stock Solution: 

1. Weigh out 0.092 gram of FD&C No. 5 yellow dye powder into a weigh boat. 

2. Rinse the contents into a 1-liter volumetric flask. 

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent. 

4. Make up to 1 liter with DI water, cap, and shake well. 

 

L 96-well, flat-bottom microplates are required for the liquid tests 
(Corning Costar #3590 is recommended). Use new microplates; 
any fingerprints or scratches may cause variations in readings. 

Before running the tests, ensure that the reader is not running in 
Rapid Mode. To check this, select UTIL > READ and then cycle 
through the prompts until READ IN RAPID MODE? is 
displayed. Choose NO for an accurate result. 

ELx808 Operator’s Manual  



94  | Chapter 4: Instrument Qualification 

Perform Liquid Test 1  

1. Using freshly prepared stock solution A or B (the concentrated solution), 
prepare a 1:2 dilution using DI water (one part stock, one part DI water; the 
resulting solution is a 1:2 dilution).  

2. Pipette 200 µL of the concentrated solution into Column 1 of the plate. 

3. Pipette 200 µL of the diluted solution into Column 2 of the plate. 

 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the plate 
for four minutes. This will allow any air bubbles in the solution to 
settle and the meniscus to stabilize. If a plate shaker is not 
available, wait 20 minutes after pipetting the diluted test solution 
before reading the plate. 

4. Read the microplate five times at 405 nm using the Normal Read Mode, 
single wavelength, no blanking (“Normal” plate position). 

5. Without delay, rotate the microplate 180° so that well A1 is now in the H12 
position. Read the plate five more times (“Turnaround” plate position). 

6. Print the ten sets of raw data, or export the data to an Excel spreadsheet 
using Gen5. The mathematical computations described below may then be 
performed and the template kept for future tests. 
 

Calculations: 

7. Calculate the mean OD value for each well location in columns 1 and 2 for 
the five plates read in the Normal position, and then again for the five 
plates read in the Turnaround position. This will result in 32 mean values. 

8. Perform a mathematical comparison of the mean values for each microwell 
in its Normal and Turnaround positions (that is, compare A1 to H12, B1 to 
G12, H1 to A12, and so on). To pass this test, the differences in the 
compared mean values must be within the accuracy specification for the 
instrument. For example: 
If the mean value for well A1 in the Normal position is 1.902, where the 
specified accuracy is ± 1.0% ± 0.010 OD, then the expected range for the 
mean of the same well in its Turnaround (H12) position is 1.873 to 1.931 
OD. 1.902 * 0.010 + 0.010 = 0.029; 1.902 – 0.029 = 1.873; 1.902 + 0.029 = 
1.931 
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 If any set of mean values is out of the expected range, review the 
other three sets of mean values for the same channel pair. For 
example, if the A1/H12 comparison fails (the wells are not within 
the expected range of each other), review the comparisons of 
A2/H11, H1/A12, and H2/A11. If two or more sets of mean values 
for a channel pair are out of the expected range, there is a 
problem with one of the eight read channels. If only one of the 
four mean values results in a failure, check the well for debris and 
the plate for scratches or fingerprints. 

 
Accuracy Specification: 

For comparison in this test, the following accuracy specification is applied, 
using Normal reading mode and a 96-well microplate. 

± 1.0% ± 0.010 OD from 0.000 OD to 2.500 OD at 405 nm 

 

Perform Liquid Test 2 

 The recommended method of testing the instrument performance is to 
use the Absorbance Test Plate to confirm alignment, repeatability, and 
accuracy, which will also confirm linearity. If a Test Plate is not 
available, Liquid Test 2 can be used for these tests. 

Required Materials: 

• A new 96-well, flat-bottom microplate (Corning Costar #3590 is 
recommended) 

• Ten test tubes, numbered consecutively, stored in a rack 

• Calibrated hand pipette (Class A volumetric pipette recommended) 

• Stock solution A or B (these are the same solutions as for Liquid Test 1) 

• A 0.05% solution of deionized water and Tween 20 

Prepare Dilutions: 

Create a percentage of dilution series, beginning with 100% of the original 
concentrated stock solution (A or B) in the first tube, 90% of the original 
solution in the second tube, 80% in the third tube, all the way to 10% in the 
tenth tube. Dilute using the 0.05% solution of deionized water and Tween® 
20. This solution can also be made by diluting the BioTek wetting agent 200:1. 
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                  Test Tube Dilutions 

Tube Number 1 2 3 4 5 6 7 8 9 10 

Volume of Concentrated 
Solution (mL) 

20 18 16 14 12 10 8 6 4 2 

Volume of 0.05% Tween 
Solution (mL)  

0 2 4 6 8 10 12 14 16 18 

Absorbance expected  
if concentrated solution 
is 2.0 at 200 µL 

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2 

 

 The choice of dilutions and the absorbance of the original solution can 
be varied. Use this table as a model for calculating the expected 
absorbances of a series of dilutions, given a different absorbance of 
the original solution. 

Prepare the plate: 

1. Pipette 200 µL of the concentrated solution from tube 1 into each well of the 
first column, A1 to H1, of the microplate.  

2. Pipette 200 µL from each of the remaining tubes into the wells of the 
corresponding column of the microplate (tube 2 into wells A2 to H2, etc.). 

 The choice of dilutions and the absorbance of the original solution 
can be varied. Use the table on the previous page as a model for 
calculating the expected absorbances of a series of dilutions, given 
a different absorbance of the original solution. 

 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the plate 
for four minutes. This will allow any air bubbles in the solution to 
settle and the meniscus to stabilize. If a plate shaker is not 
available, wait 20 minutes after pipetting the diluted test solution 
before reading the plate. 

Perform the Linearity Test (Test A) 

1. Read the prepared microplate five times using Normal mode, dual 
wavelength at 450 nm with 630 nm as the blank.  

 Do not discard the plate; you will use it again for Test C. 

2. Print the ten sets of raw data or export them to an Excel spreadsheet using 
Gen5. The mathematical computations described below may then be 
performed and the template kept for future data reduction. 
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Calculations: 

1. Calculate the mean absorbance for each well, and then average the means 
for each concentration. 

2. Perform a regression analysis on the data to determine if there is adequate 
linearity. Since it is somewhat difficult to achieve high pipetting accuracy 
when conducting linear dilutions, an R Square value of at least 0.99 is 
considered adequate. 

Calculate Repeatability (Test B) 

1. Calculate the mean and standard deviation for the five readings taken 
above at each concentration. Only one data set needs to be analyzed. The 
well that shows the most variation for any concentration is selected for data 
reduction. 

2. For each mean below 2.500 OD, calculate the allowed deviation using the 
repeatability specification for a 96-well plate of ± 0.5% ± 0.005 OD  from 
0.000 OD to 2.500 OD at 405 nm. 

3. The standard deviation for each set of readings should be less than the 
allowed deviation. For example: 

Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will result in a 
mean of 1.951, and a standard deviation of 0.0026. The mean (1.951) 
multiplied by 0.5% (1.951 * 0.005) = 0.0098, which, when added to the 0.005 
(0.0098 + 0.005) = 0.0148 OD, which is the allowable deviation. Since the 
standard deviation is less than this value, the reader meets the test criteria. 

Repeatability Specification: 

± 0.5% ± 0.005 OD from 0.000 OD to 2.500 OD at 405 nm  

Channel-to-Channel Variation and Alignment (Test C) 

1. Using the plate prepared for Test A on the previous page, conduct a 
Turnaround test by reading the plate with the A1 well in the H12 position 
five times. This test results in two comparisons of each channel to its 
corresponding channel. 

2. Calculate the means of the wells in column 1 in the Normal plate position 
(data is from Test A) and in the turnaround position (from Step 1 above). 
Compare the mean reading for well A1 to its mean reading when in the 
H12 position. 

3. Next, compare the mean reading for well A1 to its mean reading when in 
the H12 position. Next, compare the mean values for the other wells to 
their corresponding mean values with the well in the turnaround position. 
(Compare B1 to G12, C1 to F12, D1 to E12, E1 to D12, F1 to C12, G1 to B12, 
H1 to A12). The difference in the values for any two corresponding wells 
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should be within the accuracy specification for the instrument. For 
example: 

If the mean of well A1 in the normal position is 1.902, where the specified 
accuracy is ± 1.0% ± 0.010 OD, then the expected range for the mean of the 
same well in the H12 position is 1.873 to 1.931 OD. (1.902 * 1.0% = 0.019 + 
0.010 = 0.029, which is added and subtracted from 1.902 for the range.) 

If any set of well values is out of the expected range, review the other set 
for the same channel pair. Thus, if A1 and H12 are not within range of each 
other, review the compliance of H1 to A12, A2 to H11, and H2 to A11. This 
will confirm that there is a problem in one of the eight read channels, or 
indicate that the result of one set of wells was in error. If any two sets of 
well values for a channel pair are out of the allowed accuracy range, there 
may be contamination on one of the lenses. 

If the four corner wells are within the repeatability range, the reader is also 
in alignment. 

Perform Liquid Test 3 (“UV” Models Only)  

 Liquid Test 3 is an optional test offered for sites that must have proof 
of linearity at wavelengths lower than those attainable with the 
Absorbance Test Plate. This test verifies operation of the ELx808 at 
340 nm and is optional because the reader has good “front-end” 
linearity throughout its wavelength range. 

Required Materials: 

• 340 nm filter installed in the reader 

• New 96-well, flat-bottom microplates (Corning Costar #3590 is 
recommended) 

• Calibrated hand pipette(s) 

• Beakers and graduated cylinder 

• Precision balance with readability to 0.01 g 

• Buffer solution as described below 

Buffer Solution  

• Deionized water 

• Phosphate-buffered saline (PBS), pH 7.2-7.6, Sigma tablets #P4417 (or 
equivalent) 

• β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced 
Form) Sigma bulk catalog number N 8129, or preweighed 10-mg vials, 
Sigma number N6785-10VL (or BioTek PN 98233). Store the powder 
according to the guidelines on its packaging. 
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1. Prepare a PBS solution using the Sigma tablets. 

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH 
powder and mix thoroughly. This is the 100% Test Solution. 

Perform the Test 

1. Check the absorbance of a sample of the 100% test solution at 340 nm on 
the microplate reader. This solution will have an optical density 
(absorbance) of approximately 0.700 to 1.000. This value is not critical, but it 
should be within this absorbance range. If low, adjust up by adding  
β -NADH powder until the high-level solution is at least at the lower end of 
this range. Do not adjust if slightly high. 

2. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test 
Solution with 5 mL of the PBS solution. 

3. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test 
Solution with 10 mL of the PBS solution. 

4. Pipette the three solutions into the new 96-well microplate:  

 150 µL of the 100% Test  Solution into all wells of columns 1 and 2 

 150 µL of the 75% Test Solution into all wells of columns 3 and 4 

 150 µL of the 50% Test Solution into all wells of columns 5 and 6   

 After pipetting the diluted test solution into the microplate and 
before reading the plate, we strongly recommend shaking the plate 
for four minutes. This will allow any air bubbles in the solution to 
settle and the meniscus to stabilize. If a plate shaker is not 
available, wait 20 minutes after pipetting the diluted test solution 
before reading the plate. 

5. Read the microplate five times using Normal mode, single wavelength at 
340 nm, no blanking (or blank on air).   

6. Print the five sets of data, or export the data to an Excel spreadsheet using 
Gen5. The mathematical computations described below may then be 
performed and the template kept for future data reduction. 

Calculate Repeatability 

1. For each well, calculate the mean and standard deviation of the five 
readings. Only one data set needs to be analyzed for each concentration. 
The well that shows the most variation for each concentration is selected 
for data reduction. 

2. For each mean calculated in Step 1, calculate the allowed deviation using 
the repeatability specification for a 96-well plate of ± 1.0% ± 0.005 OD from 
0.000 to 2.000 OD at 340 nm. 
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3. For each well, compare the standard deviation calculation in Step 1 with 
the allowed deviation calculation in Step 2. The standard deviation should 
be less than the allowed deviation. For example:  

Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 will result in 
a mean of 0.8004, and a standard deviation of 0.0018.  

To calculate the allowed deviation for well A1, multiply the mean by 1.0% 
and add 0.005 (0.8004 * 0.010 + 0.005) to get 0.013. Since the standard 
deviation for well A1 is less than 0.013, the well meets the test criteria. 

Repeatability Specification: 

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD at 340 nm 

Calculate Linearity 

1. For each of the three Test Solutions, calculate the mean absorbance for the 
wells containing that solution (mean of wells A1 to H2, A3 to H4, and A5 to 
H6).   

2. Perform a regression analysis on the data to determine if there is adequate 
linearity. Since it is somewhat difficult to achieve high pipetting accuracy 
when conducting linear dilutions, an R Square value of at least 0.99 is 
considered adequate. 



Chapter 5 

Preventive Maintenance 

This chapter provides step-by-step instructions for maintaining the 
ELx808 in top condition, to ensure that the reader continues to 
perform to specification.  
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Recommended Maintenance Schedule 

A general Preventive Maintenance (PM) regimen for all ELx808 models includes 
periodically cleaning all exposed surfaces,  inspecting/cleaning the wavelength filters, 
replacing the lamp, and decontamination. Robotic models should have certain components 
lubricated. The table below recommends Preventive Maintenance tasks and the frequency 
with which each task should be performed. 

 The risk factors associated with your tests may require that some or 
all of the procedures be performed more or less frequently than shown 
below. 

Task 

Frequency 

Every 
three 

months 

Every six 
months 

As needed 
Before 

storage or 
shipment 

Clean Exposed Surfaces, p. 103       

Inspect/Clean Wavelength 
Filters, p. 104   

  
  

(Optional) Lubricate Robotic 
Components, p. 105   

    

Replace Lamp and Clean 
Contacts, p. 107    

  
after ~500 

hours 
 

Decontamination, p. 111      

 

Warnings and Precautions 

Please read the following before performing any maintenance procedures. 

 
Warning! Internal Voltage. Turn off and unplug the 
instrument for all maintenance and repair operations. 

 
Warning! Wear prophylactic gloves when handling 
contaminated instruments.  Gloved hands should be 
considered contaminated at all times; keep gloved hands 
away from eyes, mouth, nose, and ears.  Eating and drinking 
while decontaminating instruments is not advised. 

BioTek Instruments, Inc. 



Clean Exposed Surfaces  |  103 

 
Warning! Mucous membranes are considered prime entry 
routes for infectious agents. Wear eye protection and a 
surgical mask when there is a possibility of aerosol 
contamination. Intact skin is generally considered an 
effective barrier against infectious organisms; however, small 
abrasions and cuts may not always be visible. Wear 
protective gloves when handling contaminated instruments. 

L Important! Do not immerse the instrument, spray it with 
liquid, or use a “wet” cloth. Do not allow water or other 
cleaning solution to run into the interior of the instrument. If 
this happens, contact BioTek’s Technical Assistance Center. 

L Important! Do not soak the keypad – this will cause 
damage. Moisten a clean cloth with deionized or distilled 
water and wipe the keypad. Dry immediately with a clean, 
dry cloth. 

 

 

Clean Exposed Surfaces  

L Important! Turn off and unplug the ELx808 for the 
cleaning procedure. 

 

Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not 
soaked) with water or water and a mild detergent. You will need: 

• Mild detergent 

• Deionized or distilled water 

• Clean cotton cloths 

To clean the exposed surfaces: 

1. Turn off and unplug the instrument. 

2. Moisten a clean cotton cloth with water, or with water and the mild detergent. 
Do not soak the cloth! 

3. Wipe the plate carrier, the inside of the plate carrier door, and all exposed 
surfaces of the instrument. 
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4. If detergent was used, wipe all surfaces with a cloth moistened with water. 

5. Use a clean, dry cloth to dry all wet surfaces. 

 

Inspect and Clean the Wavelength Filters 

L Important! To properly store interference filters for the 
ELx808 during extended periods of non-use, package the 
filters in a light-tight envelope or container, away from 
high humidity and direct sunlight. This will ensure the 
longest life for the filters. When handling the filters, keep 
the surfaces clean from fingerprints and debris by simply 
wiping with a lens tissue or other lint-free cloth. 

 

Laboratory air is used to cool the lamp, and the wavelength filters can become dusty as a 
result. The filters should be inspected and cleaned at least every three months. You will 
need: 

• Tape 

• Screwdriver 

• Isopropyl, ethyl, or methyl alcohol 

• Lens-cleaning tissue 

To inspect and clean the wavelength filters: 

1. If you have not already done so, turn off and unplug the reader. 

2. Temporarily tape the reader’s plate access door shut. 

3. Using your fingertips, locate the seven perimeter screws around the sides and 
front where the reader’s top shroud meets the base. Remove the screws using a 
screwdriver.  

 Tip: Bring the reader to the edge of the work surface to access the 
screws without having to turn the reader upside down. 

4. Carefully raise the front of the shroud and tip it toward the back of the 
instrument. 

5. The filter wheel is located in the left-rear quadrant inside the reader. Remove 
the filter wheel by pulling it off its magnetic hub. 

6. Inspect the glass filters for speckled surfaces or a halo effect. This may indicate 
deterioration due to moisture exposure over a long period of time. If you have 
any concerns about the quality of the filters, contact your BioTek 
representative. 
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7. Clean the filters using lens-cleaning tissue moistened with a small amount of 
isopropyl, ethyl, or methyl alcohol. Ensure that the filters remain in their 
current locations. 

8. Replace the filter wheel on its magnetic hub. Ensure that the peg on the wheel 
lines up with the notch on the hub, and that the filter wheel is positioned flat 
against the hub and rotates freely. 

9. Close the top shroud and replace the seven perimeter screws. 

 Store filters in a dry environment, such as a desiccator, if they will not 
be used for an extended period. 

 If the reader continues to fail tests in Chapter 4, Instrument 
Qualification, after you have cleaned the filters and the lamp 
contacts, or if one or more filters appear to have deteriorated, contact 
your BioTek Representative or BioTek. 

 

(Optional) Lubricate Robotic Components 

This section applies to ELx808 robotic models only. You will need lubricant, BioTek  
PN 66039. 

1. Remove the top shroud of the instrument (see instructions in Chapter 2). 

2. Lubricate the components as shown in Figure 8a and Figure 8b every six 
months, or after 10,000 cycles, according to the instructions in the table below. 

 

Component 
Location 

 
Procedure 

A Lubricate the underside of the bracket. 

B Lightly lubricate the shaft indicated. 

C Apply a heavy coating of lubricant to both sides of the motor 
shaft. Run the motor shaft back and forth through the motor to 
ensure that the internal drive nut is heavily lubricated. Use the 
robotic motor adjustment procedure described on the next 
page to work the lubricant into the internal drive nut. 

D Lightly lubricate the surface of the roller. 

E Lightly lubricate the underside of the hook-in bracket. 

 
3. Reattach the top shroud. 
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Figure 8a:  Location of bracket, motor shaft, and main PCB/motor assembly 

 

 

Figure 8b: Roller surface and hook-in bracket 
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Robotic Motor Adjustment Procedure 

After lubrication/reassembly, the robotic door needs to be set to the open and closed 
positions. Press the following keys to adjust the door. 

At the Main Menu:  

1. Press the UTIL soft key. 

2. Press the SETUP soft key. 

3. Press the hidden key between the Main Menu and Previous Screen keys. 
You should see the Door Adjustment screen. 

4. Press the CLOSE soft key. 

5. Press the UP soft key until you just see the door move up. You may have to 
press the key many times before the door moves. When the door does 
move, press the DOWN soft key 4 times. This positions the door lift ram 
just behind the door roller in the closed position. 

6. Press the OPEN soft key. 

7. Press the UP soft key to raise the door to the desired height. Press the 
DOWN soft key if you want to adjust the door downward. 

 

L Important! Do not open the door to its 
maximum open position. 

 
8. Press the Main Menu key.  

9. Press the CLOSE soft key. This will close the door. The door should rest 
closed on the top cover. 

 

Replace the Lamp and Clean the Contacts 

 There are two types of lamp assemblies. Steps 7 and 8 only pertain to 
the newer assembly. Review the photos below to determine which 
instructions apply to your reader.  

The reader’s lamp, on average, should provide 500 hours of total service before it needs to 
be replaced. This equates to approximately six months to one year of use under routine 
conditions. The intensity of the lamp will slowly drop over time until the reader’s run-time 
self-check detects a low signal and warns the user with a displayed error code. The bulb 
should be replaced at this time (PN 3400508), and the electrical contacts in the lamp socket 
cleaned. 
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Warning! Hot surface. The lamp is hot when the instrument 
is turned on. Turn off and unplug the reader. Allow the lamp 
to cool down before attempting to replace it. 

L 
Important! Oxide coating on the electrical contacts can 
reduce lamp output. Clean the contacts in the socket 
whenever the lamp is replaced (approximately every 500 
hours). 

 

You will need: 

• Tape 

• Screwdriver 

• Cotton swabs or pencil eraser 

• Isopropyl alcohol 

• Lamp, BioTek PN 3400508 
 

To replace the lamp: 

1. Turn off and unplug the reader. Allow the lamp to cool for at least ten minutes. 

2. Temporarily tape the reader’s plate access door shut. 

3. Using your fingertips, locate the seven securing (perimeter) screws around the 
sides and front where the reader’s top shroud meets the base. Remove the 
screws using a screwdriver.  

 Tip: Bring the reader to the edge of the work surface to access the 
screws without having to turn the reader upside down. 

4. Carefully raise the front of the shroud and tip it toward the back of the 
instrument. 

5. The lamp is located in the left rear quadrant inside the reader. Unplug the 
lamp connector from the circuit board. 

L Important! Do not touch the glass lens in the lamp 
bracket. 

 
6. The lamp bracket is attached to the side of the instrument with two screws, 

which are accessed from the outer left side of the instrument. Using a  
screwdriver, loosen (do not remove) these two screws. Slide the bracket out of 
the instrument. 
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7. (Lamp Assembly 1 Only) Carefully unscrew the two thumbscrews on the 
lamp clamp that holds the bulb in the bracket. Remove the screws, springs, 
washers, and lamp clamp and set them aside. 

8. (Lamp Assembly 1 Only) Slide the rubber O-ring down the bulb socket away 
from the bulb.  

9. Remove the bulb from its socket by pushing the socket and the bulb together 
and rotating the socket counterclockwise. 

10. Clean the two contacts in the socket, using a cotton swab moistened with 
isopropyl alcohol, and allow them to dry for a few minutes. An alternative 
cleaning technique would be to rub the contacts with a pencil eraser. 

To install the lamp, reverse steps 1 through 9. Keep your fingers out of the reflector 
interior and away from the bulb. Ensure that the bulb is set flat against its housing 
before reinstallation in the instrument.  

 

O-ring 

springs 

lamp clamp 

thumbscrews 

washers 

Figure 9: New lamp hardware for the ELx808 (Lamp Assembly 1) 
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Figure 10: New lamp hardware for the ELx808, assembled (Lamp Assembly 1) 

 

Figure 11: Location of the lamp in the ELx808 (Lamp Assembly 2) 
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Decontamination 

Purpose 

Any laboratory instrument that has been used for research or clinical analysis is 
considered a biohazard and requires decontamination prior to handling.  

Decontamination minimizes the risk to all who come in contact with the instrument 
during shipping, handling, and servicing. Decontamination is required by the U.S. 
Department of Transportation regulations. 

Persons performing the decontamination process must be familiar with the basic setup 
and operation of the instrument. 
 

L Important! BioTek Instruments, Inc. recommends the use of 
the following decontamination solutions and methods based on 
our knowledge of the instrument and recommendations of the 
Centers for Disease Control and Prevention (CDC). Neither 
BioTek nor the CDC assumes any liability for the adequacy of 
these solutions and methods. Each laboratory must ensure that 
decontamination procedures are adequate for the Biohazard(s) 
they handle. 

 Warning! Internal Voltage. Turn off and unplug the 
instrument for the decontamination procedure. 

 
Warning! Wear prophylactic gloves when handling 
contaminated instruments.  Gloved hands should be 
considered contaminated at all times; keep gloved hands away 
from eyes, mouth, nose, and ears.  Eating or drinking while 
decontaminating instruments is not advised. 

 
Warning! Mucous membranes are considered prime entry 
routes for infectious agents. Wear eye protection and a surgical 
mask when there is a possibility of aerosol contamination. 
Intact skin is generally considered an effective barrier against 
infectious organisms; however, small abrasions and cuts may 
not always be visible. Wear protective gloves when performing 
the Decontamination procedure. 
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Tools and Supplies 

• Sodium hypochlorite (NaClO, or bleach) 

• 70% isopropyl alcohol (alternative to bleach) 

• Deionized or distilled water 

• Safety glasses 

• Surgical mask 

• Protective gloves 

• Lab coat 

• Biohazard trash bags 

• 125-mL beakers 

• Clean cotton cloths 

Decontamination Procedure   

 
Warning! The bleach solution is caustic; wear gloves and 
eye protection when handling the solution. 

Do not immerse the instrument, spray it with liquid, or use 
a “wet” cloth. Do not allow the cleaning solution to run into 
the interior of the instrument. If this happens, contact the 
BioTek Service Department. 

Do not soak the keypad – this will cause damage. 

L Important! Turn off and unplug the instrument for all 
decontamination and cleaning operations. 

 
1. Turn off and unplug the instrument. 

2. Prepare an aqueous solution of 0.5% sodium hypochlorite (bleach). As an 
alternative, 70% isopropyl alcohol may be used if the effects of bleach are a 
concern. 

• Be sure to check the percent NaClO of the bleach you are using; this 
information is printed on the side of the bottle.  Commercial bleach is 
typically 10% NaClO; if this is the case, prepare a 1:20 dilution.  Household 
bleach is typically 5% NaClO; if this is the case, prepare a 1:10 dilution.   
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3. Moisten a clean, lint-free cloth with the bleach solution or alcohol. Do not 
soak the cloth! Wipe down the carrier and all exposed instrument surfaces 
with the bleach solution. 

• Wipe the keypad (do not soak). Wipe again with a clean cloth moistened 
with deionized or distilled water. Dry immediately with a clean, dry cloth. 

• Wipe the plate carrier, the inside of the carrier door, and all exposed 
surfaces of the instrument. 

4. Wait 20 minutes. Moisten a cloth with deionized or distilled water and wipe all 
surfaces of the instrument that have been cleaned with the bleach solution or 
alcohol. 

5. Use a clean, dry lint-free cloth to dry all wet surfaces. 

6. Reassemble the instrument as necessary. 

7. Discard the used gloves and cloths, using a Biohazard trash bag and an 
approved Biohazard container. 
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Chapter 6 

Troubleshooting and Error 
Codes 

This chapter provides a list of Error Codes that may appear on the 
ELx808 or in Gen5, and their probable causes. 

Overview ....................................................................... 116 
Diagnostics ................................................................ 116 
Terms Used in the Error Codes Tables ........................... 116 
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Error Codes (Fatal) ......................................................... 121 
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Overview 

An error code that appears on the display of the ELx808 (during instrument control of the 
reader), or in Gen5 software (during PC control of the reader) is displayed as a four-digit 
identifier. The first digit will be 0, 1, 2, or A.  

• 0, 1, or 2 denote a noncritical or “General” error, which means that it is still 
possible for the ELx808 to communicate with the controlling software and run 
the reader system test.  See Error Codes (General) beginning on page 117. 

• A denotes a more serious error with the memory or processing, which requires 
that the ELx808 be turned off and then powered up before any diagnostics can 
be performed. If the error reappears, call BioTek TAC for troubleshooting 
assistance (see Chapter 1). See Error Codes (Fatal) on page 121. 

Diagnostics 

If an error code is displayed, a System Self-Test should be conducted for diagnostic 
purposes. Refer to the following brief instructions for performing the Self-Test: 

• From the Main Menu screen on the ELx808 display, select UTIL > TESTS 
> SYSTEM.  

• In Gen5, access the System menu and select Diagnostics > Run System 
Test.  

Terms Used in the Error Codes Tables 

• Air Blank: A full light reading through a filter with no plate in the light path. 

• Dark Current: A reading taken with the light blocked to measure background 
light levels in the reading chamber. Also used as a measure of background 
electronic noise within the measurement circuit. 

• Gain: An automatic electronic adjustment to the measurement circuit. The 
gain adjustment compensates for changing light levels or filter variations. For 
example, if the lamp output decreases slightly, the gain will increase to make 
up the difference. 

• Axis: Refers to a motor that positions the filter wheel or plate carrier. 

• Offset: A numerical limit, usually a range. For example, if the gain fails an 
offset test, it may be too high or too low. 
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Error Codes (General) 

Code Probable Cause 

0200 

0201 

Plate carrier did not find the home sensor. 

Filter wheel motor did not find the home sensor; filter wheel not 
installed or detached from hub. 

Errors 0200 and 0201 indicate that a motor was not able to move to its 
“home” position as registered by feedback from an optical sensor. 

Probable causes: 

• Carrier movement may be limited so that the optical sensor cannot be 
interrupted. Check the carrier path for obstructions. 

• Filter wheel not installed. The wheel is shipped in a separate envelope 
and may not be installed or may have broken free of the magnetic 
hub.  

• Filter wheel movement may be impeded. Remove the wheel to confirm 
if a loose filter is impeding the movement of the wheel.   

0300 

0301 

 

 

Carrier failed to find light beam. 

Filter wheel did not find home. 

Errors 0300 and 0301 indicate that a particular axis has moved to a point 
where the light beam from the optics is no longer detectable by the 
measurement electronics. This error is usually only seen during the service 
Auto Cal sequence. 

Probable causes: 

• Carrier: Lamp may be out or blocked by a faulty filter wheel. A loose 
belt or a loose motor pulley may cause the carrier to ignore movement 
instructions.  

• Filter Wheel Motor: The filter wheel is missing or loose or a loose filter 
may be impeding filter wheel movement.  

0400 

0401 

 

 

Carrier x-axis failed position verify. 

Filter Wheel motor failed position verify. 

Errors 0400 and 0401 indicate that an axis failed its Position Verify test. After 
moving a predefined number of steps from a home position, the motor should 
return to the home position in the proper amount of time and steps. If the 
axis moves back to its home position in the wrong amount of time or in too 
few or too many steps, the test fails.  

Probable causes: 

• Mechanical obstruction. 

• Carrier belt or pulley slipping. 

• Loose filter wheel hub. 

• Loose filter may be impeding filter wheel movement. 

• Defective motor drive circuit or 12-volt power problem. 
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Code Probable Cause 

0500 

0502 to 
0506 

 

Filter is not installed. 

0500 indicates an empty filter location on the filter wheel, or that the filter 
wheel is not installed. 

Probable causes: 

• All filter locations must have either a filter or a filter blank (BTI 
PN 3122037) installed. The reader may also display this error if the 
filter wheel is not installed. 

0601 to 
0606 

Filters 1 through 6 Gain out of range. 

Errors 0601 through 0606 indicate that the gain for a specific filter is out of 
range. Gain out of range indicates that the lamp is out, or that a particular 
filter absorbs or transmits entirely incorrect light levels. 

Probable causes: 

• Lamp out. Check that the lamp is lit when the unit is ON. Replace lamp 
if necessary. 

• A missing, defective, or misplaced filter or filter blank will cause this 
error. Observe that the filters in the wheel match the filters 
programmed in the software. Look for obvious physical defects in the 
filters. 

0700 

 

 

 

 

Reader failed noise test. 

Error 0700 indicates significant variations in background electronic noise were 
detected when blocking the light and increasing the Gain to maximum. 

Probable causes: 

• Electrical noise penetrating the measurement chamber. The bottom 
and top shrouds are part of the electrical shielding. Check that the 
shrouds are installed and properly fastened.  

• Ambient light leak. Check that the plate chamber door is closed to 
keep out ambient light.  

• Missing or loose filter allowing unintended lamp light into the 
measurement chamber. Check filter wheel for empty positions.  

• Internal electronic noise caused by a faulty Analog PCB or faulty 
internal grounding.  

0800 Reader failed offset test. 

Error 0800 indicates electronic signal detected is outside of acceptable limits 
at maximum gain when blocking the light. 

Probable causes: 

• Electrical noise penetrating the measurement chamber. The bottom 
and top shrouds are part of the electrical shielding. Check that the 
shrouds are installed and properly fastened. 

• Ambient light leak. Check that the plate chamber door is closed to 
keep out ambient light. 

• Missing or loose filter allowing unintended lamp light into the 
measurement chamber. Check filter wheel for empty positions. 

• Internal electronic noise caused by a faulty Analog PCB or faulty 
internal grounding. 
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Code Probable Cause 

0900 

 

 

Read time dark value out of range. 

Error 0900 indicates that the dark current value taken during the current read 
is significantly different than the same reading during the power-up self-
check. 

Probable cause: 

• Read chamber door has opened or closed relative to when the unit was 
powered ON. Close door and reboot reader to correct. 

• Electrical noise penetrating the measurement chamber. The bottom 
and top shrouds are part of the electrical shielding. Check that the 
shrouds are installed and properly fastened. 

• Internal electronic noise caused by a faulty Analog PCB or faulty 
internal grounding.    

0A00, 
0A01 

to 0A05 

 
 

Read time air blank out of range. 

Error 0A00 indicates that the blank (full signal) reading taken during the 
current read has changed significantly from the same reading taken during 
the power-up self-check. 

Probable cause: 

• Lamp has failed since power-up. Check that the lamp is lit and replace 
if necessary. 

• Analog PCB failure. 

0C00 Printer time out error. 

Error 0C00 indicates that the time allotted for the instrument to make a valid 
connection to a printer has expired. 

Probable cause: 

• Printer out of paper, not connected, or not on-line. 

0D00 Reader failed calibration checksum test.  

Internal software corruption. 

0E00, 
0E01 to 
0E05 

Wavelength not detected in reader’s filter table. 

Compare filters’ wavelengths to the filter table. 

0F00 to 
OF86 

Reader’s filter or channel signal is out of specified range. 

Check for lamp failure, and/or replace lamp. 

1000 Required reader configuration data missing. 

Re-download software basecode and assays. 

1100 Failed configuration checksum test.  

Re-download software basecode and assays. 

1200 Calibration data missing. 

1201 Calibration value missing 

Filter table was updated but System Test was not run. Run a system test. 

1300 Motor not homed. 

Autocal error, see error 0200. 
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Code Probable Cause 

1400 Assay incubation error.  

Assay requires incubation but the instrument does not appear to have an 
incubator. 

1500 Incubator failed to hold temperature within tolerances during the 
assay. 

1600 Computer control assay definition error.  

This error is used only for software development. 

1700 Kinetic interval too short for selected options. 

1800 Too many kinetic intervals selected. 

2311 to 
2386 

Lamp unstable.  

Problem with lamp output during power-up or while reading a plate. If a 23xx 
error is displayed during a System Test or during startup, the last digit 
indicates the filter wheel position. If a 23xx error is displayed during a read, 
the last digit indicates the filter number in the list of filters used for the read.  

Probable causes: 

• Defective or old lamp; replace the lamp.  

• Lamp not sitting correctly in lamp holder (always remove the holder to 
install the lamp, then insert the holder with the lamp back into the 
reader). 

• Lamp contacts dirty. Clean with ethanol (refer to Chapter 5, 
Preventive Maintenance). 

• Lamp cable needs upgrade. 

• Filter degradation. 

• Filter not seated properly in filter wheel. 

• Lower lenses for all or some channels failing and need replacement. 

• Electrical noise or grounding issue. 

• Shortened lamp life from performing long kinetic runs every day or 
leaving the reader on 24 hours a day. 

• When using 340 nm filters, the analog gain must be increased. 
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Error Codes (Fatal) 

These errors indicate conditions that require immediate attention. If a fatal error is 
displayed, contact BioTek’s Technical Assistance Center for further instructions (refer to 
the Product Support & Service section in Chapter 1). 

 
Code Description 

A100 Task control block not available. 

A200 Read already in progress. 

A300 <Device> not available. 

A400  Failed code checksum test on powerup. 

A500 DR steps alloc/free error < assay num>.  

A600 Data flash write timed out. 

A700 Data flash readback  did not match write (test) <chip>. 

A800 Code flash write timed out. 

A900 Memory Manager corruption detected. Power instrument off, then back 
on. 
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Appendix A 

Sample Reports   

The following pages contain examples of reports that can be 
generated and/or printed from the ELx808 when it is running in 
standalone mode. For details on how to print these reports, refer to 
OUTPUT Options in Chapter 2, Installation. In addition, an Assay 
List, Assay Definition, Map, and Result can be printed by choosing 
REPORT from the Main Menu screen.  

 Important! The 'OUT' indication on reports means the OD for 
an individual well, or the average OD for a group of wells, falls 
outside the minimum/maximum OD range defined for the 
assay. For the Quick Read assay on the ELx808, this range is -3.0 
OD to +3.0 OD. For assays defined onboard by a user (Assay02-
Assay55), it is -4.0 OD to +4.0 OD. 

 

Samples with Calls on Matrix Report .................................. 124 
Curve Fit Report ............................................................. 125 
Samples with Calls on Column Report ................................ 126 
Column Report without Samples ....................................... 127 
Panel Report .................................................................. 128 
Assay Detail Report ......................................................... 129 
Assay List ...................................................................... 130 
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Samples with Calls on Matrix Report 
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Curve Fit Report 
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Samples with Calls on Column Report 
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Column Report without Samples 
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Panel Report 
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Assay Detail Report 
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Assay List 

Assay List 

Version: 2.82 

 1 _Quick Read 

 2 ASSAY 02 

 3 ASSAY 03 

 4 ASSAY 04 

 5 ASSAY 05 

 6 ASSAY 06 

 7 ASSAY 07 

 8 ASSAY 08 

 9 ASSAY 09 

10 ASSAY 10 

11 ASSAY 11 

12 ASSAY 12 

13 ASSAY 13 

14 ASSAY 14 

15 ASSAY 15 

16 ASSAY 16 

17 ASSAY 17 

18 ASSAY 18 

19 ASSAY 19 

20 ASSAY 20 

21 ASSAY 21 

22 ASSAY 22 

23 ASSAY 23 

24 ASSAY 24 

25 ASSAY 25 

26 ASSAY 26 

27 ASSAY 27 

28 ASSAY 28 

29 ASSAY 29 

30 ASSAY 30 
 



Appendix B 

Instructions for Programming a 
New Assay 

This appendix provides two sample assay kit instructions with step-by-
step instructions for programming each assay: one with a ratio 
transformation calculation and a POS/NEG cutoff determination, and 
another with a standard curve.  

These examples are based on real assays; however, the results have not 
been verified on any clinical kits. The kit instructions are provided so that 
users can see how it is possible to translate the kit wording into an 
ELx808 assay program. For clarity, only the user menu choices from the 
reader screens are shown. See Chapter 3 for details.  

L Important! The user is responsible for programming the 
reader properly according to their specific kit instructions, and 
for verifying that the calculations are performed correctly. 

 

Sample ANA Screen Enzyme Immunoassay Kit ........................ 132 
Sample Anticardiolipin IgG Enzyme Immunoassay Kit ............... 136 
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Sample ANA Screen Enzyme Immunoassay Kit 

This sample demonstrates the use of transformations and cutoffs. 

Intended Use 

This assay is designed for the in vitro screening of serum for the presence of specific 
IgG antinuclear antibodies (ANAs), to aid in diagnosing certain systemic rheumatic 
diseases. Sufficient materials are supplied to allow a maximum of 93 samples to be 
screened in single, with a positive, cutoff, and negative controls. 

Background 

Antinuclear antibodies occur in a large number of patients with systemic rheumatic 
diseases. These diseases are characterized by the presence of one or more ANAs. 

Sera positive on this ANA kit should be tested for the specific autoantibodies 
indicative of the various systemic rheumatic diseases. 

Principle of the Assay 

Microwells are pre-coated with purified antigens. The prediluted controls and diluted 
patient samples are added to the wells, and autoantibodies recognizing one or a 
combination of antigens bind during the first incubation. After washing the wells to 
remove all unbound proteins, IgG conjugate is added. The conjugate binds to the 
captured autoantibody, and the excess unbound conjugate is removed by a further 
wash step. Substrate is added that causes a blue reaction, thereby exposing the bound 
conjugate, and producing an intensity proportional to the concentration of 
autoantibody in the sample. Phosphoric acid is added to each well to stop the reaction. 
This produces a yellow end-point color, which is read at 450 nm. 

Materials Supplied 

• Instruction Leaflet: Giving full assay details. 

• QC Certificate: Indicating the expected performance of the batch. 

• ANA Coated Wells: 12 x 8 well strips coated with purified antigens. 

• Type III Wash Buffer 20x Concentrate: 1 bottle containing 50 mL of a concentrated 
buffer for washing the wells. 

• Type III Sample Diluent: 2 bottles containing 50 mL of buffer for sample dilution. 
Ready to use. 

• ANA Positive Control: 1 bottle containing 1.8 mL of diluted stabilized serum. 
Ready to use. 
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• ANA Cutoff Control: 1 bottle containing 1.8 mL of diluted stabilized serum. Ready 
to use. 

• ANA Negative Control: 1 bottle containing 1.8 mL of diluted stabilized serum. 
Ready to use. 

• ANA Conjugate: 1 bottle containing 12 mL of peroxidase labeled antibody to IgG. 
Colored red, ready to use. 

• TMB Substrate: 1 bottle containing 14 mL TMB substrate. Ready to use. 

• Stop Solution: 1 bottle containing 14 mL of 3M Phosphoric acid. Ready to use. 

Additional Materials and Equipment – Not Supplied 

• Automatic Microplate Plate Washer: This is recommended; however, plate 
washing can be performed manually. 

• Microplate Reader: Capable of measuring optical densities at 450 nm referenced on 
air. 

• Distilled or Deionized Water: This should be of the highest quality available. 

• Calibrated Micropipettes: For dispensing 1000, 100, and 10 µL. 

• Multichannel Pipette: Recommended for dispensing 100 µL volumes of conjugate, 
substrate, and stop solution. 

• Glass/Plastic Tubes: For sample dilution. 

Quality Control 

For an assay to be valid, all the following criteria must be met: 

• Cutoff as well as Positive and Negative controls must be included in each run. 

• The OD of the cutoff and the ANA result of the Negative and Positive Controls 
should be in the ranges specified on the QC Certificate. 

• For example: The absorbance of the Positive Control must be greater than  
1.200 OD. The absorbance of the Negative Control must be less than 0.300 OD. 

 If the above criteria are not met, the assay is invalid and the test 
should be repeated. 

Calculation of the Sample Results 

Use the following formula to calculate the ANA result for each sample: 

Control or sample OD 
x 10 = Control or sample value (U/mL) 

Cutoff control OD 
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Expected Values 

The normal range was determined on serum from 200 normal adult blood donors. The 
cutoff control has been set at a point equivalent to the upper normal limit, or a cutoff 
level of 10 U/mL. 

The ranges are provided as a guide only. ELISA assays are very sensitive and capable 
of detecting small differences in sample populations. It is recommended that each 
laboratory determine its own normal range, based on the population techniques and 
equipment employed. 

ANA Result Interpretation 

< 10.0 Negative 

> 10.0 Positive 

Programming the Assay on the ELx808 

From the Main Menu, press DEFINE. Enter the assay number and edit the name if 
desired. At the DEFINE menu: 

  STEP                     COMMENTS 

To program the reading method, press:  

 METHOD:  

  READ TYPE (Endpoint, Kinetic, or Scan):         
Endpoint 

 

  DELAY FIRST READ:  

  If incubator model: INCUBATION TEMP           
(Ambient or Temperature): 

 

  WAVELENGTH (Single or Dual): Single  

  MEASURE (Wavelength[s] to use): 450  

  SHAKE (First, Every, or None):  

To program the plate map, press:  

  MAP  

  AUTO “Auto” mapping is normally preferred, 
because it fills in the well IDs logically 
and automatically after determining 
which direction to map and how many 
wells to fill. 

 DOWN Maps the wells down the column. 

 DOWN Locates replicates in a vertical 
orientation down the column. 

  A01 Begins mapping at well location A01. 

  BLANK MAP: AIR Choose to blank on “AIR” if no blank 
wells are required. 

  NUMBER STDS: 00  
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  STEP                     COMMENTS 

  REUSE STANDARD CURVE? Can only be programmed in assays  
31-55. Cannot be reused on panels. 

  NUMBER CTLS: 03  

  CONTROL 1: PC  

  CONTROL 2: CTL1 Suggested for the cutoff control. 

  CONTROL 3: NC  

  NUMBER OF REPLICATES  

  PC: 01  

  CTL1: 03  

  NC: 01  

  SAMPLES: 91 User-defined; recommendation is to 
fill the entire plate. 

  SAMPLE REPLICATES: 01  

 Use the MAP and MATH keys to  
create the control validation formula: 

 

  FORMULA  

  VAL  

 CONTROL: 

PC;x > 1.200  

NO. OF REPLICATES: 01 

NC;x < 0.300 

NO. OF REPLICATES: 01 

When defining control validation 
formulas, use “PC” to indicate the 
criterion for each of the PC replicates, 
and “PC;x” to indicate the average of 
the Positive Control replicates. 

To create the plate transformation for CALC, divide the ANA result by a cutoff standard. 

 FORMULA 

*MORE 

TRANS - VAR  

 

 SCOPE VARIABLE (SMP or OD) Select OD to advance to the formula 
definition screen and define the 
transformation variable (Tvar) 

 FORMULA  

 CTL1;X Defining TRANS VAR = CTL1;X 
isolates the OD value for CTL1;X for 
use in transformation. 

 TRANS:  

 FORMULA: (OD/TVAR)*10 Converts all OD values on plate to 
”ANA Result” per the kit instructions. 

To define a cutoff formula for Positive and Negative calls: 

 FORMULA  

 CUTOFF: 10.0  

 GREYZONE: 00%  

 SAMPLE > CUTOFF: POS  
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Sample Anticardiolipin IgG Enzyme Immunoassay 
Kit 

This sample demonstrates the use of standard curve and cutoffs. 

Intended Use 

This assay is intended for the in vitro measurement of IgG anticardiolipin antibodies in 
serum, as an aid in the diagnosis of antiphospholipid syndrome (APS). Sufficient 
materials are supplied to allow a maximum of 41 samples to be tested in duplicate or 
89 in single, with a standard curve and positive and negative controls. 

Background 

Anticardiolipin antibodies are found in a wide range of conditions either transiently, in 
some infectious diseases, or more persistently in autoimmune diseases such as 
systemic lupus erythematosus (SLE) and antiphospholipid syndrome (APS). 
Anticardiolipin antibodies have also been associated with a range of clinical conditions 

including fetal loss, endocarditis, stroke, heart attack and autoimmune haemolytic. 

Principle of the Assay 

Microwells are pre-coated with cardiolipin and cofactor. Standards, controls, and 
patient samples are added to the wells, and autoantibodies recognizing cardiolipin 
bind during the first incubation. After washing the wells to remove all unbound 
proteins, conjugate is added. The conjugate binds to the captured antibody, and the 
excess unbound conjugate is removed by a further wash step. Substrate is added that 
causes a blue reaction, thereby exposing the bound conjugate and producing an 
intensity proportional to the concentration of autoantibody in the sample. Phosphoric 
acid is added to each well to stop the reaction. This produces a yellow end-point color, 
which is read at 450 nm. 

Materials Supplied 

• Instruction Leaflet: Giving full assay details. 

• QC Certificate: Indicating the expected performance of the batch. 

• Cardiolipin Coated Wells: 12 break-apart 8-well strips coated with bovine 
cardiolipin antigen. The plate is packaged in a re-sealable foil bag containing two 
desiccant pouches. 

• Type II Sample Diluent: 2 bottles containing 50 mL of buffer for sample dilution. 
Colored yellow, ready to use. 
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• Type II Wash Buffer (20x Concentrate): 1 bottle containing 50 mL of a 20-fold 
concentrated buffer for washing the wells. 

• Cardiolipin IgG Standards: 5 bottles each containing 1.2 mL of diluted serum, with 
the following concentrations of anticardiolipin autoantibody: 100, 50, 25, 12.5, 6.25 
GPL U/mL. Ready to use. 

• The standard set is calibrated against the Louisville APL reference preparation (see 
Assay Calibration, page 138). 

• Cardiolipin IgG Positive Control: 1 bottle containing 1.2 mL of diluted serum. The 
expected value is given on the QC certificate. Ready to use. 

• Cardiolipin Negative Control: 1 bottle containing 1.2 mL of diluted serum. The 
expected value is given on the QC certificate. Ready to use. 

• Cardiolipin IgG Conjugate: 1 bottle containing 12 mL of purified peroxidase 
labeled antibody. Colored red, ready to use. 

• TMB Substrate: 1 bottle containing 14 mL TMB substrate. Ready to use. 

• Stop Solution: 1 bottle containing 14 mL of 3M phosphoric acid. Ready to use. 

Additional Materials and Equipment – Not Supplied 

• Automatic Microplate Plate Washer: This is recommended; however, plate 
washing can be performed manually. 

• Microplate Reader: Capable of measuring optical densities at 450 nm referenced on 
air. 

• Distilled or Deionized Water: This should be of the highest quality available. 

• Calibrated Micropipettes: For dispensing 1000, 100, and 10 µL. 

• Multichannel Pipette: Recommended for dispensing 100 µL volumes of conjugate, 
substrate, and stop solution. 

• Glass/Plastic Tubes: For sample dilution. 

Quality Control 

For an assay to be valid, all the following criteria must be met: 

• Standards and the positive and negative controls must be included in each run. 

• The values obtained for all the controls should be in the ranges specified on the 
QC Certificate. 

• The curve shape should be similar to the standard curve, shown on the QC 
Certificate. 

• If the above criteria are not met, the assay is invalid and the test should be 
repeated. 
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Calculate Mean Optical Densities (for assays run in duplicate only) 

For each standard, control, and sample, calculate the mean OD of the duplicate 
readings. The user must verify that the percentage coefficient of variation (%CV) for 
each duplicate OD is less than 15.0%. 

Plot Calibration Curve 

The calibration curve can be plotted either automatically or manually as follows by 
plotting the anticardiolipin autoantibody concentration on the log scale against the OD 
on the linear scale for each calibrator: 

• Automatic - Use appropriately validated software, and the curve fit that best 
fits the data. 

• Manual - Using log/linear graph paper, draw a smooth curve through the 
points (not a straight line or point to point). 

Treatment of Anomalous Points 

If any one point does not lie on the curve, it can be removed. If the absence of this 
point means that the curve has a shape dissimilar to that of the sample calibration 
curve, or more than one point appears to be anomalous, then the assay should be 
repeated. 

Calculation of Autoantibody Levels in Controls and Samples 

Read the level of the anticardiolipin autoantibody in the controls and diluted samples 
directly from the calibration curve. The control values should fall within the range 
given on the QC Certificate. 

 The standard values have been adjusted by a factor of 100 to 
account for a 1:100 sample dilution. No further correction is 
required. 

Assay Calibration 

The assays are calibrated against the Louisville reference LAPL-GM-100. One GPL unit 
is defined as the cardiolipin binding activity of 1 µg/mL of an affinity purified IgG 
anticardiolipin preparation from a standard serum. 

The Louisville reference center recommends the following positive discrimination 
criteria according to the recommendation of the 2nd International Anticardiolipin 
Workshop. 
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Criteria Range (GPLU/mL) 

High Positive  > 80 

Medium Positive ≥ 20-80  

Low Positive ≥ 10, < 20 

 

Results Interpretation 

The association between low positive levels of anticardiolipin antibodies and clinical 
findings is unclear. 

Normal population studies indicate that there is a higher prevalence of IgM positives 
in the normal population than IgG, 9.4% and 6.5%, respectively. In normal pregnancy, 
the levels are higher still at 17.0% (IgM) and 10.6% (IgG). 

Expected Values 

The normal range was determined on serum from 102 normal adult blood donors. The 
ranges below are provided as a guide only. ELISA assays are very sensitive and 
capable of detecting small differences in sample populations. It is recommended that 
each laboratory determine its own normal range, based on the population techniques 
and equipment employed. 

 
 lgG Anticardiolipin  

< 11 GPL U/mL Negative result 

> 11 GPL U/mL Positive result 

 
 

Programming the Assay on the ELx808 

From the Main Menu, press DEFINE. Enter the assay number and edit the name if 
desired. At the DEFINE menu, follow the steps below: 

STEP 

To program the reading method, press: 

 METHOD: 

    READ TYPE: Endpoint 

    DELAY FIRST READ: 

    If incubator model: INCUBATION TEMP             (Ambient or Temperature): 

 DELAY FIRST READ: 
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STEP 

    WAVELENGTH (Single or Dual): Single 

    MEASURE (Wavelength[s] to use): 450 

    SHAKE (First, Every, or None): 

To program the plate map, press: 

    MAP 

    AUTO 

 DOWN 

 DOWN 

    A01 

    BLANK MAP: AIR 

    NUMBER STDS: 05 

    NUMBER STD REPLICATES: 01 

    CONCENTRATIONS: 

            STD1:  6.25 

            STD2:  12.5 

            STD3:  25 

            STD4:  50 

            STD5:  100 

    REUSE STANDARD CURVE? 

    NUMBER CTLS: 02 

    CONTROL 1:  PC 

    CONTROL 2:  NC 

    NUMBER OF REPLICATES 

 PC:  01 

    NC: 01 

    SAMPLES: 89 

 SAMPLE REPLICATES: 01 

To define a cutoff formula for Positive and Negative calls:  

Note: Kit instructions specify that samples with concentration values greater than 11 
should appear as positive. The ELx808 software calculates the cutoff based on 
absorbance value or transformed value (see the previous example) and cannot calculate 
based on concentration. The technician must make the positive or negative 
determination visually, based on the calculated concentration results. 

Curve: 4P 

Note: As a general guideline, choose “linear” if you expect a straight line result. Choose 
“4P” for all others, unless otherwise specified by the kit instructions. The reader will 
automatically calculate the concentrations of the samples when the assay is run. 

 

 
 



Appendix C 

Adjusting the Power 
Input Voltage Setting 

This appendix does not apply to ELx808 readers equipped 
with an external power supply.  
 
This appendix provides instructions for adjusting the power input 
voltage setting in ELx808 instruments that are equipped with an 
internal four-voltage range power input module.  

Identifying the Reader’s Power Input Module ...................... 142 
Newer-Style Module ........................................................ 143 

Adjust the Power Input Voltage Setting ......................... 143 
Reconfigure or Replace Fuses ....................................... 145 

Older-Style Module ......................................................... 147 
Adjust the Power Input Voltage Setting ......................... 147 
Reconfigure or Replace the Fuses ................................. 148 
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Identifying the Reader’s Power Input Module 

Previous versions of the ELx808 (models manufactured before December 2005) have an 
internal, four-voltage range power input module, instead of an external power supply. 
Located on the right side of the ELx808, the input module can be adjusted for a 100, 120, 
230, or 240 V~ voltage setting.  

The voltage setting that is currently selected can be determined by observing which of the 
four possible voltage indicator holes has a white peg in it. Check the peg now to make sure 
the setting is appropriate for your location.  

If you need to adjust the setting, first determine which type of power input module is 
installed in the reader:   

• The newer style module has a cover that can swing back toward the 
reader, when opened with small needle-nose pliers. If your reader has this 
module, follow the instructions starting on page 143 for adjusting the power 
input voltage setting and reconfiguring/replacing the fuses. 

• The older style module has a cover that can be detached from the reader 
when opened with a small flat-blade screwdriver. If your reader has this 
module, follow the instructions starting on page 147 for adjusting the power 
input voltage setting and reconfiguring/replacing the fuses. 
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Newer-Style Module 

Adjust the Power Input Voltage Setting  

 Important! Turn off and unplug the reader before adjusting 
the voltage setting. 

 

1. Unplug the reader and remove the power cord. 

2. Insert a small pair of needle-nose pliers into the two holes on the cover of 
the power input module. Lift the cover open and swing it back toward the 
power cord socket (see Figure 12 below). 

3. As shown below, a small voltage selector card is located to the right of the fuse 
holder. Using the pliers, carefully pull this card straight out of the 
compartment. 

 

 

Figure 12: Power input module: accessing the voltage selector card and fuse holder  
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4. As shown in Figure 13 below, there are four different voltage range positions. 
Rotate the white plastic indicator peg around the card so that it fits into the 
correct groove for the desired voltage. 

 Point the peg upward so that the text matching the desired voltage 
range is readable at the bottom of the card, as shown below.  

 

 

Figure 13: Voltage selector card input range positions 

 

5. Reinsert the voltage selector card into the power input module so that the text 
side faces the ON/OFF switch, and the desired voltage range is on the bottom 
of the card (see above). 

6. Reconfigure or replace fuses as needed (see next page). 

7. Replace the cover, and verify that the white peg lines up with the correct 
voltage indicator hole. 

 

White plastic 
indicator peg 
should point 
upward. 

This side (showing 
text) should face the 
ON/OFF switch 
(voltage range 
should be on the 
bottom). 
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L Important! The peg indicating the intended voltage should 
protrude through the cover. Do not power up the instrument 
until the voltage range to be used is indicated correctly by 
the peg. 

Reconfigure or Replace Fuses  

 
Important! Turn off and unplug the reader before 
reconfiguring or replacing the fuses. 

 

Either USA or International style fuses are installed in the fuse holder that is located 
inside the power input module. The reader’s fuses are configured at the factory prior to 
shipping. Use the procedure described below if you need to reconfigure or replace 
fuses. 

 A failed fuse is usually an indication of another problem that a new fuse is 
not likely to remedy. Contact BioTek’s Technical Assistance Center if the 
fuse replacement fails to resolve the problem. See Chapter 1 for contact 
information. 

The fuse holder can have either one of two fuse configurations: 

• 100/120 V (USA): A fused hot AG 1.5 A, 250 V Slo Blow (PN 46024), or 

• 230/240 V (International): Both hot and neutral fused with a 5 x 20 mm, 0.63 A, 
250 V Slo Blow (PN 46038). 

To reconfigure fuses: 

1. Turn off and unplug the reader. 

2. Insert the needle-nose pliers into the two holes on the cover of the power input 
module. Lift the cover open and swing it back toward the power cord socket. 

3. Using the pliers, gently pull the fuse holder out of the power input module and 
turn it over. 

 

Changing to the 
100/120 V 
Configuration: 

• Remove the two 0.63 A, 250 V fuses. 

• Install one AG 1.5 A, 250 V fuse (PN 46024) on the 
fuse holder on the side opposite the original 0.63 A 
fuse location. 

• Reinstall the fuse holder with the fuse toward the 
back of the power input module.  
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• Replace the cover, and verify that the white plastic 
indicator peg lines up with the correct voltage 
indicator hole. 

Changing to the 
230/240 V 
Configuration: 

• Remove the single AG 1.5 A, 250 V fuse. 

• Install two 0.63 A, 250 V fuses (PN 46038) on the 
fuse holder on the side opposite the original AG 1.5 
A fuse location. 

• Reinstall the fuse holder with the fuses toward the 
back of the power input module. 

• Replace the cover, and verify that the white plastic 
indicator peg lines up with the correct voltage 
indicator hole. 

 

To replace defective fuses: 

1. Follow steps 1 through 3 on the previous page to access the fuse holder. 

2. Remove the defective fuse and replace it with the correct new one. 

3. Reinstall the fuse holder with the fuse toward the back of the power input 
module. 

4. Replace the cover, and verify that the white plastic indicator peg lines up with 
the correct voltage indicator hole. 
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Older-Style Module 

Adjust the Power Input Voltage Setting 

 Important! Turn off and unplug the reader before adjusting 
the voltage setting. 

L Important! Be careful when removing the cover from the 
power input module: the fuse holder is attached to the inside 
of the cover. 

 

Refer to Figure 14 on the next page for the following instructions: 

1. Unplug the reader and remove the power cord. 

2. Insert a small flat-blade screwdriver into the access hole between the power 
cord inlet and the power input module cover. Carefully pry the cover off the 
module. Note that the fuse holder is attached to the inside of the cover. 

3. A small voltage selector card is located on the right side of the power input 
module. Using a small pair of needle-nose pliers, carefully pull this card 
straight out of the module. 

4. Text printed on the card identifies the four different voltage positions. Each 
voltage number has an arrow printed next to it. Rotate the white plastic 
indicator peg so that it fits into the groove on the card that represents the 
desired voltage; the peg should point in the opposite direction from the arrow 
printed on the board. 

5. Orient the card so that the peg is facing out and the text on the card is facing 
the ON/OFF switch. The arrow should be pointing into the power input 
module. Slide the card all the way back into the input module. 

6. Reconfigure or replace fuses in the fuse holder, as needed (see the instructions 
on page 148). 

7. Replace the cover on the power input module and verify that the white peg 
lines up with the correct voltage indicator hole. 

L Important! The peg indicating the intended voltage should 
protrude through the cover. Do not power up the instrument 
until the voltage range to be used is indicated correctly by 
the peg. 
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Figure 14: Power input module; accessing the voltage selector card and fuse holder 

Reconfigure or Replace the Fuses 

 
Important! Turn off and unplug the reader before 
reconfiguring or replacing the fuses. 

 

Both USA and International style fuses are installed in the fuse holder that is attached to 
the inside of the power input module’s cover. The reader’s fuses are configured at the 
factory prior to shipping. Use the procedure below if you need to reconfigure or 
replace fuses. 
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 A failed fuse is usually an indication of another problem that a new fuse is 
not likely to remedy. Contact BioTek’s Technical Assistance Center if the 
fuse replacement fails to resolve the problem. See Chapter 1 for contact 
information. 

The fuse holder has two configurations: 

• 100/120 V (USA): A fused hot AG 1.5 A, 250 V Slo Blow (PN 46024), and 

• 230/240 V (International): Both hot and neutral fused with a 5 x 20 mm, 0.63 A, 
250 V Slo Blow (PN 46038). 

The fuse configuration (U.S. or International) that is currently being used by the reader 
is determined by which fusing network is facing the inside of the power input module. 

To reconfigure fuses: 

1. Turn off and unplug the reader. 

2. Insert a small flat-blade screwdriver into the access hole between the 
power cord inlet and the power input module cover. Carefully pry the cover off 
the module. 

3. Use the screwdriver to remove the Phillips-head screw that anchors the fuse 
holder to the inside of the cover. See Figure 14. 

4. Turn the fuse holder over. 

5. Reattach the fuse holder to the cover with the screw. 

6. Replace the cover, and verify that the white plastic indicator peg lines up with 
the correct voltage indicator hole. 

To replace defective fuses: 

1. Repeat steps 1 through 3 on the preceding page to access the fuse holder. 

2. Remove the defective fuse and replace it with the correct new one. Do not turn 
the fuse holder over, or you will change the configuration. 

3. Reattach the fuse holder to the cover with the screw. 

4. Replace the cover, and verify that the white plastic indicator peg lines up with 
the correct voltage indicator hole. 
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